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GENERAL

SECTION 1

1.1 SCOPE OF MANUAL

This manual describes the functions of the Call
Processor (CP) and the System and Subscriber
Manager (SSM). Refer to the Multi-Net Application
Note, Part No. 009-3039-004 or |ater for more detailed
information on Multi-Net system operation.

1.2 DEFINITIONS

Thefollowing are brief definitions of some terms
as they apply to Multi-Net systems.

1.2.1 TRUNKED SYSTEM

Radio systems which pool multiple channels
using automatic switching allowing all system users
access to any repeater channel that isnot in use. This
results in aminimum waiting time to make a call.

1.2.2 LTR TRUNKED SYSTEM

LTRY (Logic Trunked Radio) systems utilize a
concept called trunking which makes al repeater
channels of a system automatically available to the
users. A logic control module in each repeater continu-
aly monitors the system and updates the mobiles and
repeaters using data messages. These data messages
tell the mobiles which repeater channels are free and
can be accessed if acall isto be made.

1.2.3 MULTI-NET TRUNKED SYSTEM

Multi-Net radio systems utilize channel trunking
similar to an LTR system. However, Multi-Net uses a
different Multi-Net signaling protocol to provide
enhanced features such as Auto-Registration, Busy
Queuing, Emergency Messages, and Priority Access.
A Multi-Net system also allows users on Multi-Net,
LTR, and Conventional channelsto talk to each other.

1.2.4 CONVENTIONAL SYSTEM

Conventional systems are licensed to operate only
on asingle repeater channel. Operation is similar to
that of acommunity repeater as thereis no automatic
access to several repeater channels.

1-1
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1.2.5 3000-SERIES SWITCH

The 3000-Series Switch (see Section 2) provides
the switching and interface to external equipment for a
Multi-Net system. It is controlled by the Call
Processor (see next section). It has up to eight shelves
with 12 device slots each (96 slots total). Many
different modules are available to provide interfacing
with the repeaters, control consoles, public telephone
systems and other functions.

1.2.6 CALL PROCESSOR (CP)

The Call Processor is a Windows NT® based
computer (see Figure 1-1) which contains the data-
base used to control the Switch. It controls and contin-
uously monitors Switch operation, provides logging of
information for billing purposes, and performs other
functions such as processing certain types of cals. The
Call Processor interfaces with the Switch as shown in
Figure 3-1. Refer to Section 4 for more Call Processor
information.

_______‘-‘“--...__. _-_.__ ‘_— = 1

I"I-'I_l';'-lf’![lljl‘llI|l|1.||.l1l == '.\
[ L |I’|:[1"1=J :" i:l \HH‘[ m .
= o e TS |Hn\\_ %

Figure 1-1 Call Processor

1.2.7 SYSTEM AND SUBSCRIBER MANAGER
(SSM)

The System and Subscriber Manager (SSM) isa
Windows NT® based computer (see Figure 1-2) which
manages the database in the Call Processor. It also

Revised August 2001
Part No. 002-3139-078



GENERAL

generates reports from the information logged by the
CP and sets up and initiates activities such as
Dynamic Reprogramming of certain transceiver
parameters (Group 11), disabling (Kill) of lost or
stolen transceivers.

Thelocal SSM and the CP functions can run on
the same computer if desired. The SSM interfaces
with the Call Processor via an Ethernet link as shown
in Figure 3-1. Refer to Section 5 for more SSM infor-
mation.

Figure 1-2 System and Subscriber Manager
(SSM)

1.2.8 LOCALITY

A Locality refersto repeaters that are physically
located together and connected by the same High
Speed Data Bus. Multi-Net localities can have a
maximum of 30 repeaters. The terms “Locality” and
“Site” are sometimes used interchangeably.

1.2.9 HOME REPEATER CHANNEL

Each Multi-Net selectable system is programmed
with a“home” repeater number. When standard
(dispatch) calls are placed and received, the home
repeater and group 1D code identify the transceiver or
group of transceivers that receive the call. Multiple
“homes’ can be assigned in large locdlities.

1-2

1.2.10 STATUS REPEATER

A Multi-Net repeater at alocality is designated to
transmit update information for all calls occurring at
that locality. This repeater is aso available for voice
traffic, but is not assigned as a home repeater for any
transceivers because none of its transceivers would
have home channel backup. Multiple status repeaters
may be assigned in large localities.

1.2.11 MONITOR REPEATER CHANNEL

Thisisthe repeater that atransceiver is currently
monitoring for update messages. With Multi-Net
signaling, it is usually the Status repeater but may also
be the home repeater. When a transceiver is not
receiving acall, it continually monitors update
messages from this repeater for incoming call and free
repeater information. When making a cal, the trans-
ceiver may be trunked to any of the locality repeaters
that are not busy.

1.2.12 DEVICE ADDRESS

Each Switch has aa variable number of shelves,
each of which hold up to 12 modules. The addressing
of the shelves starts with zero on the lower left of the
first Switch rack (reserved for the NetNIM Network
Interface Modules). Each succeeding shelf above the
first starts with a number 16 higher. The next Switch
rack (if applicable) continues this consecutive
sequence. This device addressis part of the identifica-
tion used in the protocols (referred to as “ Card
Address”).

1.2.13 UNIQUE IDENTIFICATION (UID)

The Unique ID number (1-8163) is assigned on a
locality-wide basis to each transceiver. Each selectable
system of atransceiver is programmed with aUID
code in addition to the Group ID codes. UIDs 8164-
8191 are reserved and should not be used.

1.2.14 GROUP IDENTIFICATION NUMBER

Group IDs 1-255 are assignable on each Multi-
Net Home Repeater. A “standard” Group call uses|D
codes 1-225, and the call isreceived by amobileif it
is programmed to receive calls on the Home Repeater/
ID code of acall. “Specia” Calls use Group ID codes
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226-255. These calls are telephone I nterconnect
(Group ID = 237), Auxiliary (Group ID = 236), and
others. Interconnect and Auxiliary Unique ID calls
require System and Subscriber Manager/Call
Processor authorization.

1.2.15 DYNAMIC REASSIGNMENT

Dynamic Reassignment feature of Multi-Net
systems allows the reprogramming of Group 11 of the
specified system of a particular mobile over the air. In
addition, another Multi-Net feature allows the sel ected
system/group of a particular mobile to be changed
over the air, for example, to receive an important

message.

1.2.16 PULSE CODE MODULATION (PCM)

PCM is used on the Switch voice buses to send
voice signals between modules. These buses operate at
2.048 MHz and have 32 Time Slots.

1.2.17 ACCESS PRIORITY

Access Priority determines which mobiles have
access to a busy system. The method used by Multi-
Net systemsisto transmit the system Priority Level in
the data stream to the mobiles. The only mobiles
which are allowed to access the system are those
programmed with an access priority that is equal to or
higher than the currently transmitted system priority.
Mobiles with alower priority do not even attempt to
access the system. This prevents lower priority
mobiles from loading the system when it is the most
crucial, such as during busy periods.

1.2.18 REMOTE ACCESS SERVICE

Remote Access Service is not being used on the
Call Processor for remote access and should not be
installed in the computer. If it isin the computer, it can
be removed in the Services tab by selecting Remote
Access Services and click “Remove’.

LapLink should be used to answer the modem.
Ensure that LapLink is setup to start before the NT
Logon, not a default.

1.3 WIDE AREA CALL INFORMATION
1.3.1 WIDE AREA MODULE (WAM)

A Wide Area Module (WAM) is used in a Switch
to activate Group Dispatch Calls on multiple sites,
either internal (same Switch) or external (between
Switches). The Call Processor in a system activates a
WAM by sending it aWide Area Call (WAC) configu-
ration that contains Site/Home/Group combinations to
be activated as aWide Area Call.

1.3.2 WIDE AREA CALL (WAC)

A Wide Area Call (WAC) consists of acombina-
tion of participants that are brought together as a Wide
AreaDispatch Call. Once activated in aWAM, the call
remainsin the WAM until taken over by another
WAC.

1.3.3 RESOURCE ALLOCATION

Wide Area Calls are activated by Group Dispatch
Calls. When a Call Processor identifiesacall on the
Switch as being aWide Area Call, it attemptsto allo-
cate aresource for that call if necessary. After vali-
dating the Group and User to seeif it is permitted on
the Switch, the call isidentified as either Internal or
External. If there are Groups on other Switches that
need to beincluded in the call, it is marked as
External. If the converseistrue, the call is marked as
Internal.

The Call Processor then determinesif thereisa
resource available to handle that call. If thereisa
WAM available that matches the type (Internal or
External) and al so matches the Routing Group
number, the call is assigned to the WAM and config-
ured appropriately.

1.3.4 WAC ALARM MESSAGES

There are two alarm messages that appear in the
Alarm Log that are helpful in solving fleet mapping
issues with Wide Area Calls:

Alarm 46 Not All ChannelsActiveln WAM - Thisin-
dicates a WAM was unable to acquire channels for all
the Groups (participants) that were programmed.
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Possible Causes:

® Channelsareall busy at the Siteand the WAM could
not activate its Group.

* More participants were programmed for a Site than
the number of available channels.

* Channdlsat a Site were not functional.

Possible Solutions:

* Mark participants as temporary. This allows only
the necessary participantsin all callsto be using
channels. Permanent participants will always be
brought up on channels where available.

® Reduce the number of participantsin aWide Area
Call that use the same Site.

* |ncrease the number of channelsat a Site or fix any
channels that are malfunctioning.

Alarm 268 No Available WAM s - Thisindicates that
the criteria for WAM take over was not met and there-
foreacall that needed a WAM could not get one.

Possible Causes:

* All WAMs have been in use within the Maximum
Inactive Time window. This essentially means that
all WAMs are being used simultaneoudly.

* All WACs have ahigher priority than the one
attempting to come active and the Maximum I nac-
tive Time has not expired on any WAMS.

Possible Solutions:

® Decrease the Maximum Inactive Time. Keep in
mind that the lower the number, the higher the prob-
ability of interrupting conversations. It is recom-
mended that no less than 5 seconds be used.

* For more important WACs, increase the WAC
priority to allow the higher priority WACstoignore
the Maximum Inactive Time.

1.4 SYSTEM MANAGEMENT
1.4.1 SYSTEM ADMINISTRATOR

The System Administrator configures the System
and Subscriber Managers to alow selection of
Networks and User Privileges for the System Opera-
tors. The System Administrator also performs the
following required administrative procedures:

Periodic Reboot

A feature of the Call Processor application isthe
automatic creation and maintenance of a backup set of
tables. Thisaction is performed at start-up. To ensure
that this backup is usable, the system needsto be
rebooted after major configuration changes occur.

For instance, after the cards are initially config-
ured, reboot to allow thisinformation to be copied to
the backup set of tables. Also, the resource manage-
ment of Windows NT® may cause the slow loss of
available resources. To recover them, it is necessary to
reboot. The frequency of service depends on the type
and amount of activity on the system.

Database Backup

Sincethe operational characteristics of the system
depend on the information in the configuration tables,
it is recommended that a backup copy be kept of the
current information on a separate medium (tape, CD-
RW, multiple floppies, adifferent hard drive, etc.).
When the Call Processor is not operating, copy the
entire contents of the RunTimeModel directory.
Regular backup of the full drive contentsis the
preferred course of action.

1.4.2 SYSTEM OPERATORS

System Operators are assigned User Privileges by
the System Administrator. These privileges determine
what the operator is allowed to do using the System
and Subscriber Manager.
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1.5 CP AND SSM OPTIONAL FEATURES
1.5.1 GENERAL

Various Call Processor and System and
Subscriber Manager features are optional and avail-
able only if unlocked by a special encryption key
available from the E.F. Johnson Company.

The latest software includes all of the following
optional features. They can be selectively unlocked by
an encryption key which activates them for use. A key
consists of astring of letters and numbers that are
unique to a specific serial number of CP/SSM soft-
ware.

The SSM encryption key is entered using the File
> Enter New Key menu function of the SSM (see
Section 5.2.4). Likewise, the Call Processor key is
entered by clicking the “Enter Key” button in the
Switch Configuration Manager Switch Properties
screen (see Section 6.3.15).

1.5.2 CALL PROCESSOR OPTIONS

The Call Processor can support the following
modes. This determines the types of subscribers that
can be programmed by the SSM.

* Multi-Net
* | TR-Net
* WideAreaLTR

1-5

Repeater Alarms- If thisoption is enabled, repeater
alarmsarelogged by the Call Processor and reported to
the SSM. Refer to Section 6.2 for more alarm
information.

1.5.3 SSM OPTIONS

Demo Mode - Restricts the SSM to a Demonstration
Mode only. In this mode, sample tables are used to
display and change the various parameters which can
be programmed by the SSM. Actual datain a Call
Processor cannot be viewed or edited in this mode.

When installing the SSM to operate in this mode,
be sure the Call Processor Tables are installed. To do
this, select “Custom Installation” and make sure that
“Call Processor Tables’ is checked.

Wide Area Calling - Allowsthe wide areagroup calls
described in Section 1.3.

3rd Level WAM Routing - Allows routing groups to
be set up so that certain wide area calls can be routed
to specific localities. Without this option, routing
groups are not available and wide area calls are always
routed to the same localities.

Priority 1 Emergency - Allows emergency callsto be
routed as wide area cals.
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3000-SERIES SWITCH

SECTION 2 3000-SERIES SWITCH

©)

Figure 2-1 3000 Series Switch (8-Shelf)
2.1 INTRODUCTION
A Multi-Net radio system is a combination of

several key elements that together make up a commu-
nication system. By using the basic el ements of a

Multi-Net system as building blocks, a system can be
designed to meet the communication needs of almost
any type of user. The basic elements of aMulti-Net
system are as follows:

Backbone - This consists of repeater Locality equip-
ment including the links to the Switch.

Control Consoles - Used for dispatch operators.

Switch - Provides the interface between the Backbone
and Control Consoles.

RF Equipment - Consists of mobile, control station,
and portable transceivers.

Each Multi-Net Locality is an independent
trunking system that processes calls between RF units,
maintains fleet partitioning, and provides priority
access control. The backbone elements are intercon-
nected by either microwave, fiber optics, RF links, or
private telephone lines equivalent to a 4-Wire voice
grade phone circuit.

A Switch contains a Channel Interface Module
(CIM) for each repeater it controls, a Telephone Inter-
connect Module (TIM) for each telephone line used
for interconnect calls, an Intelligent Dispatch Module
(IDM) or Multi-Net Console Module (MCM) for each
dispatch console and others described in this section.
A single Switch can control up to 30 repeater channels
all at one Locality or divided among a combination of
Localities. The Switch provides interface between the
Locality equipment and the control consoles and
directs al activity in Multi-Net Locality applications.

RF units in the coverage area of one repeater
Locality can communicate with RF unitsin the
coverage area of other repeater L ocalities through the
Switch. Where more than 30 channels are required,
multiple Switches can be used with communication
between them to direct calls. Wide arearadio coverage
is provided to allow amobile to talk to another mobile
using arepeater hundreds of miles away. That repeater
may be part of the same Multi-Net system or another
Multi-Net system with phone lines or some other type
of link that provides the communication path.
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One or more dispatch consoles can be connected
to the Switch using direct connection, phone lines, or
some other type of link. Depending on the capabilities
of the particular console, the dispatcher can perform
functions such as place calls to specific mobiles, place
callsto other dispatchers, and make a patch between
two mobiles.

2.2 SWITCH MODULES

The Switch contains various modul es that
provide the interface between the Switch and external
devices. The exact modules used depend on the appli-
cation. The available modules are as follows.

Shelvesin the Switch are designated as Channel
or Terminal shelves. A Channel shelf can contain only
CIM and CCM modules, and a Terminal shelf can
contain any of the other modules. Thisis necessary for
proper routing of the audio signals on the PCM bus.

CCM - Conventional Channel Module
CIM - Channel Interface Module
CPM - Conventional Patch Module
DCM - Dispatch Channel Module
DIM - Dispatch Interface Module
IDM - Intelligent Dispatch Module
LEM - Logging Encoder Module
MAM - Multi-Net Acquisition Modulg
MCM - Multi-Net Console Module
NetNIM - Network Interface Module
PTM - Power Termination Module
SNM - System Network Module

TIM - Telephone Interface Module
VDM - Voter Diagnostics Module
VTM - Voice Tone Module

WAM - Wide Area Module

Call Processor - The computer which contains the
data base used by the Switch. This data baseis pro-
grammed by the System and Subscriber Manager.

CCM (Conventional Channel Module) - A Channel
shelf module that controls a Conventional repeater.

CIM (Channel Interface M odule) - A Channel shelf
module that controls a Multi-Net or LTR repeater.

CPM (Conventional Patch Module) - Patches a
single Conventional channel to asingletrunked Group.

2-2

It connects to a4-Wire interface or to an external
4-Wire E& M interface. An associated MCM is
required.

DCM (Dispatch Channel Module) - A Terminal shelf
module that controls a Conventional repeater.

DIM (Dispatch Interface Module) - Interface from
the Switch to the Dispatch Consoles.

IDM (Intelligent Dispatch Module) - Controls the
Multi-Net Dispatch Console.

LEM (Logging Encoder Module) - Provides system
usage information to alogging recorder.

MAM (Multi-Net Acquisition Module) - Interface
from the Switch to the ORBACOM Dispatch Consoles
for Tone Paging.

MCM (Multi-Net Console Module) - Interfaces the
Switch to a computer controlled (VRCM-50 Series)
Dispatch Console.

NetNIM (Network Interface Module) - Primary
Switch interfaceto the Call Processor. The NetlDB and
NetCSB interface the Call Processor to thiscard in the
Switch.

PTM (Power Termination M odule) - Providesfusing
of power and termination for a shelf.

SNM (System Network Module) - Controls other
SNMs and Switches. This allows Unique ID calls by
mobiles.

TIM (Telephone Interface M odule) - Connects the
Switch to telephone lines and handles telephone line
protocol to the PSTN or aPABX.

VTM (Voice Tone Module) - Provides voice and tone
messages to the System.

VDM (Voter Diagnostics M odule) - Interfaces the
Switch to the Voter system.

WAM (Wide Area Module) - Used to make wide
areacalls to multiple Localities within a System or
across multiple Switches.
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Figure 2-3 Four-Shelf Switch With CP/SSM
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SECTION 3 ARCHITECTURE

Switch
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NetNIM
h
CALL
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(cP)
Figure 3-1 Multi-Net System Diagram

3.1 INTRODUCTION

The architecture of the Switch refersto the
modules or elements that make up the physical
portions of the Switch and the buses that carry data,
control, and voice information.
3.2 SWITCH INTERFACES

The main Switch interfaces are as follows (see
Figures 3-1, 3-5, and 3-6).

a. Interface to Multi-Net repeaters

b. Interfaceto LTR repeaters

c. Interface to Conventional repeaters

d. Interface to Multi-Net Dispatch Consoles

e. Interface with VR-series Dispatch Consoles

f. Interface with the Public Switched Telephone
Network

g. Interfaceto other Switches

h. Interfaceto the Call Processor and System and
Subscriber Manager

3.3 BUS STRUCTURE

3.3.1 INTRODUCTION

The modules in the Switch are connected by
Data, Control, and Voice buses. Refer to the sections
which follow for more information.

3.3.2 DATA BUSES

The following are descriptions of the data buses
shown in Figure 3-2.

Ether net

EthernetisaLAN (Local AreaNetwork) protocol
that is used to pass information between multiple Call
Processors and System and Subscriber Managers using
TCP/IP communication. Several different physical

3-1
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Figure 3-2 Data Buses

media may be used including twisted-pair cable and
coaxial cable. The Ethernet link is used to passinfor-
mation between the SSM and CP even if they are
located on the same computer.

TCP/IP isthe abbreviation for Transmission
Control Protocol/Internet Protocol which is a suite of
communication protocols used to connect hosts on the
Internet. It is the de facto standard for transmitting
data over networks.

Network Intra-Terminal Data Bus (Netl DB)
The NetIDB is 19,200 baud sync-escape protocol

bus that passes information from the Call Processor to
and from other modules viathe NetNIM.

Network Channel Satus Bus (NETCSB)

The NetCSB isa 19,200 baud Sync-escape
protocol busthat passes the CSB (Channel Status Bus)
data to the Call Processor or external peripheral equip-
ment via the NetNIM.

Intra-Terminal Data Bus (IDB)

The IDB isa 19,200 baud sync-escape protocol
bus that modules communicate on to pass control

3-2

information to each other using high speed CSMA
(Carrier Sense Multiple Access).

Channel Status Bus (CSB)

The CSB isa19,200 baud sync-escape protocol
bus that passes channel status from channel modules
to other system modules using high speed CSMA.

Channel Interface Bus (CIB)
The CIB isa 1200 or 9600 baud sync-escape

protocol bus that passes system channel control and
status to and from the CIMs, CCMss, and repeaters.

Dispatch Interface Bus (DIB)

The DIB isa 1200 or 9600 baud sync-escape
protocol busthat passes DIM control and status to and
from the Dispatch consoles.

Dispatch Tone Protocol (DTP)
The DTP passes industry standard tone remote

push-to-talk tone and DTMF for DIM control and
status to and from the dispatch consoles.
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Figure 3-3 Control Buses

System Network Bus (SNB)

The SNB is a 1200 baud sync-escape protocol
bus that passes control and status between SNMs.

PSTN or PABX

This connectsto a PSTN (Public Switch Tele-
phone Network) or a PABX (Private Automatic
Branch Exchange) for outgoing and incoming tele-
phone calls.

3.3.3 CONTROL BUS

The following are descriptions of the control
buses shown in Figure 3-3.

IDB Idle/Collision Line

Thisisathreelevel line that indicates if the line
isidle or busy or acollision occurred for the IDB
communication process. This provides for high speed
CSMA of the IDB.

CSB Idle/Coallision Line

Thisisathreelevel line that indicates if the line
isidle or busy or acollision occurred for the CSB
communication process. This provides high speed
CSMA of the CSB.

3.3.4 VOICE BUS

The following are descriptions of voice buses.
shown in Figure 3-4.

VTM Bus

The VTM Busisa2.048 MHz Pulse Code Modu-
lated (PCM) bus containing 32 slots of tones or voice
the modules use to indicate call progressto an end user
by means of audio information.

Tx PCM Bus

Thisisa2.048 MHz Pulse Code Modulated
(PCM) bus containing 32 slots. Audio received from
the RF channel istransmitted on these slots by the
channel modules and received by the other system
modules.
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Figure 3-4 \oice Buses
Rx PCM Bus Master Clock
Thisisa2.048 MHz Pulse Code Modulated The Master Clock providesthe 2.048 MHz
(PCM) bus contains 32 dots. Audio is transmitted clocking signal for the PCM buses.
from the other system modules to these slots and
received by the channel modules to be transmitted on
the RF channel.
Master Sync
Master Sync provides the synchronization signal
for the PCM bus communication to begin the frame of
32 PCM dlots.
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3000 Series Switch
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SECTION 4 CALL PROCESSOR (CP)

4.1 INTRODUCTION

The Call Processor (CP) controls the Multi-Net
System. These components interface with the Switch
as shown in Figure 3-5.

The Call Processor controls and continuously
monitors Switch operation, provides logging of infor-
mation for billing purposes, and performs other func-
tions such as processing certain types of calls. The
Call Processor program runs on a computer that has a
Windows NT® 4.0 operating system and a Pentium®
233 or better microprocessor.

One Call Processor isrequired for each Switch,
and it must be co-located with the Switch. The Call
Processor program must be running for the Switch to
function. If desired, the local Call Processor and
Subscriber Management M odule can run on the same
computer. The following information describes the
data buses utilized by the Call Processor and some of
the main functions the Call Processor performs.

4.2 DATA BUSES

The NetIDB and NetCSB connect the Call
Processor to the Switch viathe NetNIM (Network
Interface Module). The Ethernet port connects the Call
Processor to other Call Processors and System and
Subscriber Managers. Refer to Section 3 for more
information.

NetIDB (Net Intra-Termina Data Bus)

The NetIDB isa 19,200 baud full duplex port

connected to the NetNIM (Network Interface Module).

The NetNIM buffers the Call Processor datato the
IDB (Intra-Terminal Data Bus). The Call Processor
communicates with the rest of the Switch modules on
the IDB viathe NetNIM.

NetCSB (Net Channdl Status Bus)

The NetCSB isa 19,200 baud full duplex port
connected to the NetNIM. The NetNIM buffers the
data from the CSB (Channel Status Bus) to the Call

Processor. The Call Processor communicates with the
rest of the Switch modules on the CSB viathe
NetNIM.

4.3 SYSTEM CONFIGURATION

System configuration provides initialization of
modules and database management. When a module
sends an initialization request to the Call Processor,
the Call Processor searches the configuration database
and sends initialization information to the module. If
the module number is not found, the Call Processor
creates an alarm and places the module in standby
mode.

4.4 STANDARD GROUP CALL

A Standard Group Call isacall originated by a
mobile which is destined for a Group of mobilesin a
given Locality. If the Group Call does not exist in a
WAC (Wide Area Call) configuration, the call
processing is handled by modules external to the Call
Processor/Switch. If the Group Call doesexistin a
WAC configuration, the Call Processor initiates Wide
Area Call Processing.

The Call Processor creates a Usage Accounting
record containing the Initiation Time/Ending Time of
the Standard Group Call.

4.5 WIDE AREA CALL

NOTE: Refer to Section 1.3 for more information on
wide area calls.

The Call Processor |ooks at each CSB (Channel
Status Bus) message and determinesif Group Call data
iscontained in aWAC (Wide Area Call) configuration.
If the Group Call Data does exist in a WAC configura-
tion, the Call Processor determinesif thereisan
existing WAM (Wide Area Module) configuration
containing the Group Call Data. If there s, the Call
Processor updates the Last Used Time in the WAM
configuration. If thereis not an existing WAM config-
uration, the Call Processor creates a new WAM
configuration based on the Registration Database and
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acquires afreeinternal and/or external WAM resource
and sendsa WAM Configuration Order to the WAM
resource.

If the WAC required an external (to the Switch)
WAM resource, the Call Processor sendsa WAC
Active Message to other Call Processors over the
network connection. After sending the WAC Active
Message to the other Call Processors, the originating
Call Processor waits for positive WAM Active Ack
Messages from each Call Processor. Once the Call
Processor has received each of the acknowledges, the
originating Call Processor sends an Active E&M Lead
Order to the WAM resource with the E-Lead and M-
Lead bits set.

If the Call Processor receivesa“nak” from any of
the other Call Processors, it does not send the Activate
E&M Lead Order. If the Call Processor receives a
WAC Active Message from another Call Processor
and the message contains any of the following, the
Call Processor sendsa WAM Active Ack Message
with an “acknowledge” to the other Call Processors.

* Anactive WAM Port Number and the message has
aHigher Priority

* An-equa priority and lower WAC ID

* The WAC active timers are within 5 seconds of
expiring

It also sends a WAM Configuration Order to the
associated WAM with that WAM Port Number. 1t then
sends an Activate E& M Lead Order with the E-Lead
bit set. Any other condition, the Call Processor sendsa
WAM Active Ack Message with a*“no acknowledge”.

If the Call Processor receives aWAC Active
Message from another Call Processor and the WAM
Port Number is not active, the Call Processor sends a
WAM Active Ack Message with an acknowledge to
the other Call Processors. It also sends a WAM
Configuration Order to the associated WAM with that
WAM Port Number. It then sends an Activate E& M
Lead Order with the E-Lead bit set.

If the WAC Active Message from another Call
processor contains a Unique ID that is different than
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the one sent to apreviously configured WAM, the Call
Processor sends a WAC UID Update Order to an
active WAM. There are response time-out periods,
expected acknowledges, and retries on the orders and
messages to an active WAM.

The Call Processor creates a Usage Accounting
record for the initiation and completion of aWide
Area Call.

4.6 REGISTRATION

If the Call Processor is configured for PTT Regis-
tration or auto-registration, it monitors the CSB for
Registration of Unique IDs. The Call Processor
updates the Locality information for the Unique ID in
the Registration Database. The Call Processor sends a
Registration Message to the other Call Processors over
the network connection (Ethernet).

When a Registration Request message on the
IDB isreceived from a CIM (Channel Interface
Module) the Call Processor formats and sends a
Registration Acknowledge Order back to the CIM
with the appropriate acknowledge information. The
Call Processor updates the Registered Locality, Home,
and User Status of the Unique ID. The Call Processor
sends a Registration Request message to the other Call
Processors within the system network via the
Ethernet.

These messages are acknowledged using the low
level network communication with a response time
out period. If thereis no acknowledgment from a
given Call Processor, an error record iswritten to the
alarm log containing the Unique ID, “no ack on
network registration” indication, Originating Call
Processor, Destination Call Processor that did not
respond, and a Date/Time Stamp.

When a Registration Request message isreceived
from another Call Processor, it is acknowledged viaa
Registration Ack Message back to the Originating
Call Processor. The received Registration Request
message is then processed by the Call Processor. If the
message contains Non-Zero Home/L ocality informa-
tion, the Call Processor updates the registered
Locality/Home and User Status for the given Unique
ID associated with the message.
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If the message contains Zero or Non-Zero Home/
Locality information, the Call Processor uses the
information for Wide Area Call Management. If the
message contains Zero for Locality/Home it isused to
de-register the unit from a Wide Area Call Configura-
tion. If the information changes the Wide Area Call to
add or delete a L ocality/Home/Group combination for
any or al Wide Area Calls the Call processor updates
the associated Wide Area Calls accordingly. This
includes Wide Area Callsthat are presently configured
inaWAM within the Switch and re-configuring the
associated WAMSs.

4.7 INTERROGATE

Interrogation is determining the Registered
Locality/Home and last User Status of a Unique ID.
There are two forms of interrogation: Static Request
from a console position, and Dynamic Function in
which the Call Processor tries to communicate with
the given subscriber unit (aping).

When a console position requests an interrogate,
the Call Processor sends a response back to the
console position with the Registered L ocality/Home
and Last User Status. The console then uses the infor-
mation to request a CIM (Channel Interface Modul€)
in the Registered Locality (if it iswithin the Call
Processor/Switch combination) to interrogate the unit
if itisamobile.

To interrogate a mobile the System Operator
entersthe desired Locality and Home repeater
numbersto use. All Call Processors receive the inter-
rogate request message, but only the one with the
requested mobile responds. Otherwise, the Call
Processor selects afree channel from the desired
Locality and sends an Interrogate Request to afree
CIM.

If the CIM accepts the request, the Call Processor
waits for aresponse. If the request is denied, the Call
Processor selects a new free channel on the desired
Locality and tries again. If there are no free channels
or al channels have been requested with no positive
acknowledge, the System and Subscriber M anager
displays “All Channels Busy” or times out to the
requesting function. The Call Processor waits for a
response from the acknowledged requested CIM. If

4-3

there is no response in 10 seconds, the System and
Subscriber Manager displays “no mobile response’.

If the CIM responds, the System and Subscriber
Manager displays the information from the CIM Inter-
rogate Response. The System Operator is able to exit
the interrogate unit function, otherwise the System
and Subscriber Manager remainsin the function.

Theinterrogate is used by the Call Processor for
de-registration of subscriber units that are being
tracked for Wide Area Calls. If the Unique ID last
registration timer expires, then the Call Processor
determinesif the unit is still active.

The Call Processor performs an interrogation on
the unit if the last Registered Locality iswithin the
given Call Processor/Switch. If the unit islast regis-
tered on a L ocality outside of the given Call
Processor/Switch then the Call Processor does not
perform the interrogation. The Call Processor selectsa
free channel on the last Registered Locality, if within
the Call Processor/Switch, to interrogate the unit. If
there are no free channels or all channels deny the
request, then the Call Processor queues the unit to be
de-registered.

If aCIM accepts the Interrogate Request and the
CIM responds with an Interrogate Response, then the
Call Processor updates the last registered time of the
Unique ID and continues to the next task. If thereisno
response from the CIM in 3 seconds, the Call
Processor assumes the mobile unit is no longer active
in the Locality and sends a registration order with
Locality O (zero), Home O (zero) on the Registration
Bus (Ethernet). This does not update the Registered
Locality to zero but must be used by Wide Area Calls
to update the mobile information and which Locali-
tiesto use in the Wide Area Calls. The Call Processor
continues after the Interrogate Response or the time
out.

The Call Processor searchesthe CSB information
and determinesif the Unique ID to beinterrogated is
active on achannel. If the unit is active on a channel
and isin the Locality/Homeit isregistered on, the Call
Processor may not send an interrogate request to afree
CIM.
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4.8 DYNAMIC REASSIGNMENT

Dynamic Reassignment sends a command to a
subscriber unit to reprogram the transmit/receive
Group ID and user priority level of Group 11 of the
desired selectable system. It is also used to automati-
cally switch atransceiver to a specific system/group
selection. Thisfunction isalso used in the execution of
a Reassignment Plan.

When a system operator is permitted to initiate a
Dynamic Reassignment, the following information can
be entered:

OTAR (Over-The-Air Reprogramming) of Group 11

® Unique ID of the subscriber unit to be reassigned
* Thelocality/home on which the reassignment isto
be attempted (the last known registered locality/
home is the default)

System position to program

Priority level

Receive Group ID (GID)

Transmit Group 1D (GID)

Move To New System/Group

® UniqueID of the subscriber unit to be moved

* Thelocality/home on which the move isto be
attempted (the last known registered locality/home
is the default)

® System and Group to select

The System and Subscriber Manager asks for
verification (Yes or Cancel). Once verification is
confirmed, the System and Subscriber Manager/Call
Processor perform the Dynamic Reassignment. The
System and Subscriber Manager then displays the
following information:

Request compl eted successfully

Not acknowledged by the subscriber unit
No response (time out)

No channels were available, try again

Dynamic Selection is aso used by the Call
Processor when executing Reassignment Plans. The
Call Processor attempts the Dynamic Selection and
responds back to the Reassignment Plan indicating the

status of the Dynamic Selection for agiven UniqueID.

The Call Processor attempts the Dynamic Selec-
tion on the desired Locality/Home. The Call Processor
attempts to find a free channel on the desired L ocality,
starting with the Home channel. If the Dynamic Reas-
signment Order is sent to the free CIM and the order is
not acknowledged by a Module Response Message
from the CIM, the CIM is marked as busy and another
attempt is made to find a new free channel.

If atime out of 2 seconds is reached the Dynamic
Reassignment Order is tried once moreto find afree
channel. If afree channel is not available, a“no
channel available” statusisindicated to the requesting
function and the dynamic Reassignment Order is
exited.

If the Dynamic Reassignment Order is acknowl-
edged, adelay of 5 minutesis alowed for an Execute
Dynamic Reassignment Message. If no message is
received from the CIM in the time out period thereisa
“request not performed” indication. When the Execute
Dynamic Reassignment Message isreceived, it is
acknowledged by a Call Processor Response Order
and waitsfor 3 seconds for a Dynamic Reassignment
Response Message from the CIM.

If thereis no responsein the time out period from
the CIM a*“no performed status to the requesting func-
tion” is displayed. If the CIM responds with a
Dynamic Reassignment Response Message, the
response isindicated to the requesting function when:

® Successful

* No Acknowledge, thentimesout (No RF Response,
Mobile No Acknowledge then Subscriber No
Acknowledge).

This execution is the same as for a Dynamic
Reassignment.

4.9 REASSIGNMENT PLAN EXECUTION

A Reassignment Planisinitiated for execution by
a System Operator using the System and Subscriber
Manager. The chosen Reassignment Plan to executeis
configured again by a System Operator using the
System and Subscriber Manager. When a Reassign-
ment Plan is executing, it uses the Dynamic Reassign-
ment and Dynamic Selection functions.
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A Reassignment Plan is a Dynamic Reassign-
ment or a Dynamic Selection for a given subscriber
unit Unique ID. When a Reassignment Plan is initi-
ated, a Reassignment Plan Log is opened and aLog
Record indicating which Reassignment Plan isiniti-
ated and the Date/Time. A retry indicator is cleared.
The Reassignment Plan executes by looking at the
Unique ID of atransaction and the information in a
transaction. The information indicates a Dynamic
Reassignment or a Dynamic Selection must be
performed. The Reassignment Plan uses the Regis-
tered Locality and Home of the Unique ID to perform
the transaction.

The Call Processor uses only the allowed number
of channelsin the given Reassignment Plan Configu-
ration for simultaneous transactions. If there are
multiple transactions for a given Unique ID, these are
performed second after there is aresponse to the first.
Other simultaneous transactions are performed on
other Unique IDs while the first transaction is being
executed. If atransaction is responded to with a“no
RF response” (mobile time out) or not performed (no
available channels), then an indication for aretry
isset.

When al transactions of a plan are attempted, the
Call Processor determinesif the retry indication was
set. If the retry indication is active, the Call Processor
determinesif the Reassignment Plan hasretries and if
the number of retries was met. If the number of retries
was not met, the Reassignment Plan is executed for
those transactions not marked for successful or no
acknowledge from the mobile. Once all retries have
been attempted, the Reassignment Plan is complete. A
log record is written indicating the plan is complete
with the associated Date/Time.

The response to a transaction iswritten to a
History Log for the given executing Reassignment
Plan. The log record includes the Unique ID, Transac-
tion Data, Response and Time. The responseis.

Successful

No RF response (mobile time out)

No acknowledge from the mobile

Not performed (no available channels).

4-5

4.10 USAGE ACCOUNTING
4.10.1 GENERAL

The Usage Accounting process isimpacted by
the following log database tables or files:

Call Usage
Reassignment Messages
Auxiliary Calls
Telco Calls
Queued Calls
CSB Usage (all PTTs)
* Reassignment Plan Logging
Registration Logging

4.10.2 ERROR MESSAGES AND INTERNAL
ERRORS

The Call Processor receives error messages from
modules and also failures during other processes. The
Call Processor generates an Error Record written to
the Alarm Log that contains a Running Alarm
Sequence Number (see Appendix A for alist of error
numbers and definitions).

4.10.3 CALL USAGE LOGGING

Call Processing generates certain types of records
and writes them to the Activity Log or Call Usage
Log. Types of Usage Records are as follows:

Reassignment M essages - Whenever a Reassign-
ment Rx Message, Reassignment Tx Message or
Reassignment Clear Message is received from a
module the Call Processor writes a Reassignment
record to the Call Usage Log.

Directed Call (UID Call) - A Directed type (using spe-
cial Group ID 236) Call Recordisgenerated by the Call
Processor and written to the Call Usage Log.

Telco Call - A Telcotype (using specia Group ID 237)
Call Record generated by the Call Processor and writ-
ten to the Call Usage Log.

Queued Call - Certain mobile originated Directed or
telco calls may be Queued Calls. The Call Processor
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writes either an SNM or TIM Queue Record to the
Queued Call Log.

4.10.4 CSB USAGE

Call information is derived from the CSB
(Channel Status Bus). The Call Processor notes a
change of usage state when the Locality/Home/Group
ID/Unique ID for agiven Switch channel number
changes.

The Start Date/Time is determined when the
information goes from idle to active or from one
L ocality/Home/Group ID/Unique ID combination to
another. The End Date/Time is determined when the
information goes from active to idle or from one
Locality/Home/Group ID/Unique ID combination to
another.

When the CSB changes from one L ocality/Home/
Group ID/Unique ID combination to another, it isthe
end of one call and the beginning of another call for
CSB Usage. Thisisabirth/death process and the Call
Processor writes a CSB Usage Record to the CSB
Usage Log at the end of the CSB call.

CSB calls can be divided into these three
categories:

1. Group Dispatch Calls. They have a Group 1D
between 1-225 and a Home between 1-30

2. Special Callsare “Directed” which uses Group 1D
236 and “ Telephone” which uses Group ID 237.

3. Other calls which use Group 1Ds between 226-255.

For Special and Other calls, the Home value
represents the channel that was being used instead of
theradio’s registered Home. Occasionally a Home
value of zero is used when the infrastructure cannot
resolve the Channel or Home.

4.10.5 REGISTRATION LOGGING

Registration information islogged to a Registra-
tion Log. When Registration request messages are
received from channel modules, the Call Processor
creates arecord in the Registration Log.

4.11 STATUS MONITOR
4.11.1 INTRODUCTION

The Status Monitor program shows log and
message entries that have occurred on the Call
Processor. It istotally independent of the Call
Processor program. Clearing a status or deleting a
message has no affect on the Call Processor. The main
Status Monitor screen is shown in Figure 4-1. To
display this screen, simply click the Viking logo in the
system tray area of the screen (see below).

. ]
Status Monitor Icon

The face color of the Viking icon changesto indi-
cate the most severe of the following conditions:

Color Condition
White Normal
Yellow Warning
Red Errors

The upper pane of the main screen indicates Call
Processor messages as they occur. The bar graph in the
lower pane indicates the percentage of Normal,
Warning, and Error messages currently being

displayed.

Right clicking the Viking icon in the system tray
displays a menu which can be used to Exit the
program, Hide/Show the display, and Reset Status (see
following). If the Status Monitor program is not
running, it isusualy restarted by selecting Start >
Programs > Startup > Status Monitor.

4.11.2 LOCAL SERVICE MENU

Bestart
HideConzale

The following functions are selected by the Local
Service menu shown above:
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® Status Monitor

Local Service  Meszages

3-8-01 1:44:42 PH
3-8-01 1:44:42 PH
3-8-01 1:44:42 PH
3-8-01 1:44:42 PK

Dizplay  About

Hide

Total SHE Count =1 -
==== Hew Guy messzage received from [swvitch2] 204 _.220.10.232==== Humber of 1
Total SHE Count =1

==== Hew Guy me=sszage received from [=swvitch2] 204 _220.10.232==== Humber of 1

Vac_id 1

| o

3-8-01 11:09:34 AN —— Database Scan Thread Priority Adjustment Complete
3-8-01 11:09:34 AH — Attempting To Adjust Database Scan Thread Priority
3-8-01 11:09:34 AN —— Timer Thread Priority Adjustment Complete
3-8-01 11:09:34 AN — Attempting To Adjust Timer Thread Priority
3-8-01 11:09:28 AH —— VACAbortH=g Sent with Sequencelumber 2
3-8-01 11:09:26 AN —— Create Database Scan Cur=zor Complete
378701 11:09:26 AHM — Attempting To Create Database Scan Cursor
3-8-01 11:09:26 AH —— Read Database Open Complete
3-8-01 11:09:26 AN —— Attempting To Open The Read Database
3-8-01 11:09:25 AH — Read Database Session Initalization Complete
3-8-01 11:09:25 AH — Read Database Initalization Complete
3-8-01 11:09:20 AN —— 5 =econd pause for debug tool =tartup
37801 11:09:20 AH — Initiating Event Dispatch Processing
3-8-01 11:09:20 AN —— Completed Execution In ArchStart_ FPreEventProcessingStart
3-8-01 11:09:20 AN —— Starting Emzecution In ArchStart PreEventProcessingStart
37801 11:09:20 AH — System Initialization Complete
3-8-01 11:09:20 AN —— Start Debug TCF Subsy=tem Complete
<
Message Counts: Infa 1 Statuz 53 Tatal B0

Q-:._=\\EQ-—<_=\E Q-—c:\: Q~—c._=\i Q-—c.r‘i\ Q-_:__w:\ Q-—c._w'\ o Q*—é.‘\ Q~—§?\ Q-—?r\ Q-}cr\ e Q'r—c.r\ -, Q-—c:\ .Q“"-'\ EQ‘—‘?\EQ‘—‘-‘\ M Status
-~ Il Information
1] a2 10 15 20 23 30 33 40 43 a0 o9 =11 B3 ] T a0 3 an 93 100
Percentage of Messages
Service Running [HEALTHY] Connected |

Figure 4-1 Call Processor Status Monitor Main Screen

Shutdown - Stops the Call Processor program.
Restart - Restarts the Call Processor program.

Show Console/Hide Console - Shows or Hides the
following DOS window that a so indicates Call
Processor messages.

CAUTION

Sdecting the closeicon (X) in the Console window
shown below Shuts Down the Call Processor program
(a confirmation window is not displayed). Therefore,
DO NOT close this window unless this is what you
want to do.

4.11.3 MESSAGES MENU

Dizplay

Bezet Statuz
Clear Al
Save ToDizk
Lirnit ..
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The following functions are selected by the
M essages menu shown above:

Reset Satus - Clears only the status entries and the
Viking head changesto white.

Clear All - Erases al messages, clears al the Status
entries, clears the graph, and the Viking head changes
to white.

lu C:\Program Files\EFJohngon\Series 3000 Call Processor\Series 3000 Call Processor_exe
Systen Initialization Complete
Kok ok x xR kR

Thu Mar
Thu Mar
Thu Mar

Starting Execution In ArchStar
Completed Execution In ArchSt
Initiating Event Dispatch Pro

singStart

ete
Session Inltall._atlun Gomplete
Open The Read Datahase

Attempting To Create Database Scan Cursor
Create Datahase Scan Cursor Complete
UACAbortHsg Sent with SequenceNumber 2
Attempting To Ad Tiner Thread Prigrity
Liner Thread Pridrity fdjustnent Complet
fAttempting To Ad 2c Scan Thread Prior ity
Database Scan Th pei ty Adjustment Complet

Neu Guy message received from [switch2] Zﬂ'i 220.10.232

Wac_id 1

a
flnm 1

al SMM Count =1
:44:42 2801
Humber of REMOTE SHI
DataBase update recieuv
Mar A8 13:44:42 2001
Total SMM Count =1

Neg Guy message received fwom [switch2] 204.220.10.232

Call Processor DOS Window
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Save To Disk - Saves the Status messagesto afilein
an RTF format.

Limit . .. - Setsthe maximum number of entriesin the
log. When the number of entries reaches this set
number, anew entry isentered at the top of the log and
the last entry drops off from the log.

4.11.4 DISPLAY MENU

fl atal

Dizplay

Soundz
Status

Sounds - Displays the following screen which is used
to program the sounds that occur when various events
take place.

* Sounds =]
Play Sound On Mew &lam

Ciitical Sound File

|
Errar Sound File

I ﬁl (= Browse
‘Warning Sound File

r ﬁl (= Browse
Infi S ound File:

r ﬁl (= Browse
Status Sound File

I ﬁl (= Browse

4-8

Satus - Displays the following screen which is used
to program the messages that are displayed when
various events occur.

* Display Text

Nao Connection to Service
INo Carnection To Service

Service Stopped

ISElvin:E Stopped

Service Running
|Sewice Riunning

Service Shutting Down
|Sewice Shutting D own

Service Restarting
ISelwce Restarting

Service Starting Up
ISelwce Starting Up

4.11.5 ABOUT MENU

About - Displays the following screen containing
information about the Status Monitor program.

Series 3000 Status Monitor
Version 37.0.0

i} EFJohnson

Copyight € E F.Johnson 1338 - 2000
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SECTION 5 SYSTEM AND SUBSCRIBER MANAGER (SSM)

Current Uzer:. HHOEM

File Tools Diagnostics Windows  Help

Current Mebwork:  Metwork, 100

SSM Main Screen Menu Bar

— FILE (Section 5.2)

—— TOOLS (Section 5.3) —

— Group Manager (Section 5.3.1)

— Permissions Profile Manager (Section 5.3.2)
—— Reassignment Plan Manager (Section 5.3.3)
—— Subscriber Manager (Section 5.3.4)

L System Locality Manager (Section 5.3.5)
—— Wide Area Call Manager (Section 5.3.6)

MAIN MENU —— - Switch Configuration Manager (Section 6)

- User Privilege Manger (Section 5.3.8)
L Network Names Manager (Section 5.3.9)

—— DIAGNOSTICS (Section 5.4)

—— WINDOWS (Section 5.5)

—— HELP (Section 5.6)

Figure 5-1 Main Screen Menu Structure
5.1 GENERAL * Generatereportsfrom theinformationlogged by the

5.1.1 INTRODUCTION

The System and Subscriber Manager (SSM)
administers the Multi-Net System. The Call Processor
(CP) and SSM connect to the Switch as shown in
Figure 3-5. The CP is described in Section 4. Some of
the functions the SSM performs are as follows:

* Manage the database used by the Call Processor.
Thisincludes viewing, setting, or modifying the
Locality/Home/Group 1D and the Unique ID
permissions.

* Monitor Switch operation and provide logging of
information for billing purposes.

* Display alarm and current system configuration via
amenu-driven display format.

Call Processor.

* Disable, reprogram, interrogate, and reassign
individual subscriber units.

* Enableand disablethe modules of any Switchinthe
network.

The SSM program runs on the desktop (work
station) of apersonal computer that is equipped with
the Windows NT® 4.0 operating system and a
Pentium® 233 or better microprocessor. The CP and
local SSM functions may run on the same computer if
desired. The SSM program does not need to be contin-
uously running for the Switches to operate, unlike the
Call Processor program.

The information which follows describes the
parameters that are programmed in the various SSM
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screens. The main SSM menu and a flowchart of the
menu structure are shown in Figure 5-1. Also shownis

described. The various SSM program functions are
also summarized in Table 5-1.

the section of this manua in which each function is

Table 5-1 Main Menu Functions

Menu

Sub-Menu

Description

NOTE: The Window Title isuser configurable using the Windows Menu described in Section 5.5.

File Select Network Network Numbers refer to the network of Call Processors to which the SSM is
linked. Network Names can be used along with numbers to make identification
and selection easier.

Reload Distributed Tables Retrieves the latest table settings shared by all Switches.

Properties Selects the sounds from a Sounds file that play when an alarm is activated.

Enter New Key Enters a new encryption key when required for such things as enabling updated
software or converting demonstration software to a fully operational program.

Import From File This allows previously exported text (.txt) files to be updated after external
modification.

Export To File This function allows the current datato be written to atext file astab Delimited
Text (for importing to a spreadsheet program, for example€) or in Formatted Text
(for importing into aword processor program).

Print This function displays the current data on pages which can then be printed if
desired.

Exit Closes the System and Subscriber Manager program.

Tools Group Manager Creates and maintains a Group 1D list.

Permissions Profile Manager | Configures Unique ID and telephone permission for Subscribers and Dispatcher
Consoles.

Reassignment Plan Manager | Allows Dynamic Reassignments (Reprogram) or Dynamic Selections (Move)
to be entered and saved in a plan that can be executed at any time.

Subscriber Manager Allows the Unique IDs to be viewed and modified and subscriber units to be
interrogated, disabled, etc.

System Locality Manager Programs the Switch ID number and the associated L ocality IDs.

Wide Area Call Manager Configures Wide Area Calls using Home/Group ID/Locality data.

Switch Configuration Manager | Global Switch Locality configuration of shelves, modules and Telco call logs
and System monitor functions (see Section 6).

User Privilege Manager Used by the System Administrator to set which SSM functions are available to
Subscriber Managers.

Network Names User defined name assigned to system components on a Logical Network to aid
intheidentification of other components on the Logical Network. There may be
multiple Logical Networks on a single Physical Network.

Diagnostics |Call Processor List Shows all active Call Processors on the current Logical Network .

Receiver Buffer Shows Switch specific Network traffic.

Send Who's There I ssues a broadcast message to all Call Processors on the Network. Responses to
the broadcast can be viewed using the preceding Recelver Buffer window.

Windows |Cascadeor Tile Arranges all open windows in either a“block” or “overlay” format.

Set Title Allows the System Administrator to change the name of the main window.

Current See Section 5.3.8 on page 5-15 |Network name of the user logged in to the computer running the SSM.

User

Current Name of the Network in which the SSM is operating (see Section 5.3.9 on page

Networ k 5-17).
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5.1.2 SETTING UP NEW SYSTEMS

When setting up a new Multi-Net system, certain
parameters must be programmed before others. There-
fore, it is recommended that the following program-
ming order be followed:

L ocal Switch
1. Installation Properties (Section 6.3)
2. Configure Switch Cards (Sections 6.1.3 and 6.4)
Distributed Tables
3. System Locality Manager (Section 5.3.5)
4. Permissions Profile Manager (Section 5.3.2)
. Group Manager (Section 5.3.1)
. Subscriber Manager (Section 5.3.4)
. Wide Area Call Manager (Section 5.3.6)
. Reassignment Plan Manager (Section 5.3.3)
Local PC
9. User Privilege Manager (Section 5.3.8)
10.Network Names Manager (Section 5.3.9)

0 N O Ol

Some of the information required to program a
system is asfollows:

Name of switch

Number of localities

Name of each locality

Number of repeaters at each locality

Conventional repeaters (if any)

Number of CIMs required in switch (one per rptr)
What talk groups will be set up and which locality
will be the home of each.

* What unique IDswill be assigned to each home
repeater

5.2 FILE MENU

[W[EW Tools Diagnostics  Windows  Help
Select Metwork. .
Reload Distributed Tahbles

Current Ne

Froperties...

Enter MNew Kesy...

Impor from File »
Exportto File »
Print

Exit

5.2.1 SELECT NETWORK

% Select Network I [=] B3 |

Metwork Nurnber

100

Network Namne

Network 100

X Cancel
Metwark Names |

] <] ]w]

The File Menu “ Select Network” parameter
selects the Network of Call Processors to which the
System and Subscriber Manager is attached. The
Network(s) in which a particular System and
Subscriber Manager can operate is determined by the
System Administrator.

The Networks can be given names to make iden-
tification and selection easier. Network names are
entered using the Tools > Network Names menu
described in Section 5.3.9.

5.2.2 RELOAD DISTRIBUTED TABLES

The File Menu “ Reload Distributed Tables’
parameter reloads distributed tables by retrieving the
latest table settings shared by all Switches.
5.2.3 PROPERTIES

The Files > Properties screen which follows

sel ects the sound that plays when specific dlarms are
activated.

Flay Sound On New Alam
Critic.al Alarm Sound File

Hajor Alarm Sound File

Minor Alam Sound Fils

Informational Alam Sound File
r
Unknawn Alarm Sound File

S E— |

5.2.4 ENTER NEW KEY

This screen is used to enter anew encryption key
when required for such things as enabling updated
software or converting demonstration software to a
fully operational program.
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5.2.5 IMPORT FROM FILE

IDDIS Diagnostics Windows  Help

Select Metwark. ..
Feload Distributed Tables

| Current Metwork: |

Froperties..

Erter Mew Key..

Import from File Delimited Text |
Exportto File 4

Print

Exit

This function allows previously exported text
(.txt) filesto be read back in. Do not attempt any
external modification of atext filethat isto be
imported because improper operation may result.

5.2.6 EXPORT TO FILE

Tools Diagnostics  Windows Help
Select Metwark...
Feload Distributed Takles

Cument Network:  Mebwork 1

Properties...
Enter MNew Keny..

Import from File 4
Exportto File Delimited Text
Frint Farmatted Text Repont

Exit |

This function writes the current table to atext
file. The Delimited Text function formats the text in
tab delimited columns for spreadsheet programs, and
the Formatted Text Report function formats the text
for viewing using word processor programs.

5.2.7 PRINT

This function displays the current log, table, or
dataasit will look when printed. The displayed pages
can then be printed if desired by clicking the printer
icon on the top. The report can aso be viewed, saved
to afile, or another loaded by clicking other icons on
top.

The print choices that are available depend on
what table or log is currently being displayed. For
example, if the Usage Log described in Section 6.3.8
isdisplayed, there are several different reportsthat can
be selected.

5.2.8 EXIT

Exits the System and Subscriber Manager
program.

5.3 TOOLS MENU

% Senes 3000 System and Subscriber Manager

Fil= QKGR Diagnostics  Windows  Help
Curr Group Manager... Current Metwark:  Metwork, 100

Permizzion Profile Manager...

FReaszignment Plan Manager...

Subszcriber Manager...

System Locality Manager...

Wide drea Call Manager...

Switch Configuration Manager...

Uzer Privilege Manager...
Mehwaork, Manmes. ..

The preceding tools menu is used to select the
screens for the program functions that are common to
all Switches on the network. Parameters unique to
individual Switches are programmed by the Switch
Configuration Manager described in Section 6. The
Tools screens and the section of this manual in which
they are described are as follows:

Group Manager Section 5.3.1 (pg 5-4)
Permissions Profile Manager Section 5.3.2 (pg 5-6)
Reassignment Plan Manager Section 5.3.3 (pg 5-7)
Subscriber Manager Section 5.3.4 (pg 5-9)
System Manager Section 5.3.5 (pg 5-11)
Wide Area Call Manager Section 5.3.6 (pg 5-12)
Switch Configuration Mngr ~ Section 6

User Privileges Manager Section 5.3.8 (pg 5-15)
Network Names Section 5.3.9 (pg 5-17)

5.3.1 GROUP MANAGER

The Group Manager screen shown in Table 5-2
creates and maintains the Group ID list. The Permis-
sion of Group IDsis set on a Locality/Home/Group
basis. Up to 30 Home channels can be declared per
Locality, and deletions and allocations are done per
L ocality/Home/Group.

The Locality/Home/Group combination to be
programmed is selected in the right pane and then the
applicable button (Enable/Disable/Delete) is clicked.
The status of all groups in the network isindicated in
the left pane. A name and description can be entered
for each group to help identify it.
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Table 5-2 Group Manager Screen

o a0 a4 a0 a0

1/ True
2 True
3 True
4 Tiue
5 True
B True
7 True
8 True
9 True
10 True
11 True
12 True
13 True
14 True
15 True
16 True
17 Tiue
18 True
19 True

—Set Range
Locality

Harme

Group

7
2
100

[F=R== = T T

0000 =) O T e G P —

[Pr——
apa =

=

Function

Parameter

Description

Locality

1-255

Selects the Locality number.

Set Home

1-30

Selects the home repeater number.

Set Group

1-225

Selects the ID code of the group.

Enable

Activates Locality/Home/Group selection.

Disabled

Deactivates L ocality/Home/Group selection.

OK

Saves the current data and closes screen.

Apply

Saves the current data without closing the screen.

Cancel

Closes the screen without saving the current data.

Delete

Deletes the selected L ocality/Home/Group.

5-5
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5.3.2 PERMISSIONS PROFILE MANAGER sion profiles that are assigned to subscriber units and

dispatch consoles. The assigned profile determines the

The Permission Profile Manager screen is shown unique 1D and Telephone call rights of the unit.
in Table 5-3. This screen is used to set up the permis-

Table 5-3 Permission Profile Manager Screen

% FPermission Frofile Manager

Permizzion Prafile

I Drefault
24

Mezzage

Tirneout [Hours) [T Directed Out Blocked

[ Dizpatcher

x [T Inbound Telco Blocked
[T Outbound Telzo Blocked

|This iz the default profile,
Teleo Mialing Rule Group

I DialingRuleGroupl ;I

35 Add Dialing Fule Group... | *% Delete Dialing Fule Group

Permission Profile Screen

% Add Dial Rule Group [_ 1] & Add a profile [_ 1]
MNew Dial Rule Group Name MNew Profile Name
I |
& OK | X Cancel | & OK | X Cancel |
Add Dialing Rule Group Screen Add Profile Screen
Function Description

Permission Profile

Selects the Profile name to edit or click the “Add” button to create a new Permission Prof
file. The above Add Profile screen is displayed to enter the name of the new profile. The
new name then appears in the Permission Profile drop down list.

Time Out Registration Time-Out in hours. If a subscriber unit has not registered for this amount of
time, an interrogate message is sent and de-registration occurs if no response is received.
Dispatcher Thisis selected for consoles and not selected for mobiles/portables.

Directed Out Blocked

When checked, directed out (directed group/unique ID) calls are not permitted by the
selected UID.

Inbound Telco Blocked

When checked, incoming Telco calls are not allowed.

Outbound Telco Blocked

When checked, outgoing Telco calls are not allowed.

Message

A note for the System Operator that provides more information about the Profile.

Telco Dialing Rule Group

Selects the desired Dialing Rule from alist. Refer to the Switch Configuration Manager
description in Section 6 for more information.

Add Dialing Rule Group

Adds anew Dialing Rule Group to the existing list. The new group must then be set up as
described in 6.3.10.

Delete Dialing Rule Group

Deletes the selected Dialing Rule Group from the existing list.

Save

Causes Permission Profile datato be immediately stored and used by the Call Processor.

Cancel Unsaved changes to the Permission Profile are disregarded and the screen is closed.
Add Adds anew Profile Name.
Delete Deletes the selected Profile from the Profile List.
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5.3.3 REASSIGNMENT PLAN MANAGER

NOTE: Refer to Sections 4.8 and 4.9 for more infor-
mation on this feature.

The Reassignment Plan Manager screen is shown
in Table 5-4. This screen allows Dynamic Reassign-
ments and Selections to be entered and saved in aplan
that can be executed at any time. Dynamic Reassign-
ments reprogram Group 11 of the specified selectable
system in specified subscriber units with new encode
and decode | Ds and access priority. Dynamic Selec-
tions automatically move the specified subscriber units
to another selected system/group (for example, to
receive an important message).

The System and Subscriber Manager configures
and manages the operation of Reassignment Plans and
displays which Reassignment Plan is active. Only one
plan in the entire system (including all System and
Subscriber Managers) can be active at any one time.

5-7

If no plan is active, the System Manager has the
ability to select a plan from alist and initiate the
execution of the selected plan. Once aplanisinitiated
for execution, the Call Processor maintains a history of
the successes and failures of the Reassignment Plan’'s
transactions. Each success or failure records the trans-
action, and atime stamp. When aplan is compl ete or
is aborted (stopped) the history is written to non-vola-
tile storage on the Call Processor at the time of each
transaction. A System Manager (verified with an abort
Yes/No question that must be explicitly answered) can
abort an executing plan.

The System and Subscriber Manager can display
a selected plan history to view from alist of Reassign-
ment Plans executed. Once aplanisinitiated for
execution the Call Processor writes alog record indi-
cating a Reassignment Plan execution was initiated,
which plan was initiated, the System Manager I1D
logged in at the initiation and atime stamp. The
System and Subscriber Manager displays a Reassign-
ment Plan is executing and which plan is active.
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Table 5-4 Reassignment Plan Manager Screen

gnment Plan Manager

Plan Humber

Flan Hame

TestPlan] - Summits
TestPlan - 85uu's
RezetGroupl1 - Summits
ResetGroupll - B5uw's
SingleS ummitT ezt
RezetSingleSunmmit
TestPland - 38"z

Fietries

_ISD

F

t aximum Channels

Plan Status—
" In Progress
= "~ Complete
[  Idle

| [ |

& Abort | 3 Delete | H & |

&3 Execute | i add

-

} Betrieve Cunent Status | x LCancel |

% Add Action.. | *+% Delete Action... | " Ezecute Selected Action

Reprogram

UID |Sel. Sustem |Gloup Selection |Encnde Group |Decnde Group |F'li0rit_l,J ITimes Retried |Status | o
1001 2 11 13 13 5 1 Success :’
10 2 1 0 a 5 1 Success
1000 2 1 0 a0 l 2 Success
1000 2 1 13 19 5 1 Sucocess d

Plan |ast executed by: SWITCHT:Adminiztratar

Function Parameter Description
Plan Number A unique number assigned to a Reassignment Plan.
Plan Name Reference name assigned to the plan number.
Retries Maximum number of times an attempt should be made to reach a

mobile upon initialization of a Reassignment Plan.

Maximum Channels

The maximum number of channelsthis Plan is allowed.

Plan Status In Progress, Complete, Idle |The result of attempts made to contact the mobiles.

Execute Starts implementing the selected plan.

New Sets up the screen to create a new Reassignment Plan.

OK Saves current data shown and closes dialog.

Abort Halts the currently executing Reassignment Plan.

Delete Deletes the selected Reassignment Plan.

Apply Saves the current configuration and leaves dialog open.

Retrieve Current Status Displays the current Reassignment Plan information.

Cancel Deletes data entered for a new Reassignment Plan.

Execute Selected Action Executes only the individual action selected by the cursor.

Delete Action Deletes only the individual action selected by the cursor.

Add Action Includes anew individual action to the plan.

Action Move, Reprogram, Group  |Move mobile to a different System/Group, Reprogram mobile to

Tag Group 11 or Reassign a new Group Tag.

Decode Group 0-225 Group ID programmed into Group 11 associated with the Home
repeater to identify the Group to receive from.

Encode Group 0-225 Group ID programmed into Group 11 associated with the Home
repeater to identify the Group to transmit with.

Group Selection 0-99 Group to use to moveto in the selected System.

uiD 1-8163 (8164-8191 reserved) Unique ID assigned the mobile unit.

Priority 1=highest, 5=lowest Priority Access number.

Select System 1-16 Select new system number for Dynamic Reassignment/Selection.

Times Retried The number of times attempted to contact an individual mobile.

Status Result of the attempts made for the individual mobile.

Plan List executed by

Thisisthe Computer name and User’s NT login name.

NOTE: To print a Reassignment Plan report, select File > Print from the main menu bar.
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Table 5-5 Multi-Net Reassignment Plan Add Action Screens

| %: Reassignment Plan Add Action [ (O] =} % Reassignment Plan Add Action
lC  Move System/Group
" Reprogram Group X Cancel | I 'l : X Cancel |
UID Selected System UiD Selected System
1007 4] = 1001 =l =
1002 1002
1003 Group Selection 1003
1004 |_F—L, 1004
{{]1008 1005
{/]1008 1006
"io07 1007 Encode Grou
(|08 1008 =
[k 8180
18 81 Decode Group
8182 i 8182 | -]
8183 8183
g184 8184 Friarity
8185 — 8185 b =
8186 8186
8187 8187
8188 8188
8189 [ 8189 =
Action: Move System/Group Action: Reprogram Group 11
Function Par ameter Description
Action Move System/Group Assigns different System/Group Numbers.
Unique ID 1-8163 (8164-8191 reserved) | Unique I D assigned the Mobile unit.
Selected System 1-16 Select anew System number for Dynamic Reassignment.
Group Selection 0-225 Group ID to send Dynamic Reassignment to.

Action Reprogram Group 11 A Unique ID isreprogrammed over-the-air with a new System/Group.

Encode Group 0-225 Thisisa"Transmit To" Group ID that is associated with the Home
repeater programmed into Group 11.

Decode Group 0-225 Thisisa"Receive From" Group ID that is associated with the Home
repeater, programmed into Group 11.

Priority 1=highest, 5=lowest Priority Access number.

5.3.4 SUBSCRIBER MANAGER

The Subscriber Manager screen isshownin Table
5-6. This screen alows the configuration of Unique
IDs to be viewed or modified. It can also Suspend
Audio, Terminate/Kill aUnique ID (immediately or
wait until the next activation), Reassign a User, and
Interrogate a mobile. Responses to these requests are
displayed by a special User Message screen. This

5-9

screen can also be displayed by selecting Diagnostics
> User Messages as described in Section 5.4.4.

New Users can aso be added or edited and
Permission Profiles added or edited. The status of the
selected user isindicated. A User’s Telephone
Number, Priority, and Permission profile may be
changed directly in this screen.
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Table 5-6 Subscriber Manager Screen

% Subscriber Manager =l B
MuliNet | wide reaLTF |
LI LocalitylHome |F‘hone Number |F‘riority |Eurrent Status |Selected Statusl Permizsion Profile |Name |Description IHegisteredl ﬂ
14 2 1/ B07E3RT000 il |dle 01 Diefault Jim Hime Primary System Test Radio | False -
| oo 2 1 s07R3Et0n 5 Idle 0 Defaul Fake H zoo |
| o2 2 1 s07eIEI002 5 Idle 0 Defaul Fakse
] tom 1 1 soremi0 § Ide 0 Defaul False ngl
| o411 507835100 5 Idle 0 Default Fake & Reload |
|| 05 1 15078351005 5 Enabled 0 Default Fake -
| toe 1 1 5073006 5 Enabled 0 Defaul Fake 1} Eind User |
| o071 1 s07eIsI007 5 Enabled 0 Default Fake % 4dd Users). |
(| oo 2 1/s07E3EI008 5 Enabled 0 Default Fake
| fo0s 1 15078351009 5 Enshled 0 Default Fake Edit User.. |
mo 1) 1 R07RIEI0I0 5 Enabled 0 Default Fake e
|| =+ Delate Users)...
n 1978 1 115078351578 b No Status Default False
| 209 1 15078352009 5 No Status Default False ﬂ il Ml
| o 1 1 5078362010 b Mo Statuz [hefaul Falza @ Mtk o K
| 2on 1 1somma0m 5 o Status Defaul Fabe 4|—a' o
| | 2268 1 1150278352266 b Mo Status Default False (T Reset |
n 4000 1 1/ B07EaR4000 2 Enabled 0 Digpatcher Falze .
L O N = 5 Enabled 0 NoTeleo Fake < Heass@"!“'---l
(| sz 1 1507838602 5 Enabled 0 NoTeleo Fake & Intenogate.. |
| B003 1 1 5078356003 5 Enshled I NaTeleo Fake
|| 6004 1 1 B0735R004 5 Enabled 0 NaTeleo False 20 Disale Audio |
|| BO05 2 1 5078356005 5 Enabled 0 NoTeleo Fakse
(| e 2 1507838006 5 Enabled 0 NoTeleo Fake
| s 2 1/507B3EG007 5 Enabled 0 NoTeleo Fake
Function Parameter Description
uiD 1-8163 (8164-8191 reserved) Unique ID assigned to a subscriber mobile unit. Select aUID and
update the telephone number and priority.
Locality 1-255 Locality the UID is currently registered in.
Home 1-30 UID’s Home repeater with in the registered Locality.
Phone Number 10-numerical digits Unique 10-digit number associated with the UID.
Priority 1-5 There are 5 levels of access priority ranging from priority 5 as the
lowest to priority 1 as the highest.
Current Status Information Only The System Level status of the user (Active, Idle, Timed Out, Marked
For Kill, Killed, Audio Disabled).
Selected Status Information Only Last reported status of the selected user.

Permission Profile See Section 5.3.2 Diaing permissions of the selected user.

Name Text Field A text string to identify the user.

Description Text Field A text string to define the user.

Registered Indicates the current registration on the System.

OK Saves the current configuration shown and closes dialog.

Apply Loads the Subscriber Manager data for immediate storage and use by
the Call Processor.

Cancel Disregards unsaved changes to the Subscriber Manager list.

Reload Reloads data from the Call Processor.

Find User Enter the Unique ID of the User.

Add Users See Table 5-7 Adds Users to the Management List.

5-10
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Table 5-6 Subscriber Manager Screen (Continued)

Function Parameter Description
Edit User Select a User and make required changes.
Delete Users Eliminates the selected UID from the list.
Kill Now Brings up dialog box Disables the mobile with which the UID is associated.
Mark for Kill Brings up dialog box Disables the mobile upon incoming request to use the system.
Reset Reactivates a UID killed or enables audio.
Reassign User Programs Group 11 Group 1D or Movesto a different System/Group.
Interrogate A special interrogate message is sent that contains the UID code of the
affected mobile.
Disable Audio Disables the receive audio to amobile selected by its UID.
Table 5-7 Add Multi-Net Users Screen
‘
LD Locali
Start End I
|| I Horme
Telephane Mumber Friarity
! !
Fermission Profile
Default A
artakjel
apple test _
Banana Test
Cantelope Test |
3 Add / Edit Permission Profiles |
o OK | X Cancel |
Function Parameter Description
UID Start/End 1-8163 (8164-8191 reserved) Start and Ending Unique ID for this block of UIDs.
Locality 1-255 Locality the repeater isin.
Home 1-30 Relates to Home repeater number for this block of IDs.
Phone Number 10-numerical digits Used when adding only one user. Unique number associated with UID.
Priority 1-5 There are 5 levels of access priority ranging from priority 5 as the
lowest to priority 1 asthe highest.
Permissions Profile List of selected Permission Profiles for this User.
Add/Edit Permission |See Section 5.3.2 Select a Permission Profile (created in Section 5.3.2) from the list to
Profile include or change.

5.3.5 SYSTEM LOCALITY MANAGER

The System L ocality Manager screenisshownin
Table 5-8. This screen sets the Switch 1D number and

the Locality 1Ds associated with that Switch. It also
sets the maximum number of active calls permitted by
the Switch, and wide area call group time-out per
Locality.
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Table 5-8 System Locality Manager Screen

Switch 1D
I'I—
r"'l ""'l I"l Hl

7% Add Switch |

+% Delete Switch |

Add Lacality... |

T Delete anality...l

aw Active Callz | Timeout

=
Function Parameter Description
Switch ID 1-255 The Switch number used in this Locality.
Locality ID 1-255 The Locality number associated with the Switch.
Maximum Active Calls |0-16 The limit set for simultaneous active specia calls (both UID and Telco).
WAC Group Time-Out  |0-65,535 minutes Group Time-Out for Wide Area Group tracking (see page 5-13).
Add Switch Includes an entry to the Switch list.
Delete Switch Removes a Switch from the list.
Add Locality Includes a Locality ID to the Locality Manager list.
Delete Locality Eliminates a Locality ID from the Locality Manager list.
Ok Accepts the data entered and programs the changes into the Call Proces-
Sor memory.
Cancel Disregards unsaved changesto the Locality Manager List.

5.3.6 WIDE AREA CALL MANAGER

NOTE: Refer to Sections 1.3 and 4.5 for more
information on wide area calls.

The Wide Area Call Manager screen is shown in
Table 5-9. A Wide Area Call isacombination of
Parti cipants (L ocality/Home/Group ID) that are
brought together as a Wide Area Dispatch Call. Once
activated inaWAM, it remains in the WAM until it is
taken over by another Wide Area Call.

A Wide Area Call configuration contains aWide
Area Call Unique Identification number (WAC ID)
that identifies the configuration to al Call Processors
in the system. A Wide Area Call can track units by
their Unique ID across multiple Localities, or by their
Locality/Home/Group ID combination.

The Wide Area Call configuration contains
multiple sets of single Home/Group ID/Locality data
and multiple Home/Group ID/UID List/Locality List
data sets. The Call Processor sends only the necessary
Home/Group ID/Locality datato the WAM within the
Call Processor’s Switch.

A WAM can be given a maximum of 30 Home/
Group ID/Locality data sets. A Switch can handle a
maximum of 30 channels. If each channel wasasingle
channel Locality, the maximum configuration
becomes 30 data sets. The Default Tx UID isthe only
UID information given to aWAM.

The following is additional information on the
parameter programmed in the Wide Area Call
Manager screen.
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Participant - Locality/Home/Group entry in a Wide
AreaCdll.

Time-Out Behavior

Temporary - When a participant is marked “tempo-
rary”, it isnot loaded into aWAM until an actua
radio has transmitted on that L ocality/Home/
Group. The participant then remains active for the
WAC Group Time-Out duration (in minutes). This
time-out timer isreset with each PTT on that

L ocality/Home/Group. The timer vaue can be
changed for each Locality (default is 60 minutes)
and is located in the System Manager under the
Tools menu in the SSM (see Section 5.3.5).

Permanent - When a participant is marked “perma-
nent”, it isloaded into a WAM regardless of
whether or not traffic has been seen for that partic-
ular Locality/Home/Group. When the WAC is
loaded into a WAM, al participants that are
marked as permanent are loaded into the WAM and
channels are brought up accordingly.

By Unique ID (pull-down) - The time-out is from
the Permission Profile of the Unique ID. Permis-
sion Profiles are described in Section 5.3.2, and
they are assigned to Unique IDs as described in
Section 5.3.4.

Default Transmit UID - In the event that the WAM
does not have a UID available, the Default Unique ID
(loaded in the WAM) isused. The default is 8180 and
it is not recommended that it be changed asit ensures
that aUID isin the data base.

Default Priority - Thisis atake-over priority that is
used for allocating WAMs. When acall attempt is
made and the WA C has not yet been programmed into
aWAM, the Call Processor uses this priority to deter-
mineif aWAM isavailable. If the priority of the WAC
being taken over is equal or greater, then the
Maximum Inactive Time must have expired.

Maximum Inactive Time - The time (in seconds,
default is 10 seconds) that a Wide Area Call remains
reserved after aPTT and cannot be taken over by a
WAC of equal or lesser priority.

If the priority of the WAC being taken over is
less, then the Maximum | nactive Time does not matter.

However, there can be no active call (PTT) on the
WAM. Default priority is 5, with 1 being the highest.
Priority level 1isreserved for emergency use only and
can be used to take over WA Cs regardless of whether
or not someone istalking on the WAM. Use of priority
level 1 asthe default is not recommended and should
be reserved for emergency use only.

Hang Time - Thisisatime in seconds that the chan-
nels can be ordered to hang for a Group in the Wide
Area Cal. This can be set from O - 7 seconds with the
default set to O.

WAC Group Time-Out - This parameter is
programmed in the System Locality Manager screen
described in Section 5.3.5. It isavalue in minutes that
a Temporary WAC participant remains active on a
Locality between PTTs. The Temporary participant is
not activated until aPTT is seen from that Group on
that Locality. The default is 60 minutes.

Routing Group - The Routing Group number corre-
sponds to the number assigned to WAM s (see Routing
Group in Section 6.4.13). NOTE: Do not use Routing
Group 0 because it is reserved for internal WAM use.
When configuring Wide Area Calls, it isimportant to
understand that by assigning a Routing Group to the
call, the scope of the call may be limited.

For example: In afour-switch system, if acall is
configured to use Routing Group 1 and the WAMs for
this Group only connect Switches 1 and 2, then the
call can never be activated in Switches 3 and 4 without
reconfiguration of the Routing Group.

Examples:

WA C with Permanent Participants

WAC ID 1 isset up with 3 participants. All
default values are chosen for WA C parameters.

Participant Locality Home Group Time-Out

Behavior
1 1 1 1 Permanent
2 2 1 1 Permanent
3 3 1 1 Permanent

When activated in aWAM, this cal brings up all
three Localitiesif channels are available.
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WA C with Temporary Participants

WAC ID 2 isset up with 3 participants. All
default values are chosen for WAC parameters.

Participant Locality Home Group Time-Out

Behavior
1 1 1 2 Temporary
2 2 1 2 Temporary
3 3 1 2 Temporary

When activated in aWAM, this call brings up
only the Localities that have had Group traffic.

Example:

If participant 1 keys up the radio, the WAC is
loaded into a WAM. If there has been no traffic seen
from participants 2 and 3, then only Locality 1 comes
up. Once a user keys up on participant 2, then that
Locality is added into the call. Each participant is
active aslong as the WAC Group Time-out has not
expired (default is 60 minutes). Thetimer is reset each
timethereisaPTT for the participant.

WA C with Mixed Participants

WAC ID 3isset up with 3 participants. All
default values are chosen for WA C parameters.

Participant Locality Home Group Time-Out

Behavior
1 1 1 3 Permanent
2 2 1 3 Temporary
3 3 1 3 Temporary

When activated inaWAM, this call always brings
up Locality 1 for participant 1. The other Localities
come up if they have had Group traffic.

Example:

If participant 1 keys up theradio, the WAC is
loaded into a WAM. If there has been no traffic seen
from participants 2 and 3, then only Locality 1 comes
up. Once a user keys up on participant 2, then that
Locality is added into the call. Each participant is
active aslong as the WAC Group Time-out has not

expired (default is 60 minutes). Thetimer is reset each
timethereisa PTT for the participant. Participant 1is
always activated regardless of PTTs seen on that
Locality.

Takeovers

* System with one WAM

* Current WAC in WAM isWAC ID 1 with
Default Priority set to 5

* Maximum Inactive Time set to 10 seconds

Default Priority =5

* The WAC ID 1 User hasjust ended a conversation.

* TheMaximum Inactive Timer isreset to 10 seconds.

® A User fromWAC ID 2 with Default Priority 5 and
Maximum Inactive Time set to 10 seconds keys up.

* Thetimer for WAC ID 1 has not expired, therefore,
WAC ID 2 does not get the WAM.

® TheUser keys up a second time and the 10 second
timer for WAC ID 1 hasexpired and WAC ID 2 gets
the WAM.

* The WAM isnow active for WAC ID 2.

Default Priority =4

* TheUser for WAC ID 3 with Default Priority set to
4 and Maximum | nactive Time set to 10 seconds
keysup just asWAC ID 2 isfinished with a
conversation.

® Even though the 10 second timer is active for WAC
ID 2, WAC ID 3 has higher priority and therefore
takes over the WAM card.

As demonstrated, by changing the values for
Default Priority and Maximum Inactive Time, the
utilization of the System can be changed. For more
important WACs it may be necessary to increase the
priority and aso lengthen the Maximum inactive
Time. This allows them to remain programmed into a
WAM for agreater length of time between PTTs. If the
system utilization is high, it may be necessary to
reduce the Maximum Inactive Time on all WACsto
allow more takeovers by al WACs.

5.3.7 SWITCH CONFIGURATION MANAGER

Refer to Section 6 for information on the Switch
Configuration Manager.
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Table 5-9 Wide Area Call Screen

Eid A'a" "a"' S B[ B % Add Wide Area Call Participant
1de Areda Lal 1de Area Lal ame
[Wae number 1 I:’/ o Localty  Home  Group ulb
| e | ] Piaddwec | £ipsetswic | e | 1 1 1 - w 7 O
(T Fiedoad WA Now o FindwiaC | X Cancel jl 1 % 18310
Diefault Trarsmit UID Locality |H0me |Gr0up |UID |TimeoutBehavior| B 3 Anpl |
EE L Mo Type Specified :ll :II g :II 83% * SpPYy
Drefault Priority 1 1 g 1004 x Cancel |
5 1 1 7 1005
M aximum Inactive Time 1 1 a3 1006 rTimeaut Behavior—
10 1 1 3 1007 f(i Tempararny
) 1 1 10 1003 — Permanent
o 1 1 11 1003
_ 1 1 12 1010 L —
e 1 1 13 1378 € wide Area LTR
1 1 14 2009
|1 1 15 200 % Multitet
i 1 16 2011
1 1 17 2266
1 1 18 4000
1 1 15 GO0
1 1 20 GO0z
1=} Find Entry | T Add Entry... | % Delete Ertny.. ] ] %l ;I EEE? ;I

Wide Area Call Manager Screen

Wide Area Call Add Participant Screen

Function

Parameter

Description

Wide AreaCall ID

Identification number for this Wide Area Call configuration.

Wide Area Call Name

Name assigned as a reference to the Wide Area Call ID.

Add WAC

Creates anew WAC configuration.

Delete WAC

Removes the selected WA C configuration.

Find WAC

Quickly displays the desired WAC by simply entering its number.

NOTE:

For additional information on the following parameters, refer to Section 5.3.6.

Default Transmit UID 8180 If an ID is not specified, this ensures that one is provided.

Default Priority 5 If aPriority Level isnot specified this ensures that one is provided.

Maximum Inactive Time |1-255 sec The time (in seconds) that a WAC remains reserved after aPTT and
(default = 10 sec) cannot be taken over by a WAC of equal or less priority.

Hang Time 0-7 sec. The length of time (in seconds) that the channels can be ordered to
(default = 0) Hang for a Group in the WAC. Hang is when arepeater delays after a

transmission until the repeater stops transmitting. For hang time to be
active, it must also be enabled in the repeater by repeater programming

Routing Group

(Do not use “0")

Assigns arouting group to the WA C (see Section 6.4.13).

Locality 1-255, 0=dll 30 entries maximum, 2 entries minimum.

Home 1-30 Home repeater numbers of the unitsin the call list.

Group 1-225 Group ID numbers of the unitsin the call list.

uiD 1-8163, O=don’t track Unique IDs of the unitsin the cal list. (UIDs 8164-8191 are reserved)
Add Entry Allows adding a L ocality/Home/Group/UID to the WAC list.

Delete Entry Removes a selected Locality/Home/Group/UID from the WAC list.

5.3.8 USER PRIVILEGE MANAGER

The User Privilege Manager is used by the
System Administrator to assign what portions of the

SSM program will be avail able to each Subscriber
Manager. The four different User Privilege screens
that can be displayed by clicking the tab at the top are
asfollows:
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User Privilege Screen

% User Privilege Manager =] E3
User Privileges IUsers | Frivieges Content | Frivileges | Ok
Uszer Name Awailable Privileges E Apply
Adminiztrate Users —_
Change Caonfiguration x Cancel
Current Privileges Guest
— Wiew System Information
Adrinistrate Users jimtest

The User Privileges screen shown aboveis used
to assign which user privileges are available to the
user name selected by the drop down list.

Users Screen

The Users screen shown above is used to create
and maintain the list of users. These arethe NT login
names used by Subscriber Managers.

=] B3
o 0K
= Aoy

x Cancel

% User Privilege Manager

User Privileges = Users I Privileges Contenll Privilegesl

DGERTZ
DSIMONSON
EFJOHMSOM
JHIME
JLMDAHL
JMALEMKE
KBARMES
MPETERSON
RSMITH
TBERG

A O O .21

TwfD

Privileges Content Screen

% User Privilege Manager

User F‘rivilegesl Users  Privileges Content | F‘rivilegesl ¢ 0K
Privilege

IAdmmistrata Users j EAL“"‘
Allowes users access or ability to: x Cancel

Archive dlams

L4dd Comments o Alarms
Delete Alamns

Delete Log Entries
Diagnostics Menu

Group Manager

Peimission Profile Manager
Fieassignment Plan kM anager
Subzcriber b anager

Switch Configuration M anager

User Privilege Manager
‘wWide Area Call Manager

The Privilege Content screen shown aboveis
used to program which privileges are included in each

Privilege category. Privilege categories are added and
deleted by the Privileges screen described next.
Programming privilege categories makes assigning
privileges more convenient when several users are
assigned the same group of privileges. Table 5-10 lists
the privileges that are assignable and the section of
thismanual in which it is described.

Privileges Screen

% User Privilege Manager [_ ] <]
User Privi\egesl Users | Privieges Content  Privileges I o 0K

B Fihdd = Aol
. Change Configuration 75 Delete x Cancel

. Guest

l View Spstem Information

. imbest

The Privileges screen shown above is used to add
and delete Privilege categories that are programmed in
the preceding Privilege Content screen.

Table 5-10 Assignable Privileges

5-16

Privilege Sect. No.

Alarms 6.2

Add Commentsto 6.2

Archive 6.2

Delete 6.2
Tools Menu 53
Diagnostics Menu 54
Delete Log Entries 6
Change or View Dialing Rules 6.3.10
Change or View Groups 531
Change or View Permission Profiles 532
Change or View Reassignment Plans 533
Change or View Subscribers 534
Change or View Systems 535
Change or View Wide Area Calls 5.3.6
Change or View Switch Configuration 6
Change or View User Privileges 5.3.8
Change or View Network Names 5.3.9
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5.3.9 NETWORK NAMES MANAGER

The Network Names Manager screen is shown in
Table 5-11. This screen assigns names to the various
Networks (Switches) that are controlled by the SSM.

A Network Name is a user defined name assigned to
system components on a Logical Network used to aid
in the identification of other components on the
Logical Network. There may be multiple Logical
networks on a single Physical Network.

Table 5-11 Network Names Screen

& MNetwork Names

I Metwark Mumber |Metwark, Mame

Id m Metwaork 0
1 Metwork 1

15 Metwork 15

25 Metwork 25

50 Metwark 50
100 Metwork 100
101 Special Metwork 101
102 Test
103 Downzkairs LTR-Met
105 Metwark 105
120 Metwork 120

Function

Description

Network Number A unique number used to identify a Logical Network.

Network Name A “human friendly” reference name associated with a specific Network Number.

Apply Saves the current data without exiting the window.

Cancel Exits the Network Name window without changing the Network Name data.

Add Creates a new network number and name.

Delete Removes the selected Network Number and Network Name from the list.

5.4 DIAGNOSTICS MENU

ols EEEEEl= "indows Help
r HI Call Frocessor List.. Ctrl+A, ork:  Metwork. 100
T Raceive Buffer.. Cirl+B
SendSWho's There  Chl+E
User Messages Ctrl+hd

5.4.1 CALL PROCESSOR LIST

Thiswindow displays all Call Processors that are
active on the current Logical Network.

5.4.2 RECEIVER BUFFER

Thiswindow displays the Switch specific
Network traffic.

5.4.3 SEND WHO’S THERE

This command issues a broadcast message to all
Call Processors on the Network. Responses to the

5-17

broadcast can be viewed using the Receiver Buffer
window.

5.4.4 USER MESSAGES

This command displays a screen similar to the
following which indicates responses to requests initi-
ated from the Subscriber Manager screen such as Kill
and Interrogate (see Section 5.3.4). Old messages
continue to be displayed until the Clear button is
clicked. Clicking the Close button simply closes the
screen.

N Motice..

Interrogate Responze Meszage received from switchl. UID 1000 not found 7|
at Site 1, Home 1. Failure reazon: Call Failed.

Cl
Interrogate Response Meszage received from switch2, UID 1008 not found — L‘

at Site 2, Home 1. Failure reason: Call Failed.

-
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5.5 WINDOWS MENU

% Senez 3000 System and Subzcnber Manager

File Toolz Diagnostics Help
Current User: MPETERS!

Windows
Tile
LCazcade

Current Metwark: M

Set Title...

5.5.1 TILE
Displays all open windows in a“block” format.
5.5.2 CASCADE

Displays all open windows overlayed, one on top
of another.

5.5.3 SET TITLE
This screen follows, and it allows the System

Administrator to change the name of the main
window.

%) Set Window Title

Specify Mew Window Title

o OK I x Cancel |

5.6 HELP MENU

% Series 3000 System and Subscriber Manager
File Toolz Diagnostics Windows
Current Uzer: MPETERSON

General...
Contents
Change History...

Att+F1

About Series 3000 Systemn and Subscriber Manager ...

5.6.1 GENERAL

This menu selection displays the Help window.

5-18

5.6.2 CONTENTS

This menu selection displays the Help Table of
Contents window.
5.6.3 CHANGE HISTORY

This displays atext file describing the various
changes that have occurred to the SSM software. The

date and reason for each change are listed with the
most recent change first.

5.6.4 ABOUT

Seriez 3000 System And Subzcriber Manager
Yergion 3.9.0.0

Febuary, 07, 2001

Copyright € 1938 - 2000 Tranzciept International

E. F. Johnson Company

233 Johhzon dvenue

Wwiazeca, MM 5E093-0574

[507) 835-6222

Technical Support US 1-800-328-3911
Technical Suppart International 507-835-6911

EFJCuztomerS ervice@E Flohnzon. com

hittg: A A, EFJ ohngon. com

Displays the screen shown above which indicates
the version number of the software and other
information.
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SECTION 6 SWITCH CONFIGURATION MANAGER

Al Alarms i@ Citical 2 @ Major 50 i@ Minor 100 i@ Info. 107 i@ Unknown 0
By Shelf | By Card Type I
E@ Metwork 100 Address | Type | Description
=@ switch? mE DIk
[ shelo m7 Open Slot
1] ”
By Shelf” Screen 018 Open Slot
y ] ma Open Slot
m Sheli ] S Externally Connected to Switch 1. slot 20
021 Open Slot
i i i 02z Open Slot
(nght Click in Left Pane) 023 SHM Internally Connected to Slot 24
Artivity Monitor 024 SHM Intemnally Connected to Slot 23
Activity Lag... 025 Open Slot
Call Lag... 5 4 026 Open Slat
Ernergency Traffic Log.. / 027 DCM
QOueued Call Log...
Beassignment Plan Log 1 | | _’I

Fegistration Log.

Uagge Acemuillig Larg h Configuration kManager

i@ Ciitical 2

Fermnove Installation
Dialing Rules..

Copy settings to defaults
Pack Tables

Al Alarms

By Shelf By Card Type |

i@ Major 50

@ Minor 100

i@ Info. 107

@ Unknown 0

Call Processaor Propetties

= switch? ;I Address | Shelf | Description |

Log Froperies...

Opet Slat 020
Switch Properties... K {[ﬂm

I com 023
- cim 024
-l cr
- oem
- oM

- 1om

1
I ek
-l tCH
- I

- B
- T

- o
- e

I e =

“By Card Type”
Screen

Shelf1  Estermally Connected to Switch 1, glot 20
Shelf1  Intemnally Connected to Slot 24
Shelf1  Internally Connected to Slat 23

Froperties
Enable
Dizable
Restart

Figure 6-1 Switch Configuration Manager Screens

6.1 INTRODUCTION
6.1.1 GENERAL

The Switch Configuration Manager described in
the following information is selected by the Tools >
Switch Configuration Manager screen of the SSM as
described in Section 5.3.

The Switch Configuration Manager programs
individual Switch parameters such as Switch number,
number of shelves, and the configuration of individual
cards. It aso displays various logs and other informa-
tion for a switch. The other Tools menu functions
program parameters common to all Switchesin the
Network.

6-1

6.1.2 DISPLAYING INSTALLED CARDS

The main Switch Configuration Manager screen
is shown in Figure 6-1. Clicking the “By Shelf” tab
displayswhat cards arein each shelf and what slotsare
empty. Then clicking the “By Card Type’ tab displays
alisting of the available cards. Then clicking a partic-
ular card displays the slot and shelf in which those
cards areinstalled (if applicable).

6.1.3 SELECTING CARD TO CONFIGURE

To select a card to configure, double click the
address of the card or right click the mouse in the right
pane and select “Properties’ in the pop up screen that
is displayed (see Figure 6-1). The card configuration
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screen isthen displayed which defines the attributes of
the particular card that was selected. Refer to the
following sections for more information on card
programming:

Card Section
Global Card Properties 6.4.1
CCM 6.4.2
CIM 6.4.3
DCM 6.4.4
DIM 6.4.5
IDM 6.4.6
LEM 6.4.7
MAM 6.4.8
MCM 6.4.9
SNM 6.4.10
TIM 6.4.11
VDM 6.4.12
WAM 6.4.13

6.1.4 SELECTING ACTIVITY MONITOR, LOGS,
AND PROPERTIES

To display the submenu used to display switch
activity monitors, logs, and properties, select the
desired Switch if applicable and then right click the
mouse in the left pane of the main screen shown in
Figure 6-1. The pop-up menu shown below is then

displayed.

Channel Status...
WAk Configuration...

Activity Monitar

Activity Log...

Call Log...

Emergency Traffic Log...
Queued Call Log...
Beassignment Plan Log...
Fegistration Log...
Usage Accounting Log...

Eemuowve Installation
Dialing Rules...

Copy settings to defaults
Pack Tahles...

Call Processor Properties...
Log Properties...
Switch Properties...

The functions in this menu are described in
following sections:

Function Section
Activity Monitor 6.3.1
Activity Log 6.3.2
Cdl Log 6.3.3
Emergency Traffic Log 6.3.4
Queued Cdl Log 6.3.5
Reassignment Plan Log 6.3.6
Registration Log 6.3.7
Usage Accounting Log 6.3.8
Remove Installation 6.3.9
Dialing Rules 6.3.10
Copy Settings To Defaults 6.3.11
Pack Tables 6.3.12
Call Processor Properties 6.3.13
Log Properties 6.3.14
Switch Properties 6.3.15

NOTE: Displayed windows can be resized by dragging
an edge or corner, a table column can be temporarily
resized by dragging it in the heading, and columns can
be sorted by clicking the column heading.

6.1.5 SELECTING OTHER INSTALLATION

To display a Call Processor that is not running or
is being added to the Network, right click on the
network name in the Switch Configuration Manager
main screen. Then click the “ Other Installation” pop-
up screen that is displayed. The following dialog box
is then displayed to enter the name of the desired Call
Processor.

& Other Installation

Installation Mame
Iswitch‘l

o OK I

x Cancel |

6.2 ALARMS
6.2.1 GENERAL

NOTE: An alarmlisting islocated in Table A-1in
Appendix A in the back of this manual.

When errors occur on either the Intra-Terminal
DataBus (IDB) or the Call Processor they are
displayed by the Switch Manager in one of the five
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Alarm categories listed below. Note that the Critical,
Magjor, and Minor alarms report afailure that requires
action to fix it. However, Informational Alarms do not
indicate afailure. They are intended only as atool to
provide the system operator with information on
system performance.

Informational messages indicate such normal
occurrences as the successful completion of atask, not
enough channelsto include everyone in awide area
cal, and no free WAMs available at thetime acall was
placed. These messages are one information source
that a system administrator can use to determine when
additional channels or switch modules may be needed.
If desired, these messages can be suppressed by
entering “0” for the Information Alarm Limit on the
Log Properties screen. However, it is recommended
that these messages not be suppressed.

Critical: The deviceisunavailable and it may have
stopped operating.

Major: A problem has been reported that is causing
some degradation in operation.

Minor: A condition has been reported that may be
causing some degradation in operation.

Informational: A condition has been reported that
may be normal or undesirable.

Unknown: The event that caused this alarm is not
known to the System, so no severity can be assigned.

If an alarm condition exists on a Network or
Switch, a colored dot is displayed to the left of the
Network or Switch on the main Switch Configuration
Manager screen (see Figure 6-1). This dot indicates
the most important alarm that has been detected. For
example, if ared dot isindicated to the left of Switchl,
acritical alarm has been detected on that Switch.

The severity assigned to alarms can be changedin
the Log Properties screen described in Section 6.3.14.
Simply click the Alarm Severity button and then click
the right side of the severity box of the alarm to be
changed. This displays a drop-down list which is used
to select the desired severity.

6.2.2 DISPLAYING ACTIVE AND ARCHIVED
ALARMS

To display the alarms which have been detected
on a Switch, click on the switch and then click the
applicable button at the top. For example, to display
any Major alarms on Switchl, click Switchl and then
the Mgjor button on the top. To display all adarmson a
Switch, click the All Alarms button instead.

The Active/Archive Alarm screen described in
Tables 6-1 and 6-2 is then displayed. An alarm condi-
tionis cleared by moving al Active Alarmsin a cate-
gory to the Archived Alarmstable. Thealarmsin a
screen can be sorted by Date, Number, Card, or
Severity. Alarms can be archived individually by
selecting the alarm and clicking the Archive button or
al alarmsin the screen can be archived by clicking the
Archive All button. Alarms can also be displayed by
date. Appendix A lists the various alarm conditions
that may be displayed.

6.2.3 REPEATER ALARMS

Repeater alarm reporting is optional (see Section
1.5.2). The repeater alarms are numbers 324-358 and
402 shown in Appendix A. The external repeater
aarms are 327-330 (IAC 1-1AC 4). These alarms can
be given a unique description which identifies the
repeater and the actual alarm that is occurring. These
descriptions are programmed by the L og Properties
screen described in Section 6.3.14. Click the Alarm
Severity button and then in the screen that is
displayed, click the Define |AC button (see Table 6-8).
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Table 6-1 Active Alarm Screen

& Alarms

Active | Archived |

 Archive | g gﬁ;tei | 3 ttam | Er:;WIDate & Refresh |
ﬂ Card # | % Severit_l,ll Tao I
« Archive &l | Add Comment | Q—:s Appl—"'l ﬁ Clear | j'IL LCloze |
Alarm # | Alarm ISeverit_l,l ISwitch ICard # ISw EhanITime IUID IData1 IData2 IDataS IEomments IEomments by |Comments Time | «
Card initialized Informationsl 2 ez 0 272852001 $06:19 &M 1] 1] 1] 1] |
287 Card inttialized Informational 2 35 0 2/28/2001 §:06:19 &M 1] 1] 1] 1]
287 Card inttialized Informationsl 2 3 0 272852001 $06:19 &M 1] 1] 1] 1]
287 Card inttialized Informational 2 24 0 2/28/2001 §:06:19 &M 1] 1] 1] 1]
287 Card inttialized Informationsl 2 20 0 272852001 &06:20 &M 1] 1] 1] 1]
287 Card inttialized Informational 2 23 0 2/28/2001 &:06:20 &M 1] 1] 1] 1]
Function Parameter Description
Archive Stores the selected alarm in the archivefile.
Archive All Stores dll alarmsin the archivefile.
Sort By Date Listsalarms by Date/Time.
Error Lists alarms by severity.
Device Lists alarms created by individual module, databus, etc.
Severity Lists dlarms by degree of importance.
Add Comment Reference to the operator about the alarm.
Show Dates From - To The Start-End date limits to display.
Apply Uses the entered date/time to retrieve data.
Clear Ignores entered dates and empties the field.
Refresh Updates the displayed data with the most current entries.
Print Sends the data displayed to a printer.
Close Exits the window.
Alarm Number Displays the Alarm Number (see Appendix A).
Alarm Displays the Alarm Name (see Appendix A).
Severity Displays the severity of the alarm (see Section 6.2.1).
Switch ID The number of the Switch where this alarm is registered.
Card Address (1-288) Displays the card (Module) slot number in the Switch.
Switch Channel Number |Displays the channel number (1-30) for this Switch.
Time Displays the time stamp for the Alarm.
uiD Displays the Unique ID of the Switch.
Data1-3 These are parameters assigned to the Alarms.
Comments Reference to the operator about the alarm.
Comments By Identifies the person that entered the comment.
Comments Time Indicates the time the comment was entered.
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Table 6-2 Archived Alarms Screen

& Alarms
Active  Archived |

g SoitB Show Date
% Delete | D Date | E Alarm B | From I &% Refresh |
+1 Delete Visible | N cadtt | B severiy| [0 |

% Delete All | Add Comment | ?—3 Appl-"'l 33 Clear | ﬁ Claze |
Alarm #] Alarm |Severit_l,l| SwitchlEard ﬁl Sw Char‘l Tirne: |UID|Data1| Data2 | Data3|Archived by |Archived time |E0mmel Comments b}l Cammerts Time| - |

276 MIM:CSB failed Critical
295 MIM:IDB General Bus Failure Critical
293 MIMIDE General Bus Failure Critical
293 MIMIDE General Bus Failure Critical
295 MIMIDE General Bus Failure Critical

2

0

0 2852001 1001626 P
0 20852001 10:18:25 PM
02872001 10:20:24 PM
0 2872001 10:22:23 PM
0 20852001 10:24:25 PM

]

i}

]

0 Avtomatically 20802001 1003625 P
0 Avtomatically 20802001 10:58:25 PM
0 Avtomatically 2/8/2001 11:00:25 PM
0 Avtomatically 20802001 11:02:25 PM
0 Avtomstically 2802001 11:04:25 PM

BRI R ORI R RD
o o o o o
o o o ol o
oo o ol o
o o o ol o

295 MIM:IDE General Bus Failure Critical 0 20852001 10:26:25 PM

0 Avtomatically 20802001 11:06:25 PM

Function Parameter Description
Delete Erases the selected alarm.
Delete Visible Erases all alarms visible on the screen.
Delete All Erases all archived alarms.
Sort By Date Arranges the order of alarms by Date/Time.
Error Arranges the order of alarms by error name.
Device Arranges the order of alarms by individual module, data bus, etc.
Severity Arranges the order of alarms by degree of importance.
Add Comment Reference to the operator about the alarm.
Show Dates From - To The start-end date limits to display.
Apply Uses the entered dates to retrieve data.
Clear Ignores entered dates and empties the field.
Refresh Updates the displayed data with the most current entries.
Print Sends the data displayed to a printer.
Close Exits the window.
Alarm Number Displaysthe Alarm Number (see Appendix A).
Alarm Displays the Alarm Name (see Appendix A).
Severity Displays the severity of the alarm (see Section 6.2.1).
Switch ID The number of the Switch where this alarm is registered.
Card Address (1-288) Displaysthe card (Module) slot number in the Switch.
Switch Channel Number | Displays the channel number (1-30) for this Switch.
Time Displays the time stamp for the Alarm.
uiD Displays the Unique ID of the Switch.
Data1-3 These are parameters assigned to the Alarms.
Acknowledged By | dentifies the person that acknowledged the alarm.
Acknowledged Time Indicates the date/time the alarm was acknowledged.
Comments Reference to the operator about the alarm.
Comments By | dentifies the person that entered the comment.
Comments Time Indi cates the date/time the comment was entered.
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% Channel Status

Refresh Every |2 Seconds

j'|_ Cloze |
j ™ Freeze Display

Lacality Filter

IS[=] E3

Channel

Localil_\llHomeIGmupI ulD ICaII T_vpel Hungj TransmillﬂeceiveIDi" HeceiveIAudio DisahleIWac # IPliolity IStalus ISyslem Priority I -

1 1

2 1
3 1
4 1

Channel Status Screen

Dev Hum Wac ID Locality

Bl % Wide Area Module Configuration Status [ (o ]=]
b Refiesh Every |E Seconds  Localiy Filker I
{

lﬁ j"L Lloze |

]

Home

[~ Freeze Display

Group Count

WAM Configuration Status Screen

Figure 6-2 Activity Monitor Screens

6.3 PROGRAMMING COMMON
SWITCH PROPERTIES

NOTE: The menu which selects the screens described
in the section is displayed by right clicking the mouse
in the left pane of the main Switch Configuration
screen (see Section 6.1.4).

6.3.1 ACTIVITY MONITOR

Channel Status Screen

The Channel Status screen shown in Figure 6-2
provides either a Periodical or On Demand update of
the System. The user selects how often the display is
refreshed and can choose to include all Localities or
select a specific Locality with thefilter. A freeze
display is provided to view the display without
updates changing the data on the screen. The refresh
rate may be from 1-10 seconds on Periodic updates. A
refresh rate of 0 enables a Manual Refresh button
which can be used to view information On Demand.

WAM Configuration Status Screen

The WAM Configuration Status screen shown in
Figure 6-2 is aPeriodical or On Demand update of
Wide Area Modules. The user selects how often the
display isrefreshed and can choose to include all
Localities or select a specific Locality with the filter.

6-6

A freeze display is provided to view the display
without updates changing the data on the screen.The
refresh rate may be from 1-10 seconds on Periodic
updates. A refresh rate of 0 enables aManual Refresh
button which can be used to view information On
Demand.

6.3.2 ACTIVITY LOG

& Activity Log |_|O]x

Show Date: =

5 Refresh | Cloze

From I Q_;s Apply ) fiLc

To I % Clear % Delete | % Delste Alll =% Ermpty Logl

Activity |T\me |Switch ID|Data|User Narne | ;I
|_|Emergency plan completed 11/30/1999 7:44:01 Ak 1 1 SWITCH1:Administrator
|_|Emergency plan execution started 11/30/1933 7:44:53 &AM 1 4 SWITCH:Administrator

The Activity Log screen is shown above. When-
ever aReassignment Plan is started or completed, itis
recorded in the Activity Log. The Activity Log
contains the activity name, a time stamp, the Switch
ID, Data, and the User name. To print thislog select
File > Print.

6.3.3 CALL LOG

Telco Calls Log

The Telco Calls screen shown in Figure 6-3
displays aTelco Call record. When a Telco call
request is received, the Call Processor begins the
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% Call Log H[=] E3
Show Date Show LD | = |
Fram I e Applyl B I & Applyl G5 Refresh | [f] Close
I I _lgf{} e | e I & Cear | i Delete | *3 Delete Visible | % Emply Logl
Telco Calls | Ditected Calls |
Start Time |End Time |Answer Time |UID |Home | Localit}l Dialed Digitsl Completion Eodﬂ Dezt. Device til Mabile Driginatedl Source Device tll Trunk | ;I
| 1141271333 10:01:31 AM 11/12/193310:01:38 AM 111241933 10:01:36 AM 1000 1 1 BE23 Success 41 True 4 TrunkGroupl
| [11/121333 100744 AM 111241533 10:01:52 AW 1112/1933 10:01:43 AW 1000 1 1 BE23 Success 41 True 4 TrunkGroupl
| 1141241993 10:02:05 AW 117121933 10:0217 AM 111241939 10:02:05 AW 1000 1 1 1000 Success 7 False 42 TrunkGroup2
Telco Call Log
& Call Log =l
Show D ate: Show UID . =
% Refresh | Close |
From I KE] ADD|5'| From I ] Apph.l E L
o I 4'23] Clear ||| Te I & Clear | i Delete | *+% Delete Visible | =% Empty Logl

Telco Calls | Directed Calls |

Start Time

|End Time

|Source LIID| Dlest UID| Completion EUde' Dest Device #lDiaIed Digitsl Homel b obile Driginated' Localit_l,ll Sounce Device ﬂl

11/18/19993 7:23:74 AM 11/18/1933 72323 &M
| 1141841993 72274 &AM 114181999 7:23.23 AM

1000 1002 1 False 1 24
1000 1002 1 True 1 7

Success a

Success 23 1002

Directed Calls Log

=]

Figure 6-3 Call Log Screens

Telco Call Record. Thisrecord includes the Start Date/
Time, Originating Unique ID (if generated from a
mobile), Dided Digits, and Locality/Home used in the
call. Thistype of call istypically afull-duplex call and
uses a destination module (i.e. CIM/SNM/IDM/TIM
etc.). The Call Processor isinformed if the destination
answers and the Date/Time it occurred. The origi-
nating unit notifies the Call Processor when the call is
terminated and the End Date/Time is noted. To print
thislog, select File > Print.

Directed Calls Log

The Directed Calls Log screen shown in
Figure 6-3 displays Directed Group and Unique ID
Calls. When a Directed Call request is received, the
Call Processor beginsthe Directed Call record. The
Log displays the Start Date/Time, Originating Unique
ID, Dialed Digits (if generated from a mobile), Desti-
nation Unique ID requested (if trunk side generated),
and the Locality/Home used in the call.

Thistype of call typically uses a destination
module (i.e. CIM/SNM/IDM etc.). The Call Processor
isinformed if the destination module answers and this
is noted. The originating unit notifies the Call
Processor when the call is terminated and the End
Date/Timeis noted. To print thislog select File >
Print.

6.3.4 EMERGENCY TRAFFIC ACTIVITY LOG

% Emergency Traffic Activity
Show Date:

s . =
Fon [ & ok e pereh | | con |
To I & Clear 5 Delete | 3% Delete Vlslblel % Empty Logl
Tirne |Card Addresslﬁroup |Home|Loca\ily|UID |Activily | ﬂ
| [11/9413335:15:32 PM 4 E 1 11001 Receive
11/9/1999 5:15:29 P ] E 1 11001 Answer
[11/9/1939 5:15:40 Phd g E 1 11001 Clear

The Call Processor writes an Emergency record
to Emergency Traffic Activity Log screen shown
above whenever an Emergency Rx Message, Emer-
gency Tx Message, or an Emergency Clear Messageis
received from amodule. To print thislog, select File >
Print.

NOTE: The above screens are displayed by right clicking the mouse in the left pane of the main Switch Configuration Manager screen.
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% Queued Call Log

(O] x|

Show Date Shies LI & Refresh | E |
(=)= 0ze

Fram I A€ APP'.'r'l Fram I KE] -"—‘«DD|5-'| LE

Ta I % Clear | To I % Clear | 5 Delete | 1 Delete Visible | i Empty Logl

I Directed Calls |

Entered (ueue ILefl LeLe |UID

|Localit_l,J |H0me

|Source Device ﬂl Reazon Left Queuel Dialed Digits

Queued Telco Call Log Screen

% Queued Call Log

Shaow D ate:
From I ﬁ Appl_l,.ll
3;11 Clear |

Show UID
From I Q_IQ Appl_l,ll
To I @ Clear |

To

Mo reason set

M=l
&5 Refresh | J-'Lglose |

i Delete | 1 Delete Visible | =% Empty Logl

Teleo Calls (D

Entered Qusue ILefl Hueue

IF!eason Left Gueuel uio

IDest UID ILocaIit_l,J IHome ISource Device #

Mo reason set

»

Queued Directed Call Log Screen

Bl

Figure 6-4 Queued Call Log Screens

% Reaszsignment Plan Log M=l E3
Show Date e
5 Refresh | [ Cl
From | o f-\pplyl 2 e | L HLE
To I % Clear | i Delete | *% Delete Visible | % Emply Logl
Plan 1D ITime IUID ILocaIit_l.J IHDme IT_I.Jpe ITimes Retried IStatus I ;I
| 1 11/11./1999 7:50:00 Ak 100 1 1  FReprogram 2 Success
1 1141141939 7:50:00 Abd 1000 1 1 Move 1 Success

Figure 6-5 Reassignment Plan Log

6.3.5 QUEUED CALL LOG

Queued Telco Calls

The Queued Telco Call Log screen shownin
Figure 6-4 indicates all Telco Calls that are waiting to
be completed. Once acall iscompleted, it is displayed
inthe Call Log described in Section 6.3.3. To print the
Telco Call log, select File > Print.

Queued Directed Calls

The Queued Directed Call Log screen shown in
Figure 6-4 displays the Directed Calls waiting to be
completed. Once acall is completed, it is displayed in
the Call Log described in Section 6.3.3. To print the
Directed Call log, select File > Print.

6.3.6 REASSIGNMENT PLAN LOG

Reassignment Plan information islogged to the
Reassignment Plan Log screen shown in Figure 6-5.
This log displays when a Reassignment Plan is started
and ended, and the associated transactions.

The Call Processor begins the record with the
Reassignment Call Name, Start Date/Time, Locality/
Home for Dynamic Reassignment/Selection, Unique
ID number of the originating caller, and Type (Repro-
gram, Move). The Log also displays the number of
attempts made (Times Retried) to activate the plan and
the results (Status) of the attempts that were made. To
print this log, select File > Print.

NOTE: The above screens are displayed by right clicking the mouse in the left pane of the main Switch Configuration Manager screen.
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% Regizstration Log IS [=] B3
Show Date e
&% Refresh | LClos
From I & ﬁppl_l,ll . i
Ts I & Clear | i Delete | *% Delete Visible | % Emptp Logl
Tirne |Lu:|c:ality |Home |UID |Card Address |User Statuz |F|egistered| ;I
11/11/1999 356:52 PM 1 1 1002 K 0 True
111141953 35653 Phd 1 1 1000 IS 0 True

Figure 6-6 Registration Plan Log Screen

& Usage Accounting Log

howy Date:
Fram I
Ta I

b LIID: howy Groups
Fram I Fram I
Ta I Ta I

:

i'L Close |

[ Run Guery | 1': Delete

3 Records

1 Delete Visible

1': Empty Log

Start Time End Time

IAirTime ISW'rtc:hICard AddrISW'rtc:h ChanILocaI'rty IHome IGroupIUID IPrior'rty IUser Status|Status

A #

3M2001 110912 AW 3M02001 11:09:51 AW 349 1
3M2001 11:09:19 AW 3M02001 11:09:51 AM 32 1
3M2001 111508 AW 3M02001 11:15:09 AW 1 1
3M2001 111520 AW 3M02001 11:15:20 AW o 1

5

=1
4
=1

2

3
1
3

0 236 1000
0 236 1001
1 1 1007
1

1 1007

) 0 ceive + Transmit
1]
1]

i}
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Receive

o o o o
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3
3 Receive

Figure 6-7 Usage Accounting Log Screen

6.3.7 REGISTRATION LOG

Registration information islogged to the Regis-
tration Log screen shown in Figure 6-6. When regis-
tration request messages are received from channel
modules, the Call Processor creates arecord in the
Registration Log. To print thislog, select File > Print.

6.3.8 USAGE ACCOUNTING LOG

General

The Usage Accounting Log screen shown in
Figure 6-7 displays the various usage information that
is generated and stored as calls are processed. The
following functions can be selected in this screen:

Show Dates/UIDs/Groups - If information is entered
in these boxes, only recordsin the selected range are
displayed. For example, if abeginning and ending date
is entered, only calls made on those dates are
displayed. If a Show box is left blank, no Date/UID/
Group restriction occurs (for example, leaving all
Show boxes blank displays all recordsin the log).

Run Query - Updates the log with the records in the
ranges selected in the Show boxes (if applicable).

Delete - Permanently deletes the currently selected
record.

Delete Visible - Permanently deletes all recordsin the
current screen (even those that have scrolled out of the
screen).

Empty Log - Permanently deletes all recordsin the
log.

Close - Exits the screen and returns to the main screen.

Printing Reports

Several different reports can be printed from the
currently displayed usage log information. To display
the following menu which selects the report to be
printed, select File > Print.

Tools Diagnostics  Windows Help
Select Network... Cunent Netwark: Metwark 100
Feload Distributed Takles

Froperies..
Enter MNew Key.
Import fram File 4
Exportto File 4
Chamel Usage Groph

Group Traffic Summary
Systermn Busy Statistics
Systerm Traffic Listing
Tatal System Traffic

UID to Group Contributions
UID Traffic Summary

Exit

Only information contained in adisplayed log
can be printed. Some report menus allow further
restrictions to be added to records displayed in a
report. The reports that can be selected are as follows:

NOTE: The above screens are displayed by right clicking the mouse in the left pane of the main Switch Configuration Manager screen.
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— Rules __Telco Dialing

| Step x
Telco Dialing
Rule Group x

New Pattern
[ Digit Patterns __I: Delete Pattern

Add Trunk Group
— Trunk Group
_I: Delete Trunk Group

Add Rule Group
'— Rule Groups
P _I: Delete Rule Group

Include These Patterns Strip

Rule Group 1 Step 1 ~E Exclude These Patterns
Then Do These Actions

After Pattern
After Including Pattern
Before Pattern

\: Before Including Pattern

Insert (Digit String)

Prepend (Digit String)
Append (Digit String)
Queue

Block

Allow (on which Trunk Groups)
Remove Queued Calls

Pattern Only
Excluding Pattern

Figure 6-8 Dialing Rules Screen Command Structure

Channel Usage Graph - Displaysin graph form, the
percentage utilization of each channel (repeater)
connected to the Switch. Various types of graphs can
be selected.

Group Traffic Summary - This summary includes
the total number of times push-to-talk was initiated

and the total call length and average length of each

transmission for the specified Group.

System Busy Statistics - Thisreport indicates, for the
date specified, the percentage of time all repeaters
were busy, the percentage of possible airtime that was
used, the actual time that all repeaters were busy, the
total time that the repeaters were used, and the number
of timesthat all repeaters were busy.

System Traffic Listing - This report displays the
binary datafrom the System Status Bus. A time period
and Unique ID code range is specified and then the
time of every transmission for each Unique ID codeis
indicated.

Total System Traffic - This summary includes the
total number of times a push-to-talk was initiated and
the total call length and average length of each trans-
mission.

UID to Group Contributions - This report indicates,
for the specified time period and Home/Group range,
the calls made to each Group. The total number and
time of calls made by each Unique ID codeis

displayed.

UID Traffic Summary - This report summarizes for
each UID, the total times push-to-talk was initiated,
the total call length, and the average length of each
transmission.

6.3.9 REMOVE INSTALLATION

This menu selection removes a non-operating
switch from the configuration. If the switch is oper-
ating, the connection is automatically re-established.

6.3.10 DIALING RULES
Introduction

The main Dialing Rules screen is shown in Table
6-3. The structure of the various screens that are
selected from this screen is shown in Figure 6-8 above.
Dialing rules determine what tel ephone number
patterns a user is permitted to dial and also which
patterns are not permitted (if applicable). Dialing
Rules also establish alink to telephone company trunk
lines.

NOTE: If telephone toll charges are passed to custom-
ersinan arearegulated by a local Public Service Com-
mission, or like entity, it isimportant that the exact toll
charges be closely approxi mated when devel oping call
dialingrules. Be sureto chargethe customer an amount
equal to or less than the amount charged by the long
distance carrier. E.F. Johnson has no responsibility for
any penalty or finelevied for overcharging toll ratesin
those regulated areas.

NOTE: The above screens are displayed by right clicking the mouse in the left pane of the main Switch Configuration Manager screen.
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Table 6-3 Rules Screen

% Dialing Rules

Fules I Digit Patterns I Trunk Gru:uupal Rule Groups I J oK. |
Telco Dialing Rule Group - | |
s Add Step Mowve Up
[DislingFruleGroup# | L H 2eol |
-3

Step I—.I e | - | ~ | r | *: Bemove Stepl * anegnwnl x Cancel |
Include theze patterns Awailable Patterns
RCELE "B

"B366..*

Gy

1%

Exclude theze patterns

Then do these actions

*MgveLlp |

Allows
[ueus *% Femove Action | * Move DUW”l
Edit &iction |
Function Description

Telco Dialing Rule Group Name representing the compl ete set of patterns and actions.
Step Number representing one set of patterns under the Telco Dialing Rule Group name.
Add Step Creates anew Step for additional patterns under the Telco Dialing Rule Group name.
Remove Step Removes the selected Step under the Telco Dialing Rule Group name.
Move Up Moves a pattern up a Step in the selected pane (to execute earlier).
Move Down Moves a pattern down a Step in the selected pane (to execute later).

Available Patterns

The patterns created in the Digit Patterns screen.

Include These Patterns

Patterns that must be met for the call to be accepted. Patterns are dragged between panes
using the mouse.

Exclude These Patterns

Patterns to be excluded from an Included pattern. Patterns are dragged between panes using
the mouse.

Then Do These Actions

If the call has met the criteriain the Include pane and does not meet the criteriain the exclude
pane, then these actions determine the call routing to a Trunk Group.

Add Action Adds an action to the actions pane. These screens are shown in Table 6-4.
Remove Action Removes the sel ected action from the actions pane.

Edit Action Allows the selected action in the action pane to be changed.

Move Up Moves up thelist of actionsin the action pane.

Move Down Moves down the list of actionsin the action pane.

OK Saves the current Dialing Rules shown and closes dialog.

Apply Saves the current Dialing Rules shown.

Cancel Disregards unsaved changesto the Dialing Rules.

NOTE: The above screens are displayed by right clicking the mouse in the left pane of the main Switch Configuration Manager screen.
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Table 6-4

Rules Screen Add/Edit Actions Screens

ll % Dialin g Rule Action

Digit String

%/ Dialing Rule Action HE R

Pattern

| |Remove Queued Calls

StipType—————— |
" after pattem

° After including pattem

" Before pattein

" Before including pattem

' Pattem only

' Excluding pattemn

Remove Queued Calls

o K

o 0K I x Cancel |

%/ Dialing Rule Action

Action
Diigit String

Insert

Strip

=[] % Dialing Fule Action

On these tunks Available trunks

Remove Queued Calls

TrunkGroupl
TrunkGroup2

TrunkGroupl
TrunkGroup2
DID_Trunk_Dant_se_fa

Remove Queued Calls

W 0K I x Cancel |

Prepend/Append Allow
Action Description

Insert The insert pattern includes numbers that are needed to complete a call but do not have to be
dialed by the user. The“at” string iswhere theinsert pattern isto be placed in the original pat-
tern.

Strip The strip action removes part of a pattern and a replacement can be inserted. For example if
1-507-555-1212 was dialed for directory assistance, the 555-1212 could be stripped and the
number of another service could be inserted.

Prepend/Append This allows digits to be placed at the beginning or the end of the digit string.

Queue Allows calls to be stored until atrunk is available.

Block Does not allow thistype of call to be placed.

Allow A trunk group from the Available Trunksis dragged to the On These Trunksto allow calls on

that trunk.

Remove Queued Calls

Empties the stored calls waiting for an available trunk.

Dialing Rules Programming Screens

Trunk Group Screen - The Trunk Rule Group screen

Rules Screen - The Rules screen shown in Table 6-4
sets up the dial patternsin each Telco Dialing Rule
Group. Rule Groups are added and deleted by the Rule
Group screen (see description which follows).

NOTE: Additional information on setting up Dialing
Rulesislocated on the pages which follow.

Digit Patterns Screen - The Digit Patterns screen
shown in Table 6-5 sets up the digit patterns that are
Included or Excluded in the preceding Rules screen.
Dialing patterns consist of numbers and symbols.

shown in Table 6-6 adds and deletes the Trunk Groups
that are associated with each TIM (Telephone Inter-
face Module) in the Switch (see Section xx). A Trunk
Group isalogical subgroup of the different types of
telephone lines that are available.

Rule Group Screen - Thisfollowing Rule Group
screen adds and deletes Telco Dialing Rule Groups
that are programmed by the Rules screen in Table 6-3.

Rules | Digit Pattems' Trurk Groups  Rule Groups | o 0K |
Rule Groups + Add Rule Group | H 2ol |
DialingRuleGroup#1 -

JimT est]

*3 Delste Rule Gioup | X Cancel |
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Table 6-5 Digit Patterns Screen

% Dialing Rules
Fules  Digit Patterns I Trurk, Groupsl Rule Groupsl 0K

M ew Pattern

S [=] B3

i

H el

75 Add Pattern |
Current Pattemns ﬂl
= {3 Delete Patternl
CETG
“99%
TR
=1L
Pattern Description
New Pattern Create adialing pattern to be added to the Current Patterns.
Current Patterns A list of dialing patterns already created.
Add Pattern Adds the New Pattern to the Current Pattern list.
Delete Pattern Deletes the selected pattern from the Current Pattern list.
OK Saves the current patterns shown and closes dial og.
Apply Saves the current patterns shown.
Cancel Disregards unsaved changes to the current patterns.
Digit Pattern Symbols (see “ Patterns’ description on page 6-14)
A Signifies the pattern must be at the beginning. If inside the string in [ ] brackets, it means “not”.
. Allows any single digit dialed to be accepted (wild card).
$ Signifies the pattern must be at the end.
* Matches zero or more digits that are dialed before this symbol. Example: ~1800.*, any 1-800 num
bers are allowed.
+ Matches 1 or more digits that are dialed before this symbol. The digit preceding the + must be
dialed to be accepted. Example: 1+, the 1 must be dialed first.
? Signifiesthe digit immediately following the ? is an optional digit. Example: 71507, either 1-507
or 507 can be dialed, the 1 is optional
[] Binds acceptable matches for this digit. Examples:
1[135]6 matches 116, 136 and 156
1[1-4]6 matches 116, 126, 136 and 146
1["2-8]6 matches 106, 116 and 196 (not 2-8)
- Specifies arange (used in conjunction with brackets).

What Call Routing Does

Call Routing routes all outbound interconnect
callsthrough particular calling resources such as an
SLIC (Subscriber Line Interface Circuit) line, DID
(Direct Inward Dialing) device, FX (Foreign

Exchange) line, or OPX (Off Premises Exchange) line.

Call Routing only deals with interconnect calls.

The Call Processor routes calls by matching the
number dialed and the service of acall against atable

of dialing rules to determine which rule (and therefore
which calling resource) appliesto this call, and also if
the call isalowed. This function is performed auto-
matically when Dialing Rules and associated Trunk
Groups have been set up.

Call Routing selectively routes calls by checking
the area codes and any other considerationsthat arein
the Dialing Rules. This permitsthe System Operator to
disallow certain types of calls or intercept calls and
route them to another trunk or line.
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Table 6-6 Trunk Groups Screen

% Dialing Rules =] B3
Rules I Digit Patterns ~ Trunk Groups | Rule Gmupsl ‘/ oK |
Trunk Groups wifdd Tnnk Grown 4 | 0 apply
TrunkGroupd -
TrunkGroupZ ¥ Delete Trunk Gf':"-‘pl X Cancel |
DID_Trunk_Dont_Uze_for_2way —
Function Description
Add Trunk Group Creates atrunk group by name associated witha TIM.
Delete Trunk Group Removes the selected Trunk Group from the Trunk Group list.

OK Saves the current Trunk Groups shown and closes dialog.

Apply

Saves the current Trunk Groups shown.

Cancel

Disregards unsaved changesto the Trunk Groups.

The Dialing Rules can block certain calls alto-
gether such as “976-xxxx” numbers. Call Routing
allows variable routing based on exchanges or area
codes. It can aso allow certain users to access certain
resources while not allowing others to use them.

Call Routing also lets the System Operator define
numbers for special uses, such as*“611” to get the
service number (rather than telephone repair) or “1” to
get time and temperature service. It can also redirect
numbers like 411" to free commercia directory assis-
tance services, if available. When arule matches a
call, the resources (repeaters, phone lines) assigned to
the rule are made available to that call.

Users are assigned a Permission Profile and
Permission Profiles are assigned a Dialing Rule Group
that is a collection of Dialing Rules. The phone
number the User dialed must meet the Dialing Rulesin
the Dialing Rule Group specified by the Permission
Profile. Many users may have the same Permission
Profile and several Permission Profiles may use the
same Dialing Rule Group.

Patterns

The user must dia acall that matches the pattern
exactly. In most cases, the pattern is shorter than the
phone number. A matching call is the same length as
the pattern, and matches as many digits as are defined
in the pattern. These are the first digits that must have
been dialed by the radio if this pattern isto be selected.

If the digits dialed by the radio do not start with this
pattern, then this pattern does not match.

The " signifies the beginning of a pattern or line.
Example: *1 indicates al phone numbers beginning
with the number 1. If it isinside the string in brackets
[~], it means“not”. Example: ~1507["8]["3]["5]$
indicates 1-507 is acceptable but “not” with the 835
exchange.

The $ causes a pattern to match only if it isat the
end of aline. Example: 5000$ matches any pattern
ending in 5000.

A singledigit may bereplaced by a( . ) period to
show that any digit in that position is an acceptable
match. Example: If the ruleisto match all direct-
dialed callsto long distance information, the pattern is
71...5551212% for thisrule.

A pattern must contain at least one digit or a
period. Any sequence of one or more periods at the
end of a pattern can be replaced with one period and
an asterisk ( .* ) The asterisk matches zero or more of
any preceding digits.

A plussign ( +) signifies that whatever digit
precedes it, may be duplicated. Example: ~1507+.+
matches 1-507 followed by any number of the numeral
seven and one or more additional digits.

A ?signifies the number that follows is optional .
Example: ~?1507 indicates the 1 is optional and either
1-507 or 507 are acceptable.
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Numeralsin brackets [ ] indicates these numbers
must be matched. [135] matchesa 1, 3, or 5, while
[1-5] matches numbers 1, 2, 3, 4, 5.

How Call Routing Works

Call Routing works by matching the number
dialed by aradio and the Dialing Rules. The Dialing
Rules should be in descending sequence order, i.e.
from the most restrictive to the least restrictive.

When acall is made, the number dialed is
matched against the patterns of the first Dialing Rule.
If the number dialed matches an “include pattern” and
does not match an “exclude pattern”, then the actions
associated with that Step are applied. If the patterns do
not match, then the next Dialing Ruleis applied. This
continues until aterminating action is encountered or
al of the Dialing Rules have been tested. Terminating
actions are those which make a determination as to
whether or not to allow the call to complete. These
actions are Allow (where atrunk is available), Block
and Queue. If acall isalowed on a Trunk Group with
no available lines, the rule processing will continue to
see if the call can be completed in accordance with
another Dialing Rule Step.

Planning The Pattern List

Because of the complexity of setting up a good
Pattern list, planning alist of Digit Patterns, Trunk
Groups, and Rules is suggested.

Begin by listing all the callsto be Included and then
list the calls to be Excluded.

* Arrange the Include list in order from the most
restrictive to the least restrictive.

® PlanaPattern that accomplisheswhat isrequired for
each type of call.

* Put these Patterns in order so they do not cancel
each other out.

® Plan the Action Form of any calsto allow.

* Finaly, enter the Digit Patterns into the Dialing
Rules Form.

Types Of Rules

The Dialing Rulesin a Call Processor either
permit acall to be completed (Include), or prevent a
call from being completed (Exclude).

There aretwo waysto block acall inaCall
Processor. Thefirst way to block acall is not to
describe the call in any of the rules. When the call is
placed, it fails to match any of the rules, and so is not
made. Use this method when a potentially large group
of callsisto be blocked, such asall 1-digit calls only,
or al 8-digit calls. Define rules and assign trunks to
callsto alow any of the remaining calls to be made.

The second way to block acall isto describe the
call so that it matches a pattern and use the Block for
the action.

Entering and Changing Rules

Before entering or changing arule, make a plan.
New rules have call canceling implications.

* Decideif thisdialingruleisto apply to al radios or
to radios that use a particular permission table.

* Decideif the set of numbersthisnew or revised rule
coversisaso covered by other dialing rules already
in the table, for the same radios.

* If both new and existing rules cover the same set of
numbers, decide if the existing rules should have
priority over the new rule, or vice versa.

* Decideif thisnew rule interferes with dialing rules
for radios other than those to be affected.

Remember that when the system searches for a
match, it starts at the first rule in the sequence and
goes through them to find a match. Once it finds a
match, it stops looking. Because the system triesto
find amatch in this order, it isimportant to place rules
in an order that makes sense.

For example, suppose that a certain area code has
thirty exchanges. All callsto that area areto be
allowed, but use a different Trunk Group for ten of the
exchanges.
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If the first rule accepts a match with any number
in that area code, and the second through ninth rules
define the exchanges, any calls to the selected
exchanges are allowed on the same Trunk Groups for
therest of that area code. When the area code
matched, the system stopped looking at the rules. To
set this up, enter the detailed rules “first”, so that if a
call matches one of those exchanges two through nine,
the system stops looking and usesits Trunk Group.
Then add the general rule for the rest of the area code.

North American Number Plan Example

The dialing rules for the North American
Numbering Plan can be fully implemented. The
complexity of the dialing rules depends upon the
amount of restriction the system operator wishes to
implement.

Thefollowing is an example of the North Amer-
ican Numbering Plan. The example assumes that a
single type of telephone line or trunk is available. The
trunk type is a standard two-way telephone line that
can handle the North American Numbering Plan. The
telephone line is assumed not to be a PBX or PABX
line. The assumed area code is 507 with two local
exchanges of 835 and 837.

Thefollowing isthelist of possible digit patterns
for diaing rule usage.

~0$ To be used to restrict single digit dialing of “0”.
Typically disallowed since international direct
and international operator assisted cannot be
distinguished, the full number is unknown.

1% To be used to restrict single digit dialing of “1”,
any long distance call would be allowed to pass
through since the subscriber unit could then dial
any digits after the initial dialing.

~011$ To be used to restrict 3 digit dialing of “011”
direct dialed international calling. Any interna-
tional calls would be allowed to pass through
since the subscriber unit could then dial any digits
after theinitial dialing. Thisistypicaly disal-
lowed since the full number that isdialed is
unknown.

A[1-8]11$ Thisis used to restrict the 3 digit dialing
other than “911”. The other service numbers of
411 or 611 are typically not usable by the end
subscriber units.

71900 To be used to restrict any number of digits with
“1-900” dialing, typically disallowed since
calling party ishilled at typicaly significant
charges.

71976 To be used to restrict any number of digits with
“1-976” dialing, typically disallowed since
calling party ishilled at typicaly significant
charges. Add in any other 1-9xx calls you wish to
disallow. There are 9xx area codes that haveto be
allowed.

AQOL......... To be used to alow “001” dialing for
international operator assisted calling. Thisis
used if one alowsinternational calls that are
billed to the called party. Thisisto allow any
operator assisted international callsif 12 or more
total digits are dialed; notice there are 9 periods.
If one wishesto allow less digits, then reduce the
number of periods.

AOLL......... To be used to alow “011” direct dialed
international calling. Thisisto alow any interna-
tional callsif 12 or moretotal digits are dialed
(notice there are 9 periods).

~911$ Thisisto be used to allow the 3 digit dialing of
the public safety emergency number.

N18 To beused for al 1-8xx-xxxx calls. Thisistypi-
cally alowed for all toll free 1-8xx type calls and
for direct long distance calls to area codes begin-
ning with 8. If the toll free 1-8xx numbers are to
be restricted then those patterns should be placed
before the allowed pattern set.

N1507835....$ This pattern is used to allow the strip-
ping of the 1507 since the 835isaloca
exchange.

A1507837....$ This pattern is used to allow the strip-

ping of the 1507 since the 837 isaloca
exchange.
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.......... $ This pattern is used to allow any 11 digit
direct long distance dialing. Since the
~1507835....$ and the 71507837....$ patterns
come before this pattern, they are used to inter-
cept and perform the stripping of the digits.
Previous patterns are used to restrict the long
distance dialing.

A 1800The 18xx toll free call patterns are included here
to be allowed.

1888
N877
1866

A835....$This pattern is used to allow 7 digit dialing
of the 835 local exchange (notice the 4 periods).

N837....$This pattern isused to alow 7 digit dialing
of the 837 local exchange. Any other 7 digit
dialing will be disallowed since there is no other
pattern match.

A$ Thisisthe no digits dialed pattern match that is
used to remove a subscriber from the queue.

The following procedure would be used to set up
the proper trunk group, digit patterns, and dialing rules
for the above North American Dialing Plan usage.

1. Establish atrunk group by “Trunk Groups/Add
Trunk Group” function with the name
Default_2Way.

Establishthe“ Telco Dialing Rule Groups’ under the
Permission Profilesform or the Dialing Rules Form.
Set up three telco dialing rule groups.

aName agroup DRG_L ocal that will be used for
usersthat will haveloca only dialing, it will also
allow 1-800 number dialing but restrict direct
long distance to 8xx area codes.

b.Name a group DRG_Local_L D that will be used
for usersthat will have local and direct long dis-
tance diaing.

c.Name agroup DRG_Loca_LD_Intl that will be
used for usersthat will have local, direct long dis-
tance, and internationa dialing.

6-17

3. Establishal of theabovedigit patternsby the* Digit
Patterns/Add Pattern” function.

NOTE: It isadvisable to keep the patternsin the
desired order when configuring the dialing rules.

DRG_Local LD _Intl

Select the DRG_Local_LD_Intl group in the
“Telco Dialing Rule Group” selection box under the
“Rules’ tab.

Sepl

1. Under the “Include these patterns’ box, place the
following patterns:

/\O$

/\1$
A011$
A[1-8]11$
1900
1976

2. Under the “Then do these actions” box, select the
“Block” function.

3. Select the“Add Step” function to add Step 2.

Sep 2

1. Under the “Include these patterns’ box, place the
following patterns:

A1507835....$
A1507837....$

Under the “Then do these actions” box, select the
“Strip” function.

Under the“ Strip” function, insert the“1507” for the
pattern and select the “ Pattern Only” radio button.

Under the “Then do these actions” box, select the
“Allow” function as the next function.

Under the “Allow” function, select the
Default_2Way trunk group name under the “Avail-
able Trunks’ and placeit in the “ On these trunks’
box.
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6. Under the “ Then do these actions” box, select the
“Queuge’ action. Thiswill queuethecdl if there are
no lines available for the given trunk group name.

7. Select the®Add Step” function to add Step 3.

Sep 3

1. Under the “Include these patterns’ box, place the
following patterns:

AOOL.........

N0l

n911$

Mo $Thiswill allow direct long distance
dialing when the previous steps
blocked the long distance calls that
are not allowed.

ng35....$

ng37...%$

2. Under the “ Then do these actions’ box, select the
“Allow” function.

Under the “Allow” function, select the
Default_2Way trunk group name under the “Avail-
able Trunks’ and placeit in the “On these trunks’
box.

Under the “Then do these actions” box, select the
“Queue” action. Thiswill queuethecal if thereare
no lines available for the given trunk group name.

Select the " Add Step” function to add Step 4.

Sep 4

1. Under the " Include these patterns’ box, place the
following patterns:

$

Under the “Then do these actions” box, select the
“Remove Queued Calls’ function. Thisisthe
pattern for no dialed digits. If auser startsacall but
does not enter any digitsthey will be removed from
the queueif they were previously queued.

6-18

DRG_Local LD:

Select the DRG_Local_LD_Intl group in the
“Telco Dialing Rule Group” selection box under the
“Rules’ tab.

Sepl

1. Under the “Include these patterns’ box, place the
following patterns:

/\O$

/\1$
A011$
A[1-8]11$
1900
1976

2. Under the “Then do these actions” box, select the
“Block” function.

3. Select the“Add Step” function to add Step 2.
Sep 2

1. Under the “Include these patterns’ box, place the
following patterns:

A1507835....$
71507837....$

Under the “Then do these actions” box, select the
“Strip” function.

Under the“ Strip” function, insert the“1507” for the
pattern and select the “ Pattern Only” radio button.

Under the “ Then do these actions” box, select the
“Allow” function as the next function.

Under the “Allow” function, select the
Default_2Way trunk group name under the “Avail-
able Trunks’ and placeit in the “ On these trunks’
box.

Under the “Then do these actions’ box, select the
“Queue” action. Thiswill queuethe call if there are
no lines available for the given trunk group name.
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7. Select the“Add Step” function to add Step 3.
Sep 3

1. Under the “Include these patterns’ box place the
following patterns:

Mo $Thiswill allow direct long distance
dialing when the previous steps
blocked the long distance calls that
are not allowed.

n835....%

ng37...%

2. Under the “Then do these actions’ box, select the
“Allow” function.

3. Under the*Allow” function, select the
Default_2Way trunk group name under the “Avail-
able Trunks” and placeit in the “On these trunks’
box.

4. Under the “ Then do these actions” box, select the
“Queuge’ action. Thiswill queuethecdl if there are
no lines available for the given trunk group name.

5. Select the“Add Step” function to add Step 4.
Sep 4

1. Under the “Include these patterns’ box place the
following patterns:

"$

2. Under the “ Then do these actions” box select the
“Remove Queued Calls’ function. Thisisthe
pattern for no dialed digits. If auser startsacall but
does not enter any digitsthey will be removed from
the queueif they were previously queued.

DRG_L ocal:
Select the DRG_L ocal group in the “Telco

Dialing Rule Group” selection box under the “ Rules’
tab.

Sepl

1. Under the “Include these patterns’ box, place the
following patterns:
0%
/\1$
N011$
N1-8]11%
1900

Mo $Thisis used to block long distance
calls except for the exclude patterns.

2. Under the “ Exclude these patterns’ box, place the
following patterns:

A1800 These patterns will be excluded from
being blocked under the1.......... $
pattern to be allowed in step 4.

1888

877

1866

3. Under the “Then do these actions’ box, select the
“Block” function.

4. Select the”Add Step” function to add Step 2.

Sep 2

1. Under the " Include these patterns’ box, place the
following patterns:

71507835....$
71507837....$

2. Under the “Then do these actions” box, select the
“Strip” function.

3. Under the " Strip” function, insert the“1507” for the
pattern and select the “ Pattern Only” radio button.

4. Under the “Then do these actions’ box, select the
“Allow” function as the next function.
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5. Under the*Allow” function, select the
Default_2Way trunk group name under the “Avail-
able Trunks’ and placeit in the “ On these trunks’
box.

6. Under the “ Then do these actions” box, select the
“Queue’ action. Thiswill queuethecdl if there are
no lines available for the given trunk group name.

7. Select the®Add Step” function to add Step 3.

Sep 3

1. Under the “Include these patterns’ box place the
following patterns:

n835....$
n837....$
"O11$

A1800 The 18xx toll-free call patterns are
included here to be allowed.

1888

1877

1866

2. Under the “Then do these actions’ box, select the
“Allow” function.

3. Under the*Allow” function, select the Default
2Way trunk group name under the “Available
Trunks’ and place it in the “ On these trunks” box.

4. Under the “ Then do these actions” box, select the
“Queue” action. Thiswill queuethecal if thereare
no lines available for the given trunk group name.

5. Select the“Add Step” function to add Step 4.

Sep 4

1. Under the " Include these patterns’ box, place the
following patterns:

$

2. Under the “Then do these actions” box, select the
“Remove Queued Calls’ function. Thisisthe

pattern for no dialed digits. If auser startsacall but
does not enter any digits, they will be removed from
the queue if they were previously queued.

6.3.11 COPY SETTINGS TO DEFAULTS

This function copies the data entered for the
Switch Configuration as defaults in the Call Processor
so they are used on startup by the Call Processor.

The Call Processor maintains separate Default
settings which are loaded when the Call Processor is
restarted. Switch Configuration Manager changes
affect current Switch operation, but are not automati-
cally made to the Call Processor default settings.
Therefore, any changes made by the Switch Configu-
ration Manager are lost when the Call Processor is
restarted if they have not been saved to the defaults.

6.3.12 PACK TABLES

When records are deleted, they are only marked
as deleted and continue to occupy space on the hard
drive. This function completely removes deleted
records from atable so that hard disk spaceisrecov-
ered. Use the Pack Tables command only when abso-
lutely necessary to recover disk space because this
function significantly slows down program execution.
It should be used only if avery large number of
records are to be deleted from atable.

6.3.13 CALL PROCESSOR PROPERTIES

The Call Processor Properties screen and descrip-
tions are shown in Table 6-7.

6.3.14 LOG PROPERTIES

The Log Properties screen and descriptions are
shown in Table 6-8.

6.3.15 SWITCH PROPERTIES

The Switch Properties screen and descriptions are
shown in Table 6-9.

NOTE: The above screens are displayed by right clicking the mouse in the left pane of the main Switch Configuration Manager screen.
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Table 6-7 Call Processor Properties Screen

S Call Pror t Propertties
—Windowsz Prioritie Logging Control——————
Main Proces: v LogEnor&
 Idle [ LogWarnings
* Mamal ™ Log Status
 High [ Canzale Window
¥ Record Session
Timer Thread— | [ Scan Thread—— | [Write Thread
" Idle i Ide  dle r—Cammand Optian——
" Lowest = Lawmest £ Lowest & Run
™ Below Mormal & Below Momal & Belaw Harmal
£ Maormal © Momal & Mamal  Restart
¢ Above Narmal " Above Mormal " Above Normal
= Highest i Highest = Highest " Shutdown
—Runtime Debugging
[~ Comstructors # Destructors I~ Process Tracing
[ Synchonous Events I~ Timers
[ Aspnchronous events ™ Read Database Activity
[ State Tracing [ wiite Database Activity

Call Processor Sound File:
[ Cant Happen |5 Fatal

aé Reboot Computer |

fL LCloze

[~ Save Old Sound File On Replace

Call Processor Event

' =] @] B popice

WINDOWSPRIORITIES

Main Process Call Processor application Priority. Normal = default, Idle = Used only if nothing elseis operating,
High = Runs before anything else.

Timer Thread Priority of the clock that determines when things happen in the program.

Scan Thread Priority of dataretrieval from the Data Base.

Write Thread Priority of the writing to the data base.

LOGGING CONTROL

Log Errors

Includes program errorsin the NT (Administrative Tools) Event Viewer and console window (if
displayed).

Log Warnings Includes program warnings in the NT Event Viewer and console window (if displayed).
Log Status Includes program status in the NT Event Viewer and console window (if displayed).
Console Window Displays log messages in awindow as they occur.

Record Session Copiesthe logging record to atext file.

COMMAND OPTION

Run

K eeps the program running.

Restart Shuts down the Call Processor program (not the computer) and restartsit from the beginning when
the window is closed.
Shutdown Stops the Call Processor program. It must then be manually restarted or the computer rebooted.

Can't Happen Is Fatal

If an event in the application occursin a state marked as “ cannot happen”, it istreated as a critical
error that causes the Call Processor to restart.

Reboot Computer Shuts down the Call Processor computer and restarts it from the beginning.
Exit Closes the window and applies the settings to the Call Processor.
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Table 6-7 Call Processor Properties Screen (Continued)

RUNTIME DEBUGGING (Direction required from support personnel to use these functions)

Constructors/Destructors

Synchronous Events

Asynchronous Events

State Tracing

Process Tracing

Timers

Read Database Activity

Write Database Activity

These functions send debugging information to atext file. All these settings are normally OFF.

CALL PROCESSOR SOUND FILES

Save Old Sound Files On
Replace

Saves the old sound file when replacing it with another file.

Call Processor Event

Selects the event for which the sound is being programmed. Call Processor events which can be
programmed to play a sound include Crash, Initialize, Shutdown, and Startup.

il Button Plays the selected sound.
Replace Displays awindow which allows a new sound to be selected to replace the current sound.
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Table 6-8 Log Properties Screen

% Log Properties

Activity Lo
v = 2oy |
Auiliay Call Log I 10000
x Cancel |
Directed Queus Log I 10000 %;E
10000 £ Alam Severityl
Emergency Plan Log Alam Limit
Emergency Traffic Log I 10000 Critical 10
ESM Resporss Log I 10000 Maior I 20
Fesponse Log I 10000 Mirar I £
Telea Log I 10000 Informational I 40
Telco Queue Log I 10000 Unknown I 50
Usage Accounting Log I 10000 Archived I 10000

larmn b it

Fiecipient Name

Fiecipient &ddress

[~ Critical Enabled

[~ Major Enabled

[ Infarmational Enabled

| |
| |
[~ Minor Enabled | I
| |
| |

[~ Unknown Enabled
E-Mail Host Hame

[~ EMai Log Enabled I

[¥ Enable Fonmarding Alarms to the Relay Manager

% Alarm Severity [_ (Ol x|
Severity Description =
| T Major CIM:Repeater Assignment Eror from the RIM
Il 2 Maior CIM.Link Setup fime-oul on the CIE H aee
3 Infomational CIM:Repeater restarted unespected from RIM

N 4 Minor CIM-Enable Fiepester Drder Mo Response Message fiom the Rit XK Cancel

|| 5 Minor ClM:Disable Repeater Orider No Response Message from the RIM 4 Define AT

|l B Informational CIM: Received Wrong Message from the RIM =

|| 7 Minar CIk: Transmit Call Request Mo Response Message fram the RIM

|| ] Minor Clt:Mo Channel Acknowledge from the RIM

|| 3 Minor Cltd:Mo Transmit Call Ack Message from the RIM

|| 10 Minor ClM:Na Transmit Hang Ack Message from the RIM

|| " Minor CIM:Ma Transmit Clear Ack Message

|| 12 Minar CIk:Mo Receive Update from the RIM
| & Define IAC Alarm Input O[]
+ 1AL Mumber CIM Card Address Severity

il | | E| =
' Alarm Test % Delete |
| I x Cancel |

Function Description

Log Limits The number entered is the maximum number of entries allowed in thelog. Any further entrieswill cause the
oldest entry to be deleted.

Alarm Limits | The number entered is the maximum number of alarms allowed in the active alarm file. Any further entries
will go into the alarm archive (see Section 6.2.2).

Archived Thisis the maximum number of alarms allowed in the archive, any further entries
will cause the oldest entry to be deleted.

Alarm Mail Checked boxes enable that severity to be sent via E-mail.

E-mail Log Enabled |When checked, enables the entire E-mail option.

Recipient Name Thisisthe name of the E-mail recipient. This can be used to send E-mail if the server
knows the recipient by this name.

Recipient Address | Thisisthe E-mail address of the recipient. This address always works for sending E-
mail, but is not needed if the server knows the recipient by name.

E-mail Host Name of the E-mail server (typically POP3).

Name

OK Saves the current data shown and closes dialog.

Cancel Disregards unsaved changes to the current patterns.

Alarm Severity |Thisisascroll list of all Alarm Numbers, Severity, and Description that allows the user to customize the
severity assigned to an alarm for the system. To change the severity of an alarm, simply click the right side
of the applicable Severity box to display adrop-down list. Then select the desired severity from thislist.

Define IAC Alarm Input (Defines specific external repeater alarms)
|AC Number Thisisthe number of the Alarm Input (1-4) of the repeater Interface Alarm Card.
CIM Card Address |Thisisthe address of the CIM card in the Switch (defines which repeater it is from).
Severity The degree of severity of the alarm (see Section 6.2).
Alarm Text Thisisthe description that is displayed when the alarm occurs.
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Table 6-9 Switch Properties Screen
& Switch Properties
Switch D Mumber of Shelves UID Call Timeout (sec]
E D =] w MK
Metwork Mumber Slots per Shelf Directed Call Bueue Limnit E Appl
[ENE B2 E =] Ll
Seral Mumber Group Patch Limit Telco Call Queue Limit ﬂl
|switch2 |2 B2 E =]
Frimary Mik COM Porte— [ Seconday MIM COM Port % Enter Key
IDE Port CSB Port Enabled 1DB Port CSE Port 4'
o N = GO N |
Fedundant Operatio
Comments [~ Enabled
I Switch Partner [0
W tulti-Hete ™ wide Bus V¥ Auto Registration
[~ wide drea LTRE W Call Queuing W PTT Registration e
T LTR-Met® W i Insufficient Pesource YW arning T one ﬂl
v Repeater Alarm Reparting [ Create Databasze Backup During Startup
Function Parameter Description
Switch ID 1-255 ID number assigned to this Switch.
Number of Shelves 1-18 Total number of shelvesin this Switch at this Locality.
UID Call Time Out 0-255 sec Maximum UID Call time limit.
Network Number 1-255 Network number to which this Switch is attached.
Slots per Shelf 12 or 16 There are 11 slots for modules and one slot for the PTM.
Directed Call Queue Limit 0-16 Maximum number of Auxiliary callsto hold in queue.
Serial Number Unique al phanumeric string (verified and enforced by the CP).
Group Patch Limit 0-16 Controls the maximum number of Console-configured Group
Patches in the Switch at any onetime.
Telco Call Queue Limit 0-16 Maximum number of Telco callsto hold in queue for aline.
Primary NIM COM Ports IDB 1-256 Thisisthe COM port used for the master clock on the bus seria
CSB 1-256 cable to the Switch (defaults are 5-6).
Secondary NIM COM Ports IDB 1-256 Thisisthe redundant COM port used for the master clock on the bus
CSB 1-256 serial cableto the Switch (defaults are 7-8).

Comments

Short note pad to help in the identification of the Switch.

Multi-Net/Wide Area LTR/LTR-Net/

Repeater Alarm Reporting

Displays only the type of System in which this Switch is operating.
For Repeater Alarms reported see Log Properties screen, Table 6-8.

Wide Bus

Sets the protocol words for running an LTR-Net Switch.

Call Queuing

Allows callsto be placed in queue until aline becomes available.

WAM Insufficient Resource Warning

Tone

Sounds an warning tone if aWAC was initiated and there are not
enough WAMSs or channels available.

Create Database Backup During Startup

This copies the database tables to the runtime directory. Should be
checked if changes have been made to ensure a good backup copy.

Auto Registration

Automatically registers mobile when it becomes a roamer.

PTT Registration Enables registration to occur on PTT if the mobileis aroamer.

OK The parameters are acceptable, save the settings.

Apply Saves the current Switch Properties shown.

Cancel Ignores entries and exits the Switch Properties screen.

Enter Key To change Switch type (i.e. Multi-Net to LTR-Net), aserial number
isrequired from Customer Service and must be entered here.

Redundant Operation Thisisthe ID number of aHot Standby Switch.
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6.4 CARD PROPERTIES

NOTE: The procedure for selecting the card to
configureis described in Section 6.1.3.

6.4.1 GLOBAL CARD PROPERTIES

The propertiesin Table 6-10 are common to all
card types. The following sections define the attributes

of the cards in the Switch. The CPM (Conventional
Patch Module), NetNIM (Network Interface Module),
and VTM (Voice Tone Module) have no attributes.
These cards are required to be a place holder for the
Call Processor to know and display the actual configu-
ration of the Switch and the modules that are defined.
This screen also shows the slots available to be used
by other modules.

Table 6-10 Global Card Properties

% Card Properties for switch2

Card &ddress Card Type

[
=] =l

—Auto enable?
" Falze
. True

i@ Enable Card |@ o Ok |
@ Dizable Card |@ gpply |

@ Restart Card |@ x Cancel |

E Save Settings as Default far Current Card |

Dezcnption
|
Function Parameters Description
Card Address 1-288 Card slot number.
Auto Enable* False, True Automatically initiates the operation of the card on restart.
Enable Card Manually initiates the operation of the card.
Disable Card Renders the card inoperable and denies access by the Call Processor.
Restart Card Manually returns the card to operation and re-initiates the card with the
Call Processor.
OK Saves current settings and closes form.
Cancel Ignores entries and exits the card properties screen.
@ Button Allows a group of cards to be updated. A wi ndpw is displayed to enter
the start and end address of cards to Enable, Disable, or Restart.
Save Settings as Default for Saves current card configuration as start up default values (see Section
Current Card 6.3.11).

* WARNING - See CIM Card Properties, Section 6.4.3.

6.4.2 CCM (CONVENTIONAL CHANNEL
MODULE)

The CCM (Conventional Channel Module)
screen is shown in Table 6-11. This module connects
the Switch to a Conventional Repeater. Each repeater
has a CCM that controls the repeater through logic
signaling. The CCM exchanges control information
with the Conventional Repeater Module (CRM) via
AFSK (Audio Freguency Shift Keying) datain a
Blank-Burst (B& B) mode on the Voice Audio Path.
The CCM monitors and controls the repeater transmit,

6-25

receives confirmation on all requests made to the
repeater and sends information the repeater received.

The CCM provides a 4-Wire 600 ohm balanced
Vvoi ce connection to the repeater, converts audio to and
from PCM (Pulse Code Modulation), transmits and
receives on the PCM bus, and controls voice audio
gating to and from the repeater. The CCM uses the
IDB (Intra-Terminal Data Bus) to communicate with
other modules, and send messages to and receives
messages from the Call Processor viathe NetNIM that
controlsits actions.
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The other modules determine the status of the
CCM/CRM/Repeater combination by what the CCM
transmits on the CSB (Channel Status Bus). The other

modules monitor the CSB and determineif aCCM has
the appropriate Group and Status for the type of
communication the module requires.

Table 6-11 Conventional Channel Module Screen

Conventional Channel Module {CCM)
Switched Channel Mumber Fepeater
Locality Group
Repeater Tppe———
= Duplex
" Simples
Function Parameters Description

NOTE: Global Card Properties are described in Table 6-10.

Switched Channel Number {1-30

A unique CCM number (a PCM time slot number).

Repeater Number 1-30

The Home Repeater channel used for calls.

Locality Number 1-255 The Locality Number that the repeater isin. Each conventional channel
must be in aunique Locality.

Group Number 1-225 The Group ID used with the Home Repeater channel.

Repeater Type Simplex, Duplex Selects the type of repeater used.

6.4.3 CIM (CHANNEL INTERFACE MODULE)

IMPORTANT

If more than one CIM is used as a Floating Channel,
DO NOT have more than one channel with Auto
Enable selected as TRUE (see Table 6-10).

The CIM (Channel Interface Module) screen is
shown in Table 6-12. This module connects the Switch
to the Multi-Net and LTR Repeaters. Each repeater has
aCIM that monitors and controls the repeater through
logic signaling. The CIM uses one of three methodsto
exchange control information with its repeater: RS-
232 lines, AFSK (Audio Frequency Shift Keying) data
on a Separate Audio Path, or by AFSK datain a
Blank-Burst (B&B) mode on the Voice Audio Path.

The CIM controls the repeater with Restart-
Enable-Disable, executes requests to Read-Write to

the repeater’s memory, and tells the repeater transmit
code to Hang or Send Turn-Off. The CIM receives
confirmation of all requests made to the repeater and
sends information the repeater receives.

The CIM provides 4-Wire 600 ohm balanced
voice connection to the repeater, converts audio to and
from PCM (Pulse Code Modulation), transmits and
receives on the PCM buses, and controls voice audio
gating to and from the repeater. The CIM usesthe IDB
(Intra-Terminal Data Bus) to communicate with other
modules, and send messages to and receives messages
from the Call Processor that controlsits actionsviathe
NetNIM. The other modules determine the status of
the CIM/Repeater combination by what the CIM trans-
mits on the CSB (Channel Status Bus). The other
modules monitor the CSB and determineif a CIM has
the appropriate Group and Status for the type of
communication the module requires.

Revised August 2001
Part No. 002-3139-078



SWITCH CONFIGURATION MANAGER

Table 6-12 Channel Interface Module Screen

Switch Channel Number
1

Repeater Nurmber
1

Localit
I 1

LTR Starting Telco GID

Channel Interface Module (CIM)

[~ Star Pound Disconnect Clk Type

’LTH

Repeater Connection Type
FSEK Burst

[~ Status Channel

I~ Unconditional Hang
FEK, Continuous

LTR Ending Telco GID Hang Time
I I 0 Digital 9500
Function Parameters Description

NOTE: Global Card Properties are described in Table 6-10.

Switch Channel Number  |1-30 A unigue CIM number (a PCM time slot number).

Repeater Number 1-30 The Home Repeater channel used for calls.

Locality Number 1-255 The Locality Number of the repeater.

LTR Starting GID 1-255 LTR Telco starting Group 1D of the block.

LTR Ending GID Start to 255 LTR Telco ending Group ID of the block.

Star Pound Disconnect Yes, No Both * and # must be used to disconnect a Telco/Aux call.

Status Channel Yes, No Marked for documentation. Indicates that this card is connected to the

Locality Status Channel.

NOTE: Do not program hang time of any type in the CIM if wide area calls are used because improper operation will result.
However, hang time works properly if it is set as a wide area call parameter and not in the CIM card properties.

Unconditional Hang Yes, No Conditional is selected to hang when thereis a Busy System condition.
Unconditional selects hang for all calls.
Hang Time 0=None The length of time arepeater delays after a transmission until the
1-15 sec. repeater stops transmitting. For hang time to be active, it must also be
enabled in the repeater by repeater programming.
CIM Type LTR, Multi-Net Communication channel if Multi-Net or LTR compatible.
Repeater Connection Type |FSK Burst Communication Data signaling type for CIM-to-repeater logic.

FSK Continuous
Digital 1200/9600

Communi cation uses Blank-and-Burst mode when FSK isto be used on
the main audio line.
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6.4.4 DCM (DISPATCH CHANNEL MODULE)

The DCM (Dispatch Channel Module) screenis
shown in Table 6-13. This module connects the Switch
to a Conventiona Repeater. Each repeater hasa DCM
that controls the repeater through logic signaling. The
DCM exchanges control information with the CRM
via AFSK (Audio Freguency Shift Keying) datain a
Blank-Burst mode on the voice audio path.

The DCM monitors and controls the repeater
transmit, receives confirmation of al requests made to
the repeater, and sends information the repeater

received. The DCM provides a4-Wire 600 chm
balanced voice connection to the repeater, converts
audio to and from PCM (Pulse Code Modulation),
transmits and receives on the PCM buses, and controls
voice audio gating to and from the repeater.

The DCM usesthe IDB (Intra-Terminal Data
Bus) to communicate to other modules and send
messages to and receive messages from the Call
Processor that controlsitsactionsviathe NetNIM. The
DCM monitors the CSB to determineif aDCM is
active with the appropriate Group.

Table 6-13 Dispatch Channel Module Screen

uio

Dispatch Channel Maodule (DCM)

Locality

Home

Repeater Mumber

GID

Friarity

Function Parameters Description
NOTE: Global Card Properties are described in Table 6-10.
Unique ID 1-8163 (8164-8191 reserved) Unique Identification (UID) number.
Home Number 1-30 Home Repeater channel.
Group ID 1-225 Group ID used for calls.
Locality Number 1-255 Locality number of the repeater.
Repeater Number 1-30 Home channel number used for calls.
Priority 1-5 Access Priority level. 1 ishighest, 5 islowest.
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6.4.5 DIM (DISPATCH INTERFACE MODULE)

The DIM (Dispatch Interface Module) screen is
shown in Table 6-14. This module uses either Direct
Connection or Tone Remote to interface to the
dispatch equipment. A DIM with direct connection is
associated with only one Group Code and uses aform
of Type Il E&M lead input similar to the mobile PTT.

A DIM with Tone Remote connection decodes
Guard Tonefor the PTT indication and decodesDTMF

(Dual Tone Multi-Frequency) to select from one-of-ten
Group Codes. A control sequence uses the DTMF to
placethe DIM in scan mode or to stop and use aspecific
Group Code. The Tone Remote feature requires the use
of aplug-in personality card. The DIM connects the 4-
Wire 600 ohm balanced audio with the PCM (Pulse
Code Modulation) data paths and communicates to
other modules viathe IDB (Intra-Terminal Data Bus).
The DIM also monitorsthe CIM (Channel Interface
Module) viathe CSB (Channel Status Bus) to deter-
mineif aCIM isactive with aDIM Group.

Table 6-14 Dispatch Interface Module Screen

Current Group Eeginring Bloc: 1D

{]]] Erding Black D

Dizpatch Madule

I~ Allow Enable By DTMF [T Serd Corral Tone
[~ Enable Patch Mode

Patch Timecut

™ Receive Control Tones

Bl Hz

Hame Channel

[T Enable Froceed Tone
I~ Enable DTHF

10 a0 H:z
850 H:

950 Hz

1050 Hz =l

Fanne |Default Tu Locali:_l,JlHang Tirne |F‘rinrity |Stath |Fl:-: IC

=

[Txi | 1 Add |
% Delete |

Function Parameters

Description

NOTE: Global Card Properties are described in Table 6-10.

Current Group 0-9 Number of Extended Group personalities available to dispatcher with tone
remote capability.

Unique ID 1-8163 Dispatcher Unique ID (UIDs 8164-8191 are reserved)

Home Channel 1-30 Home Repeater channel used for calls.

Beginning Block ID 1-225 Lowest number in ablock of Group IDs.

Ending Block ID 1-225 Highest number in ablock of Group IDs.

Encrypted LIC Yes, No If selected, M-Lead is used to mute audio on the LIC for UIDs 8000 and above,

Enable Patch Mode Yes, No If selected, this DIM is connected to agroup of DIMs.

Patch Time-Out 0-255 minutes Automatically disconnects the patch after time selected.

Enable Proceed Tone Yes, No If selected, atone sounds indicating ready to talk.

Enable DTMF Yes, No DTMF used by Tone Remote to indicate extended group.

Allow Enable By DTMF|Yes, No

If selected, DTMF tones enable a patch.

Receive Control Tones |Yes, No Tone Remote interface tones, input.
Send Control Tone Noneto 2050 Hz  |Tone Remote Function Tone. Uses selected standard frequency.
in 100 Hz steps

Home 1-30 List for each Extended Group: Home Repeater Channel.

Default Tx Locality 1-255 List for each Extended Group: Default Transmit Locality.

Hang Time 1-255 seconds List for each Extended Group: Repeater Hang Time. Time a repeater transmits
data but no audio and hold the channel for the call.

Priority 1 highest - 5 lowest |List for each Extended Group: Access Priority Level.

Rx ID 1-225 or 255 List for each Extended Group: Receive Group ID.

Tx 1D 1-225 or 255 List for each Extended Group: Transmit Group ID.

Add Includes DIM propertiesto thelist.

Delete Removes selected DIM properties from the list.
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6.4.6 IDM (INTELLIGENT DISPATCH MODULE)

The IDM (Intelligent Dispatch Module) screen is
shown in Table 6-15. This module interfaces the
Switch to a computer controlled dispatch Multi-Net 11
console. The IDM has a digital data connection that
requires a separate full-duplex 9600 baud RS-232
interface called the IDIB (Intelligent Dispatch Inter-
face Bus). The separate data path is required to allow
the computer controlled dispatch consoles to monitor
and display the status of other Groups. This status and
display update can take place while the consoleis busy

with voice communication on another Group. The
information exchanged between the IDM and the
consoles controlswhat the IDM receives and transmits
for voice communication.

The IDM connects the 4-Wire 600 ohm balanced
audio with the PCM (Pulse Code Modulation) data
paths and communicates to other modules viathe IDB
(Intra-Terminal Data Bus). The IDM aso monitors the
CSB (Channel Status Bus) to send update changes to
the IDM viathe IDIB.

Table 6-15 Intelligent Dispatch Module Screen
Console Module [(CM)
uiD
r—
¥ Enable Proceed Tone
Function Parameters Description
NOTE: Global Card Properties are described in Table 6-10.
Unique ID 1-8163 Dispatcher Unique ID (UIDs 8164-8191 are reserved)
Enable Proceed Tone Yes, No When selected, sounds a Proceed Tone indicating Ready-To-Talk.
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6.4.7 LEM (LOGGING ENCODER MODULE)

The LEM (Logging Encoder Module) screenis
shown in Table 6-16. This moduleis the interface that
performs the data collection and outputs of informa-
tion for recording voice traffic. The LEM communi-
cates with the other modules viathe IDB (Intra-
Terminal Data Bus) and monitors the CSB (Channel
Status Bus) for the Groups set up to use the LEM.

The LEM is configured to monitor up to five
channelsfor information. The LEM convertsthe CSB
information for the five channels and outputs 1200
baud AFSK (Audio Frequency Shift Keying) to a
logging recorder. There may be up to six LEMsina
Switch to cover up to thirty channels

Table 6-16 Logging Encoder Module Screen

Channel 1

Channel 2

Channel 3

Channel 4

Channel &

Logging Encoder Module (LEM)

Function Parameters

Description

NOTE: Global Card Properties are described in Table 6-10.

Channel 1- Channel 5 1-30

tions.

Array with 5 Switch Channel Numbers. These are PCM time slot posi-

6.4.8 MAM (MULTI-NET ACQUISITION
MODULE)

The MAM (Multi-Net Acquisition Module)
screen isthe same as the DIM screen shown in Table
6-14. This module uses either Direct Connection or
Tone Remote to interface to the VRCM-50 (Orbacom)
dispatch equipment for tone paging. A MAM with
direct connection is associated with only one Group
Code and uses aform of Type Il E&M lead input
similar to the mobile PTT.

The MAM also monitors the CIM (Channel Inter-
face Module) viathe CSB (see Section 3.3.2) to deter-
mineif aCIM isactive withaMAM Group. The CIM
notifies the MAM when a channel has been acquired
and an alarm relay on the MAM closes the connection
between the VRCM-50 console and the MAM. When
the consol e detects the connection to the MAM,
paging tones are sent.
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6.4.9 MCM (MULTI-NET CONSOLE MODULE)

The MCM (Multi-Net Console Module) screenis
shown in Table 6-17. This module interfacesto a
computer controlled VRCM-50 Series dispatch
console. The MCM has a digital data connection that
requires a separate full-duplex 9600 baud RS-232
interface called the IDIB (Intelligent Dispatch Inter-
face Bus). The separate data path is required to allow
computer controlled dispatch consoles to monitor and
display the status of other Groups. This status and
display update can take place while the consoleis busy
with voice communication on another Group. The
information exchanged between the MCM and the
consol e controls what the M CM receives and transmits
for voice communication.

The MCM connects the 4-Wire 600-ohm
balanced audio with the PCM (Pulse Code Modula-

tion) data paths and communicates to other modules
viathe DB (Intra-Terminal DataBus). The MCM also
monitorsthe CSB (Channel Status Bus) to send update
changes to the console viathe IDIB (Intelligent
Dispatch Interface Bus).

The MCM issimilar to an IDM except it al'so has
the capability of summing Multiple Group Audio into
the Select Audio. It can aso change the audio level of
each Group in the Select Audio. A Conventional Patch
Module (CPM) can only exist with an MCM. There
may be two CPMs per MCM and they must be
installed in the two address dlots above the MCM.
Example: MCM card address 40, CPM 1 address
would be 41 and CPM 2 address would be 42. The
functions of the CPM are controlled by the MCM.

Table 6-17 Multi-Net Console Module Screen

LD

Console Module [Ch)

[¥ Enable Proceed Tane

Function Parameters Description
NOTE: Global Card Properties are described in Table 6-10.
Unique ID 1-8163 Dispatcher Unique ID (UIDs 8164-8191 are reserved)
Enable Proceed Tone Yes, No When selected, sounds a Proceed Tone indicating ready to talk.
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6.4.10 SNM (SYSTEM NETWORK MODULE)

The SNM (System Network Module) screen is
shown in Table 6-18. This moduleis the interface that
alows Unique ID calling from RF units and multiple
Switches to be connected to atotal system network.
The SNM uses a 4-Wire 600-ohm balanced audio on
the interface and connects audio to the PCM (Pulse
Code Modulation) data paths. The SNM also uses a
Typell E&M lead connection set for connection initia-

tion and supervision.

The SNM communicates with other modules via
the IDB (Intra-Terminal Data Bus) and monitors the
CSB (Channel Status Bus) for a Group set up to use
the SNM. SNMs use AFSK (Audio Frequency Shift
Keying) datain a Blank-Burst mode to pass informa-
tion on the interface relative to the type of call desired
and connection status of the end device. Thisform of
data passing alows a standard 4-Wire interface
connection and does not require a specialized system
switching node.

Table 6-18 System Network Module Screen

Systemn Network Module (SNM)
SMNM Connection Type—
’717 Internat

" External

Paired SHM Card Address

0

Systern Metwork

St Connection Type———
’7(" Internal

{* Extemnal

Module (SN

Switch Connected To

2

Function Parameters Description
NOTE: Global Card Properties are described in Table 6-10.
SNM Connection Type Internal, External Isthis SNM External to this Switch?
Paired SNM Card Address Paired SNM’s Address.
Switch Connected To 0 = Node Switch Associated Switch. Provides reference as to when to select SNM when

routing acall. 255 isfor incoming SNM.
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6.4.11 TIM (TELEPHONE INTERFACE MODULE)
General

The TIM (Telephone Interface Module) connects
the Switch to the telephone lines and handles tele-
phone line protocols. The TIM logic unit is micropro-
cessor-controlled, and communicates to the Call
Processor viathe NetNIM and the IDB (Intra-Terminal
DataBus). A Switch may have multiple TIMs with
varying styles of telephone lines attached. The tele-
phone line audio is processed to interface with the
PCM (Pulse Code Modulation) voice path. The basic
TIM operation functions are Supervision, Signaling,
Call Supervision, and Intra-Terminal Communication
(see Multi-Net 3000 Series Switch Setup and Align-
ment Manual, Part No. 001-3139-003 or |ater for more
detailed information).

The TIM screens vary depending on the type of
telephone line being used. The TIM Card Type param-
eter selects one of the following types of phone lines.
Refer to the indicated table for information on the
screen, and to following descriptions for more infor-
mation on TIM card programming.

2-WireDID - Table 6-19

2-Wire Loop Ground - Table 6-20

4-Wire DID - Tables 6-21 and 6-23

4-Wire Loop Ground - Tables 6-22 and 6-23

Supervision

The TIM can be seized from either landside or
internal. Landside seizure occurs by DID (Direct
Inward Dialing) or 2-Way Start. Internal seizure comes
from the IDB as arequest for outgoing service on the
telephone line. Once seizure has occurred, connection
supervision takes place. Incoming calls are connected
by Immediate Start or Wink Start. Immediate Start
requires the ability to accept digitsin less than 70 ms
before digits are sent. Wink Start sends digits after a
short battery reversal and back to normal battery
before digits are received. Two-Way Incoming indi-
cates readiness to accept “ end-to-end” DTMF digits by
outputting a Proceed Tone.

Signaing

Once connection supervision has occurred, the
digit signaling occurs. There are two ways to send and
receive digits: Dial Pulse or DTMF. The TIM sends or
receives the appropriate signaling depending on the
direction of the call. The TIM is capable of sending
and receiving “end-to-end” signaling where the call is
completed and normal voice communication takes
place, or numeric information can be sent or received
viaDTMF. Dia Pulseinformation cannot pass through
the telephone company’s CO (Central Office) to make
it back and forth to the units.

Call Supervision

Oncethe signaling of the digits has occurred, call
status is determined for Answer and Disconnect.
Answer Supervision is an indication of when the
called party answers the telephone. The preferred
method is by Reverse Battery Answer, where the CO
reverses the battery connection. Therefore, current
flow reverses when the called party answers. The other
method is Mobile Speech Activity which detects the
presence of mobile speech for a certain length of time.
If the telephone line cannot recognize Reverse Battery
Answer, noneis sent toward the CO, and no real
answer supervision exits. However, the mobile speech
activity can be used for answer detection.

Disconnect Supervision

Disconnect Supervision detects when the called
party hangs-up (disconnects) and a message is then
sent to the TIM to disconnect from the telephone line.
The preferred method is Reverse Battery Answer
where the battery returnsto normal when the called
party disconnects. The next method isto wait for the
Mobile Disconnect Message. If the mobile does not
hang up properly, the message is not sent and the call
continues. Fail-safe alternatives watch for loss of
mobile speech or detect the return of dial tone. This
ensures call disconnect and allows another call to be
placed. The TIM then informs the Call Processor that
it has disconnected from the telephone line.

The TIM communicates to the Call Processor
through the Intra-Terminal Data Bus (IDB) and sends
activity information to the Call Processor. The Call

Revised August 2001
Part No. 002-3139-078



SWITCH CONFIGURATION MANAGER

Processor sends messages to the TIM to request
service, informsthe TIM to disconnect, and any other
necessary control information.

Telephone Line Styles

There are severa different styles of telephone
linesthe TIM contrals. The following styles of lines
and their basic connection are supported:

Direct Inward Dialing (DID) - The DID offersdirect
inward dialing of the telephone number and supplies
the 48V DC battery voltage to the incoming lines.
The Central Office (CO) contacts the DID by closing
the loop and sends the number to the DID by dia pulse
or DTMF. The DID can handle 2, 3 or 4 digits being
spilled forward by the CO.

4-WireE& M - Thisis primarily used with electronic
switches, public leased lines or microwave equipment
to provide compl ete separation of transmit and receive
audio lines. The signaling unit providesthe -48V DC
battery to the M-Lead, while the trunk unit provides
ground to the M-Lead. The signaling is reversed for
the E-Lead.

Dial Pulse- Dial pulsing isthe “break and make” of
the loop path current to cause no flow and flow. The
number of breaks, when no current flows, isthe
number of the desired digit, with 10 pulses equaling O.

Dual Tone Multi-Frequency (DTMF) - DTMF tone
signaling isused on almost all push button telephones.
DTMF iswhere the desired digit is composed of a
combination of two tones. A tone pair consists of one
tone from the low band group (697, 770, 852 or 941
Hz), and the high band group (1209, 1336, 1447 or
1633 Hz).

Audio Processing

The audio processing converts intra-terminal
voice path audio to be placed on the telephone lines.
The telephone line interface contains a hybrid that
transmits and receives audio from the telephone line
and keeps the transmitted audio out of the received
audio to eliminate side-tone and echoing. The hybrid
also converts the balanced telephone line to unbal-
anced connections.

Receive Audio

Thereceive audio is from the telephone line and
processed for the intra-terminal Pulse Code Modula-
tion (PCM) channel stream. The received audio has
three paths:

Voice Audio - The receive audio from the telephone
line comes from the unbalanced receive side of the
hybrid. The audio is level adjusted through an ampli-
fier to give acorrect line level adjustment and passes
through minimal filtering to eliminate the possibility
of unwanted frequencies. A transmission gate turnsthe
audio on and off toward the terminal. The gateis
followed by alevel adjustment amplifier/buffer before
the audio entersthe intra-terminal voice processing.
Theintra-terminal voice processingisaPCM CODEC
with atime slot determination circuit. The CODEC
digitizes the analog voice and outputs it on the PCM
transmit channel stream in the appropriate time slot.
The master clock and master frame sync are inputs to
the TIM. These inputs provide timing for the CODEC
and timing determination circuit.

Dial Tone Detection - The receive audio from the
telephone lineis taken from the line level adjust
amplifier buffer and passesinto a bandpass filter
centered on the frequencies used for dial tone. The
bandpassfilter is adjusted for detection of the dial tone
sent by the CO. The output of the bandpass filter
passes to arectification and detection circuit. The
output of the detection circuit indicates the presence of
dial tone to the logic unit.

DTMF Detection - The receive audio from the tele-
phone line is taken from the line level adjust amplifier
buffer. The audio passes into the DTMF detection
circuitry and outputs the tone pair received and the
valid tone pair signal to the logic unit.

Transmit Audio

The transmit audio from the PCM channel stream
is processed to analog and sent to the telephone line.
The functional paths of the transmit audio are as
follows:

Voice Path - The transmit voice is processed from the
PCM channel stream by the same CODEC and time
dlot determination circuitry asin the receive audio
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voice path section above. The digitized voiceis
converted to analog and filtered by the CODEC to a
high pass filter to eliminate low frequency audio. The
audio islevel adjusted by an amplifier buffer and gated
into a summing amplifier buffer. The audio gating
provides on/off control of the voice audio to the tele-
phoneline. The summing buffer hasalevel adjustment
to set the outgoing line level and drives the unbalanced
side of the telephone line hybrid.

M obile Speech Detection - The audio for mobile
speech detection comes from the CODEC amplifier
buffer. The bandpassfilter is centered at the audio

frequency recognized for voice peaks. The filtered
audio isrectified and detected for the presence of
voice. The output of the detector is an input to the
logic unit.

DTMF Generation - The DTMF signaling is gener-
ated on the TIM and transmitted toward the telephone
line. Thelogic unit provides the inputsto the DTMF
generation circuit. The generator outputs the desired
tones and is adjusted to the proper level with respect to
the voice path by an amplifier. The tones pass through
alogic unit controlled audio transmission gate,
summing amplifier buffer, to the telephone line.

Table 6-19 TIM 2-Wire DID Screen

Telephone Interface Module (TIM)

T TIMCardType——

Home Digits

4 wire DID
4 'wire Loop Ground

¢ e Loop Grownd | |

Murnber of Digitz

rDisconnect Method—— [ 'wink Start
= Total Time
= Dial Tane
Priority — Diefault Locality
::all Timeu:ulut [zec] 7 Fast Pulse
* 7 DTMF Dialing
Function Parameters Description
NOTE: Global Card Properties are described in Table 6-10.

TIM Card Type 2-Wire DID DID (Direct Inward Dialing) of the telephone number. Cannot
dial out to the CO. Two-Wire uses a pair of linesfor short
distances.

Disconnect Method Total Time Call disconnect by Dial Tone or by aTotal Call Time.

Dial Tone

Priority 1=highest, 5=lowest Access Priority Level

Default Locality 1-30 Default Locality for a Group Call when dialing only Home/
Group.

Call Time Out 1-255 Time between PTTsin secondsfor Dia Tone disconnect. Tota
call timein 10s of seconds for total time disconnect.

DTMF Dialing Used on almost all push-button phones. Tone pairs are used to
represent adigit.

Home Digits 10 numerical digits PSTN number.

Number of Digits 1-9 The number of digitsto receive (digits spilled forward).

Wink Start Yes, No Waits for battery reversal and back to normal to send digits.

Fast Pulse Yes, No Controls dialing rate for Pulse Dia, 20 PPS/10 PPS.
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Table 6-20 TIM 2-Wire Loop Ground Screen

Telephone Interface Module (TIM)

" 4"ire Loop Ground

—TIMCardType———

Trunk Group

:’ &dd Trunk Group |

T elephone Mumber

-

—Dizconnect Method
" Total Time
" Dial Tone

[F Proceed Tone
[Z "wait For Dial Taone

Priority

Default Locality

Call Timeout [zec)

[¥ Ground Start

[¥ Fast Pulze
[¥ FReverse Battery

® ¥ DTMF Dialing
Function Parameters Description
NOTE: Global Card Properties are described in Table 6-10.
Disconnect Method Total Time Call disconnect by Dial Tone or Total Call Time.
Dia Tone
Priority 1=highest, 5=lowest Access Priority Level
Default Locality 1-30 Default Locality for a Group Call when dialing only Home/
Group.
Call Time Out 1-255 Time between PT Tsin seconds for Dial Tone disconnect. Total
call timein 10s of seconds for total time disconnect.
DTMF Dialing Used on almost all push button phones. Tone pairs are used to
represent adigit.
Trunk Group 0-9 Used for trunk selection (see Section 6.3.10). Corresponds to
the trunk number assigned to the device connected to the PBX
Telephone Number 10-digits PSTN number (XXX-XXX-XXXX)
Proceed Tone Yes, No Outgoing tone when ready for digits.
Wait For Dial Tone Yes, No Wait for aDial Tone before sending digits.
Ground Start Yes - Ground Ground Start recognizes ground on Inward/Outward calls.
No - Loop Loop Start establishes load current on Inward/Outward calls.
Fast Pulse Yes, No Controls dialing rate for Pulse Dial, 20 PPS/10 PPS.

Reverse Battery

Yes - Reverse Battery
No - Mobile Speech

Call answering scheme.
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Table 6-21 TIM 4-Wire DID Screen

Telephone Interface Module (TIM)

rTIMCardType——
~ 2%ire DID

Home Digits

0 2'wire Log

meund I
(O Lk

Murnber of Digits

lal 65;: Ground

= Taotal Time
= Dial Tone

Priority  Default Locality

Dizconnect Method——  [7 ik Start

[ lgnore Pulze Timeout 7 Detect E Lead
All Times in millizeconds
CO Settle Min pulse break. Pulze dial break

Dial Tone in pulze make Pulze dial make

Hangup Delay Min pulse pause Pulze dial pause

Intes-digit Min pulses/iing Ring Hmeout

Call Timeout [zec]

= ¥ DTMF Disling

Wink Delay Time [meec)

Max ring pulse Min ring pulse  Tone off

Wink, Pulze Length [meec]

i E-lead tin tone off Tone oh

Min dial tone  Min tone on

Function

Parameters

Description

NOTE: Global Card Properties are described in Table 6-10.

Disconnect Method Total Time Call disconnect by Dial Tone or by a Total Call Time.
Dial Tone

Priority 1=highest, 5=lowest Access Priority Level

Default Locality 1-30 Default Locality for a Group Call when dialing only Home/
Group.

Call Time Out 1-255 Time between PTTsin secondsfor Dial Tone disconnect. Total
call timein 10s of seconds for total time disconnect.

DTMF Dialing Used on almost all push-button phones. Tone pairs are used to
represent adigit.

Home Digits 10 numerical digits PSTN number.

Number of Digits 1-9 The number of digitsto receive (digits spilled forward).

Wink Start Yes, No Waits for battery reversal and back to normal to send digits.

Wink Delay Time 0-255 ms Amount of delay between an E-L ead state change and awink
on the M-Lead is asserted.

Wink Pulse Length 0-255ms Length of aWink Pulse. NOTE: Setting both Wink Delay Time

and Wink Pulse Length to zero indicates |mmediate Sart.

NOTE: Refer to Table 6-23 for information on the 4-Wire Properties on the right side of the screen.
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Table 6-22 TIM 4-Wire Loop Ground Screen

Telephone Interface Module (TIM)

 2Wire DID

rTIMCardType

= 2'Wire Loop Ground I
= Awire DID

Trunk Group

[# lgnore Pulse Timeowt [ Detect E Lead
All Times in millizeconds

CO Settle Min pulze break Pulze dial break

;": Add Trunk Group |

Telephone Mumber

i

Dial Torne bin pulse make Pulze dial make

Hangup Delay Min pulse pause Pulse dial pause

Dizzonnect Method

" Total Time
" Dial Tone [+ Proceed Tone Inter-digit tin pulsesing Ring timeout
— | [ wait For Dial Tane I I

Priority  Default Locality i —

I I bdax ring pulze Minring pulse  Tone off

E Lead Timeout [mzec]
Il:a" s ) I fin E -lead intone off  Tone on
E 7 DTMF Dialing it dial tane it tone an
Function Parameters Description

NOTE: Global Card Properties are described in Table 6-10.

Disconnect Method Total Time Call disconnect by Dial Tone or by a Total Call Time.
Dial Tone

Priority 1=highest, 5=lowest Access Priority Level

Default Locality 1-30 Default Locality for a Group Call when dialing only Home/
Group.

Call Time Out 1-255 Time between PTTsin secondsfor Dial Tone disconnect. Tota
call timein 10s of seconds for total time disconnect.

DTMF Dialing Used on almost all push-button phones. Tone pairs are used to
represent adigit.

Trunk Group 0-9 Used for trunk selection (see Section 6.3.10). Corresponds to
the trunk number assigned to the device connected to the PBX

Telephone Number 10-digits PSTN number (XXX-XXX-XXXX)

Proceed Tone Yes, No Incoming tone when ready for digits.

Wait For Dial Tone Yes, No Wait for aDial Tone before sending digits.

E-Lead Time-Out 0-9950 ms If E-Lead Detection ison, the amount of time (in 50 ms steps)

to look for an E-Lead reversal before determining thelineis
out-of-order.

NOTE: Refer to Table 6-23 for information on the 4-\Wre Properties |ocated on the right side of the screen.
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Table 6-23 TIM 4-Wire Screen Properties

Telephone Interface Module (TIM)
rTIMCardType
& 2Wire DID
= 2'Wire Loop Ground

Dizzonnect Method
" Tatal Time
i Dial Tone

Trunk Group

[# lgnore Pulse Timeowt [ Detect E Lead
All Times in millizeconds
CO Settle

Iin pulse break Pulze dial break

i

Dial Torne bin pulse make Pulze dial make

;": Add Trunk Group |

Telephone Mumber

Hangup Delay Min pulse pause Pulse dial pause

Friority

Default Locality

[ Proceed Tone
[Z “w/ait For Dial Tane

Inter-digit

g Min pulzesAting Hing timeout

Call Timeout [zec]

bdax ring pulze Minring pulse  Tone off
E Lead Timeout [mzec]

I I tdin E-lead i tone off Toke an
E 7 DTMF Dialing IMin dial tone it tone an
Function Parameters Description

Ignore Pulse Time Out Yes, No Accept valid Pulse Dial digits.

Detect E-Lead Yes, No Turns E-Lead detection on or off.

CO Settle 0-2550 The amount of time to delay after line supervision has taken place before dialing
digits.

Dial Tone 0-9950 If Dial Tone detection is on, the amount of time to look for a Dial Tone before
determining the lineis out-of-order.

Hang-Up Delay 0-9950 The amount of time after going off-hook before an E-Lead reversal is accepted as aj
valid hang-up.

Inter-Digit 0-9950 Time-Out Timer that sets the maximum time allowed between digits when over-
dialing aradio or (in the case of DID) the amount of time to collect a Pulse Dialed
digit. In either case when a digit is detected the timer is reset. When the timer
expires, the call progresses with no more digits being accepted.

Maximum Ring Pulse 0-255 The maximum length of a pulse for ring detection.

Minimum E-Lead 0-255 The minimum length of a pulse for ring detection. Along with Maximum Ring
Pulse Length creates a valid frequency envelope for ring detection.

Minimum Dial Tone 0-255 The minimum amount of time a Dial Tone is detected contiguously beforeit is cond
sidered valid.

Minimum Pulse Break 0-255 The minimum amount of timeto idle the M-Lead while dialing Pulse Dial digitsfor
out-bound calls.

Minimum Pulse Make 0-255 The minimum amount of timeto reversethe M-Lead while dialing Pulse Dial digits
for out-bound calls.

Minimum Pulse Pause 0-9950 The minimum amount of time to pause between Pulse Dial Digits when making an
out-bound call.

Minimum Pulses/Ring 0-255 The minimum number of ring pulses that must be gathered before thering tone is
considered valid.

Minimum Ring Pulse 0-255 The minimum length of a pulse for ring detection. Along with Maximum Ring
Pulse length creates a valid frequency envelope for ring detection.

Minimum Tone Off 0-2500 The off time between DTMF digits while making an out-bound call.

Minimum Tone On 0-2500 How long to generate a DTMF digit while making an out-bound call.

Pulse Dial Break 0-255 How long to idle the M-Lead while dialing Pulse Dial digits for out-bound calls.

Pulse Dial Make 0-255 How long to reverse the M-Lead while dialing Pulse Dial digits for out-bound calls
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Table 6-23 TIM 4-Wire Screen Properties (Continued)

Function Parameters Description
Pulse Dial Pause 0-9950 The amount of time to pause between Pulse Dial digits when making an out-bound
call.
Ring Time Out 200-50,000 |The amount of time to wait for an answer (from amobile or landside) when ringing
Tone Off 0-2500 The off time between DTMF digits while making an out-bound call.
Tone On 0-2500 How long to generate a DTMF digit while making an out-bound call.

6.4.12 VDM (VOTER DIAGNOSTIC MODULE)

The VDM (Voter Diagnostic Module) screen is
shown in Table 6-24. This module in the Switch is the
data communication buffer module between the Call
Processor and the Voting System. The VDM pollsthe
Voter Shelf for alarms and passes the information to

the Call Processor. The type of data exchanges
between the Voting System and the VDM pertainsto
memory read of the Voters, Receiver Locality Enable/
Disable, and Alarm/Control information. The Call
Processor supports the manual control of the Receiver
Voter Module (RVM) in the Voter Shelf through the
VDM and the VDM is configured accordingly.

Table 6-24 Voter Diagnostic Module Screen

Yoter

Diagnostics Module [VDM)

Active Channel
1 e r7rser
24 &6 [ 8 [ 10

1112 151719 21 [ 23] 25[ |27 29
12 1416 18 20 221 24 261 28] 20

Receiver Yoter Control
Channel FWh Humber

F*b kemary banagement
Memorny Space | Address
" Intemal

 Ensternal

" Code

(* EEFROM

Data

Local Chankels
12 3r 4
[ e | o, |
Q_;i Write |

Function Parameters Description
NOTE: Global Card Properties are described in Table 6-10.
Active Channels Array with identifiers of 1-30, each identifying if the channel is active.
Channel 1-30 An active channel number indicated. Relates to the Receiver number.
RVM Number O=current, 1-7 external |Select an RVM number in conjunction with a Channel number to com-
municate with a specific RVM viathe VDM screen. The user, viathe
VDM, uses the number as atemporary selection.
RVM Memory External, Internal, Code,| Memory location to store data. External memory, Internal memory,
Management EEPROM Code ROM or the EEPROM.
Address Number in Hex Hex RAM address to read (memory location on selected RVM).
Data Number in Hex Datato write to EEPROM.
Read Reads from the EEPROM at Address/Data location.
Write Writes to EEPROM at Address/Data location.

Local Channels

14

These represent the four possible Localities a given RVM can be con-
nected to for a given channel.

Send

Sends the data to the selected channel in the Voter shelf.
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6.4.13 WAM (WIDE AREA MODULE)

The WAM (Wide Area Module) screen is shown
in Table 6-25. This module communicates with the
other modules viathe IDB (Intra-Terminal Data Bus)
and monitors the CSB (Channel Status Bus) for the
Groups that are set up to use the WAM. The Wide
Area Call configuration sent by the Call Processor
determines when the Wide Area Call should be acti-
vated.

The Wide Area Call configuration contains a
unique identification number (WAC ID) that identifies
the configuration to all Call Processors on a Network.
If auser at one Call Processor creates or modifies a
WAC ID configuration, it propagates to all the other
Call Processors on the Network.

A Wide Area Call can be configured to look like
an STM* (Site Tracking Module) call or a GPM*
(Group Patch Module) call. The STM call uses only
one Home/Group ID and tracks units by their UID
(Unique ID) across multiple Localities. The GPM call
contains Locality/Home/Group ID combinations and
does not care about Unique IDs.

WAM s with software version 2.17 or later allow
consoles to patch together multiple wide area group
cals.

* These modules were used in previous Multi-Net Systems with an
RNT. The WAM obsoleted these modules.

Additional information on Wide Area Module
programming follows:

Card Address - Thisis the dot number in the Switch.

Port - Thisisthelogical port number assigned to a
WAM in aswitch. The port numbers must be unique
and are used to identify which external WAMs are
physically tied together.

Example: If aWAM located in Switch 1, Slot 32 is
connected to aWAM in Switch 2, Slot 38, a port

number can be assigned that identifies they are tied
together. If there are more than two switchesin the
system, all the WAMSsin the group that are tied
together get the same port number.

Call Router - The Call Router option can either be set
for Present or Not Used. When multiple Switches are
connected together, the transmit and receive audio
paths are connected together. Thisin effect wraps the
audio from the transmit to the receive audio path.
When this type of configuration is used, the Call
Router option needs to be set to Present. When only
one Switch is used, this option needs to be set to Not
Used. This option tells the WAM whether the audio is
wrapped internally or externally.

Type- A WAM can be either an Internal or External
type. An Internal WAM isonly used for calls occur-
ring on that Switch with no external connectionsto
other switches. An External WAM isused for calsto
other switches designated by a Routing Group
Number.

Routing Group - The Routing Group identifieswhich
Switches areincluded inaWAM Group. When WAMs
are wired externally, they may be connected to any or
all of the other Switchesin the system. Wide Area
Calls are dlocated to a WAM through the use of the
Routing Group number.

Each WAC is configured with a Routing Group
number that identifies the type of resource needed to
setup the Call. If more than one set of WAMs are
connected to wire the same group of Switches
together, they are assigned the same Routing Group
number.

NOTE: Do not use Routing Group 0 becauseit is
reserved for internal WAMSs.

Allow Emergency Wide Area Calls - Turns on or off
the WAM’s ahility to activate WACs for priority 1
calls. Thisisaseria number key dependent field.
Therefore, it is displayed only if the SSM encryption
key contains this feature. This key is entered using the
File> Enter Key function described in Section 5.2.4.
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Table 6-25 Wide Area Module Screen

Cannection Typ
’V(:' External

" Intemnal

Wide Area Module (WAM)

Call Router———
E—‘ ’76’ Mat Uszed

" Present

Part Nurnber

Fiouting Graup

Wide Area Module (WaAM)

¥ Allow Erergency wide Area Calls

External Connection Type

C ion T CalR i .
(fng;ci[lﬁzl p (; Nootuti'aj— ¥ Allow Emergency wide Area Calls Internal Connection Type
& Internal " Present

Function Parameters Description

NOTE: Global Card Properties are described in Table 6-10, and additional information on the following parametersis

located on page 6-42.

Connection Type

External, Internal

Isthis an external stand-alone WAM or isit externally connected to
WAMs in other Switches?

Cadll Router

Not Used, Present

Indicate if a Call Router is used. In a multiple-switch environment
where the switches may not be co-located, Present is sel ected to prevent
multiple audio pathsin Wide Area Calls. NOTE: The Tx and Rx audio
between WAM cards needs to be bridged together at one point in all
multiple-switch systems.

Allow Emergency Wide
AreaCadlls

Enable/Disable

Enables or disables the ability to activate WACs for priority 1 cals.
Thisis an optional feature that is displayed only if the SSM encryption
key contains this feature.

Port Number

16 bits (0-65535)

External Only. When thereisno Call Router present, the WAM Port
Number represents a set of interconnected WAMs. If thereisa Call
Router, the port number represents only one external WAM.

Routing Group

(Do not use “0")

Identifies which Switches areincluded in aWAM group.
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APPENDIX A ALARM LIST

Table A-1 All Alarms (Listed By Number)

Alarm
No.

Severity

Description

INTRA-TERMINAL DATA BUSALARMS

Major

CIM:Repeater Assignment Error from the RIM. The CIM is reporting a mismatch between the
repeater number assigned to it and the repeater number reported by the repeater. Data 1 Value and
Description: Thisisthe repeater number that is programmed into the CIM and iswhat the CIM is
expecting from the repeater. Data 2 Value and Description: Thisisthe actual repeater number
reported by the repeater to the CIM.

Major

CIM:Link Setup time-out on the CIB. The CIM tries for 30 seconds to establish alink with the
repeater and if it fails, it generates this alarm. Once this alarm is generated for the first time, the CIM
continues to look for the repeater and if it continues to see nothing, it proceeds to report thisalarm
every 5 minutes until it either sees arepeater or detects that it has been set to disable.

Informational

CIM:Repeater restarted unexpected from RIM. The CIM generates this alarm if the CIM receives a
repeater restart message at atime it does not expect it. This alarm will be generated anytime the
repeater is manually restarted after the link had been established.

Minor

CIM:Enable Repeater Order No Response Message from the RIM. Not used. Alarm #18 used in its
place.

Minor

CIM:Disable Repeater Order No Response Message from the RIM. Thisalarm is generated if the CIM
does not get a response back from the repeater indicating that the repeater has disabled as aresult of al
disable order sent from the CIM. A disable order is nothing more than a bit state inside of a“repeater
authorization request order”. The repeater must acknowledge this order with the proper repeater
number and a proper enable/disable state. If either of these two parameters are wrong or no acknowl-
edgeisreceived at al, thisalarm is generated.

Informational

CIM:Received Wrong M essage from the RIM. Not Used.

Minor

CIM:Transmit Call Request No Response Message from the RIM. Not used. Alarm #9 used in its
place.

Minor

CIM:No Channel Acknowledge from the RIM. Not used. Alarm #18 used in its place.

Minor

CIM:No Transmit Call Ack Message from the RIM. If a CIM does hot get areply back from arepeater
for a“transmit call request order” within 300 ms, it will send the order again. If it does not receive a
response 300 ms after the third try, the CIM will send this alarm to the CP and send a NACK back to
whatever device that had sent it the simulselect or channel request order in the first place.

10

Minor

CIM:No Transmit Hang Ack Message from the RIM. If a CIM does not get areply back from a
repeater for a“transmit hang request order” within 300 ms, it will send the order again. If it does not
get aresponse within an additional 300 ms, it will send this alarm to the CP.

11

Minor

CIM:No Transmit Clear Ack Message. If a CIM does not get areply back from arepeater for a
“transmit clear request order” within 300 ms, it will send the order again. If it does not get a response
within an additional 300 ms, it will send this alarm to the CP.

12

Minor

CIM:No Receive Update from the RIM. Once aCIM isin areceive state of some form as the result of
receiving a“receive call request” message from its repeater at some point, the CIM expects additional
messages periodically from the repeater to keep the call up. If the CIM does not receive another
receive “call request message” from its repeater for a period of three minutes and if the CIM isnot in
duplex task, it dropsthe call and sendsthis alarm to the CP. If it does not receive another “call request
message”' whileit isin duplex task, it closesits audio gates routing the received audio and returns to
transmit task.
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Table A-1 All Alarms (Listed By Number) (Continued)

Alarm

No. Severity Description

13 |Unknown External error. If the DIM or MAM initialization order from the Call Processor indicates there are
extended groups but then no DIM extended initialization order is received by the card, the card will
send this alarm message to the CP and then go back to the initialization task.

14 |Informational|Group Number Error. If aDIM or MAM receivesa*“DIM Extended Initialization Order” from the Call
Processor with a record number that is out of order, it will send this error to the CP and return to Idle
Task. Thismay occur if for some reason the card missed onein aseries of DIM Extended Initialization
Ordersresulting in the extended group record number not matching what it expects.

15 |Informational|ldle busy conflict. If the home, group, or UID of the channel the card has selected or requested,
changes to something other than what the card started with, or if the channel unexpectedly goesidle,
this alarm message is sent to the CP. Thisalarm is produced whenever a switch side card (WAM,
MCM, SNM, DIM, TIM, MAM, IDM, etc.) attempts to take control of an idle channel and gets a
negative response. This could be caused by such things as two cards requesting a channel at the same
time
(collisions), aradio getting a channel just prior to an attempt by a card, a console taking over control
of achannel, or the channel going down for some reason. A few of these alarms aday are normal but
hundreds may indicate avery busy system in need of reconfiguration. Note that this alarm does not
indicate lost calls because aretry isimmediately made on another channel.

16 Informational| Transmit time-out error

17  |Informational|Hang error

18 |Minor CIM:No Repeater Authorization Ack Message

19 |Major TIM:No Trunk Error

20 [Minor SNM:Connection Failure

21 |Minor CIM:Link Established Message No Response Order

22 |Minor CIM:Repeater Enabled Message No Response Order

23 |Minor CIM:Repeater Disabled Message No Response Order

24 (Minor Loss of E-lead on the PCM

25  [Minor No response from the SMM

26  |Minor No response from the module

27  |Minor No Trunk Response Order

28 Minor No disconnect response

29  |Minor No DIM Response

30 |Minor SNM:No SNB Response

31 |Major TIM:2-WAY not able to get service

32 [Minor TIM:No dia tone received

33 [Minor TIM:No wink received

34  |Mgjor TIM:No trunk connected to 2-way

35 |Informational|Lost a Registration Request Message

36 [Minor CIM:RIM Link Lost
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Table A-1 All Alarms (Listed By Number) (Continued)

Alarm

No. Severity Description

37 |Major No RVM Response. The VDM polls each RVM it believes exists sequentially every two seconds. If it
does not get a response back from one, it sends an error message on the IDB informing the CP of
which RVM it has lost communication with. Data 1 Value and Description: Range of the valueis 8
to 255. Thisisan 8-bit number binaurally representing the RVM and channel number of the reportedly
missing RVM. Bits 0-2 represent the RVM number. A zero in these three bits meansthe cRVM is
missing. Anything in the range of 1 to 7 means a specific dave RVM is missing. The upper 5 bits (3-7)
represent the repeater number (or cRVM number) of the missing RVM. These 5 bits can rangein value
from 1 and 30. Data 2 Value and Description: Range of the value if 0to 1. If thisfield is a zero then
thisalarm is“set”* meaning the RVM in Data 1 is currently missing. If thisfield is a one, then this
alarmis*“cleared” meaning the RVM in Data 1 has had communication restored.

38 |Informational|CIM:Went to standby

39 |Informational| SNM:SNB link restored

40 |Minor IDM:Link was lost between IDM and console

41  |Informational|IDM:Link was restored between IDM and console

42  |Minor IDM:Repeater Alarm/IDM Link Error

46  |Informational|Not all channels activein WAM. The WAM did not get all the channels needed to fully service the
wide area call, usually because not enough were available. It indicates that one or more of the partici-
pants did not participate. A few if these messages are normal during busy periods, but hundreds per
day may indicate a need for additional channels. Data 1 Value and Description: Indicates that task
the WAM was in where the alarm was generated. They can be asfollows: 3 - Rx Only; 4 - Rx of Other
Tx; 5- Tx Only; 8 - Duplex. Data 2 Value and Description: Indicates the site number of the site that
was unable to bring up all needed channels. Note that this only displays the first site the WAM sees
that did not bring up all channels. There may have been others.

72  |Major NIM:IDB lock up

73 |Major NIM:CSB lock up

74 |Magjor NIM:NIM Card Lock up

100 |Critica Out of Memory

101 |Minor Received Card Address out of range

102 |Informational|Clock Status

103 |[Magor NIM:Clock Takeover

104 |Informational| Unexpected DIM Ack

105 |Informational| DIM Initialization Complete

106 |Informational| Device Enabled

107 |Informational| CIM Initialization Complete

108 |Informational| STM Initialization

109 |Informational| CCM Initialized

110 |Informational| SNM Initialized

111 |Minor Device Not Defined at Initialization

112 |Informational| CIM:Repeater Enabled

113 |Informational| CIM:Repeater Disabled

114 |Informational|UID Terminated

115 |Minor Unexpected UID Termination

116 |Informational|UID Reassigned

117 |Minor Failed Terminate Set up

118 |Minor Failed Interrogate Setup

119 |[Minor Selective Unit Disable Time-out
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Table A-1 All Alarms (Listed By Number) (Continued)

Alarm Severity Description
No.
120 |Minor No Response Suspend Audio Order
121 |Minor Failed Dynamic Reassignment Setup
122 |Minor Dynamic Reassignment Response Time-out
123 |Minor NAK to Selective Unit Disable Order
124 |Minor Execute Selective Unit Disable Failure
125 |Minor Fail Execute of Dynamic Reassignment
126 |Minor Unexpected Dynamic Reassignment
127 |Informational| System Boot Complete
128 |Minor Call Failure Prior to SUD
129 |Informational| RNT Registration out to othersfailure
130 |Minor No Response for DIM to accept a UID call
131 |Minor No Response for SNM to accept aUID call
132 |Minor Exceeded number of tries to disconnect
133 |Unknown Pointer indicate idle and still on timed list
134 |Informational| SNM Idle Time-out Error
135 |Informational| TIM Initialization
136 |Minor No TIM Response to Trunk Request
137 |Informationa| TIM Idle Time-out Error
138 |Informational| NAK to a TIM Outgoing Request
139 |Minor No TIM Response to Call Destination Order
140 |Minor No DIM Response to Call Destination Order
141 |Minor No SNM Response to Call Destination Order
142 |Minor NACK Execute of Dynamic Reassignment by Mobile
143 |Informational| Failure to complete enable of card
144 |Unknown Reserved
145 |Unknown Reserved
146 |Unknown Reserved
147 |Unknown Reserved
148 |Unknown Reserved
149 |Unknown Reserved
150 |Unknown Reserved
151 |Informational| DCM Initialization
152 |Minor SUD Kill Not Allowed by Radio
153 |Unknown Reserved
154 |Unknown Reserved
155 |Informationa|VDM Initiadization
156 |Informational|Group Patch Initialization
157 |Minor GPM Configure Setup Failure

A-4
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Table A-1 All Alarms (Listed By Number) (Continued)

Alarm Severity Description

No.

158 |Minor GPM Tear Down Failure

159 |Minor No Queue setup completion message

160 |Informational|IDM Initialization

161 |Informational|LEM Initialization

162 |Minor Dynamic Freq. No CIM Response

163 |Minor IDM fail to ack patch setup

164 |Minor GPM fail to ack patch add order

165 |Minor GPM fail to ack reconfiguration order

CALL PROCESSOR ALARMS

240 |Unknown Keith Barnes Personal TIM debug message (call for details)

256 |Informational| Selection Complete

257 |Informational|No channels available for interrogate

258 |Informational|lnterrogate succeeded

259 |Informational|Interrogate failed

260 |Minor Selective Unit Disable setup failed

261 |Informational|User Kill completed

262 |Major Network time-out

263 |Minor User suspend audio failed

264 |(Minor WAM abort failed

265 |Major Card failed

266 |Minor EM activate failed

267 |(Minor No available channels

268 |Informational|No available WAMs. At the instant the Call Processor needed aWAM to configure awide areacall, all
were busy or were in the 10-second dwell time after acall. A few of these messages aday is consid-
ered normal, but hundreds may indicate a need for additional WAMs.

269 |Informational| Net WAM nak. The Call Processor receivesaNACK when awide area call configuration order is sent
toaWAM and fails. This could occur if the WAM went busy with another call at the same time this
order was sent. The CP then reattempts on a different WAM. Aswith alarm 268, hundreds of these
alarms a day may indicate a need for additional WAMSs.

270 |Informational| Channel was busy

271 |Informational|“Kill user failed, no available channels”

272 |Minor TIM request failed

273 |Minor EM enable failed

274 | Informational| Emergency plan aborted

275 |Informational|NIM:CSB OK

276 |Critica NIM:CSB failed
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Table A-1 All Alarms (Listed By Number) (Continued)

Alarm
No.

Severity

Description

277

Informational

VDM memory log. The VDM receives amemory message from an RVM as aresult of it initially
sending a memory order to it. The memory order includes the memory location and the type of
memory being read from the card. The order sent from the VDM to the RVM isitself the result of a
VDM order sent to the VDM from the CP. The memory order from the CP isitself originated from a
user requesting the memory read from the VDM card property of the SSM. TheresultisaVDM
Memory Message being sent to the CP from the VDM containing the contents of the memory message
it received from the RVM. The CP then generates the informational VDM Memory Log alarm (277)
and logsit to the alarm log with the following data fields set as follows: Data 1 Value and Descrip-
tion: Range of the valueis 1 to 65535. This 16-bit number represents the RVM number and the
channel number that had its memory read. The RVM number islocated in the top 8 bits of the field
value and the channel number isin the lower 8 bits of the field. The RVM number rangesfrom 0 to 7
with O being the cRVM and 1 to 7 being the possible dave RVMs. Example, if memory read occurred
on the cRVM of channel one the 16-bit binary representation would be 0000000000000001 or 1in
decimal. If the memory read occurred on ave RV M number 1 of channel 2, the binary representation
would be 0000000100000010 or 258 in decimal (12h in hex). Data 2 Value and Description: Range
of thevalueis 1 to 65535. This 16-bit number represents the memory location (in decimal) read from
the respective RVM. Data 3 Value and Description: Range of the valueis 1 to 65535. This 16-bit
number represents the value returned by the RVM as aresult of reading the location displayed in
Data2. The lower 8 bits of this 16-bit number is the value returned for the actual memory location
displayed in Data2. The upper 8 bits are from the location directly above the memory location
displayed in Data 2. In other words, every memory read returns the contents of two locations. The one
reguested and the one above it.

278

Informational

RVM message log. The cRVM setsabit inits RVM error bit map when it does not get aresponse back
from aslave RVM. The bitmap is seven bits long with the least significant bit representing RvM 1 and
the most significant bit representing RVM 7. Example: If the cRVM lost contact with RVM 3, the
RVM error bit map would be set to 0000100 (or decimal 4). If it lost contact with RVMs one, two, and
six it would set it to 0100011 (decimal 35). This bit map is supplied in every RVM status message to
the VDM. If the VDM detects a change to the bit map for the given RV M, it writesan “RVM
Message” to the CP viathe IDB informing the CP of the new bit map state. The CP will write this out
as an informational alarm (278) with the data fields set as described below. See also alarm 37. Data 1
Value and Description: Range of the valueis 1 to 30. Thisis the repeater number of the cRVM that
originated the data to the VDM. Data 2 Value and Description: Range of the valueis 0 to 128. This
isthe 7-bit bitmap representing the failed RVMs the cRVM is reporting on. If thisvalueis 0, then all
previously reported RVM failures have cleared. Data 3 Value and Description: Range of thevalueis
110 128. Thisisthe 7-hit bitmap representing the RV Ms that are expected to be present and communi-
cating with the cRVM. The source of this setting is adip switch setting on the cRVM.
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Table A-1 All Alarms (Listed By Number) (Continued)

Alarm
No.

Severity

Description

279

Informational

CDM message log. RVMs send their status to the VDM when polled. Included in this status is the
status of the CDM bus (bus that transfers RSS! information to the RVM). If an RVM detects a bad
CDM bus on one or more of its sites, it sets that site's respective number in a4-bit bitmap. Example: If
the RVM lost the CDM bus on the third site, the CDM Error bit map would be set to 0100 (or decimal
4). If it lost sites one and two it would set it to 0011 (decimal 3). This bit map is supplied in every
RVM status message to the VDM. If the VDM detects a change to the bit map for the given RVM, it
writesa“CDM Message” to the CP viathe IDB informing the CP of the new bit map state. The CP
then writes this out as an informational alarm (279) with the data fields set as described follows: Data
1 Value and Description: Range of the valueis 1 to 65535. This 16-bit number represents the RvM
number and the channel number. The RVM number is located in the top 8 bits of the field value and
the channel number isin the lower 8 bits of the field. The RVM number itself ranges from 0 to 7 with
0 being the cRVM and 1 to 7 being the possible slave RVMs. Example: If the CDM error occurred on
the cRVM of channel one the 16-bit binary representation would be 0000000000000001 or 1in
decimal. If the error occurred on slave RVM number 1 of channel 2, the binary representation would
be 0000000100000010 or 258 in decimal (102h in hex). Data 2 Value and Description: Range of the
valueis0to 15. Thisisthe CDM error bit map vaue. If the valueis 0, then the last change to the bit
map resulted in any previous CDM errors being cleared. A number from 1 to 15 binaurally describes
which of the 4 CDM busses for that given RVM isin an error state. Example: If sites one and three are
in an error state, the bit map would be 0101 or 5 in decimal.

280

Informational

RDM message log. RVMs send their status to the VDM when polled. Included in this status is the
status of the RDM bus (bus that transfers RSSI information to the RVM). If an RVM detects a bad
RDM bus on one or more of itssites, it setsthat site's respective number in a4-bit bitmap. Example: If
the RVM lost the RDM bus on the third site, the RDM Error bit map would be set to 0100 (or decimal
4). If it lost sites one and two it would set it to 0011 (decimal 3). This bit map is supplied in every
RVM status message to the VDM. If the VDM detects a change to the bit map for the given RVM, it
writes a“RDM Message” to the CP viathe IDB informing the CP of the new bit map state. The CP
writes this out as an informational alarm (279) with the data fields set as follows. Data 1 Value and
Description: Range of the valueis 1 to 65535. This 16-bit number represents the RVM number and
the channel number. The RVM number is located in the top 8 bits of the field value and the channel
number isin the lower 8 bits of the field. The RVM number itself ranges from 0 to 7 with 0 being the
cRVM and 1 to 7 being the possible slave RVMs. Example: If the RDM error occurred on the cRVM
of channel one, the 16-bit binary representation would be 0000000000000001 or 1 in decimal. If the
error occurred on slave RVM number 1 of channel 2, the binary representation would be
0000000100000010 or 258 in decimal (12hin hex). Data 2 Value and Description: Range of the
valueis0to 15. Thisisthe RDM error bit map value. If the value is 0, then the last change to the bit
map resulted in any and all previous RDM errors being cleared. A number from 1 to 15 binaurally
describes which of the 4 RDM bussesfor that given RVM isin an error state. Example: If sitesone and
three arein an error state, the bit map would be 0101 or 5 in decimal.

281

Minor

TIM:Bad TIM type

282

Minor

Dispatch card initialize failed

283

Informational

Card restart log entry

284

Minor

Bad card address detected

285

Informational

Memory log error

286

Informational

Log standby

287

Informational

Cardinitialized

288

Minor

Card Initialize failure

289

Minor

Card restart failure
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ALARM LIST

Table A-1 All Alarms (Listed By Number) (Continued)

Alarm Severity Description
No.
290 |Informational|Bad opcode detected. The Call Processor received alDB message addressed to it with an opcode it
does not handle. This could be caused by improper programming of a CIM or other card.
291 |Minor UID not in database
292 |Minor Group or home not in database
293 |Informational|CIM Initiaized
294 | Critical NIM:IDB Tx Bus Failure
295 |Critica NIM:IDB Genera Bus Failure
296 |Informational| Emergency plan execution started
297 |Informational| Emergency plan completed
298 |Minor Sleep call setup failed
299 (Minor Sleep call failed
300 |Minor Sleep call timed out waiting for a response
301 |Minor Sleep execute failed
302 [Minor “Sleep call failed, no available channels”’
303 |Informational|Sleep Completed successfully
304 |Informational|Group Alpha Tag completed successfully
305 |Minor Group Alpha Tag Failed
306 |Minor “Group Alpha Tag failed, no available channels”
307 |Minor “Group Alpha Tag Failed, no response from CIM”
308 |Informational| Wide Area Call aborted due to glare on specified port number
309 |Informational|Alpha Numeric Message sent successfully
310 |Informational| Alpha Numeric Message failed.
311 |(Minor “Alpha Numeric Message failed, No available channels’
312 |Minor “ Alpha Numeric Message failed, no response received.”
313 [(Minor ESN by UID call failed
314 |(Minor “ESN by UID call failed, No available channels’
315 |Minor “ESN by UID call failed, No response from subscriber unit”
316 |Informational| ESN successfully retrieved from UID
317 |Minor UID by ESN call failed
318 |Minor “UID by ESN call failed, No available channels’
319 |Minor “UID by ESN call failed, No response from subscriber unit”
320 |Informational|UID successfully retrieved from ESN
321 |Informational| ESN Authentication Done
322 |Informational| ESN Authentication Started
323 |(Minor WAM Configuration Failed
324 |Unknown RPTR:SMC
325 |Unknown RPTR:VNC
326 |Unknown RPTR:AC Fall
327 |Unknown |RPTRIIAC1
328 |Unknown |RPTR:IAC2
329 |Unknown RPTR:IAC 3
330 |Unknown |RPTR:IIAC4
331 |Unknown RPTR:MAC

A-8
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ALARM LIST

Table A-1 All Alarms (Listed By Number) (Continued)

Alarm Severity Description
No.
332 |Unknown RPTR:HSDB
333 |Unknown RPTR:IRDB
334 |Unknown RPTR:CIM
335 |Unknown RPTR:TIC
336 |Unknown RPTR:Battery Fail
337 |Unknown RPTR:PS Thermal
338 |Unknown RPTR:FAN 1
339 |Unknown RPTR:FAN 2
340 |Unknown RPTR:GPS 1PPS
341 |Unknown RPTR:IAC Mismatch
342 |Unknown RPTR:SMC Link
343 |Unknown RPTR:No A/D
344 |Unknown RPTR:GPS 10 MHZ
345 |Unknown RPTR: Setup
346 |Unknown RPTR:RF Shutdown
347 |Unknown RPTR:RF Half Power
348 |Unknown RPTR:RF Thermal
349 |Unknown RPTRIRF1& 2
350 |Unknown RPTR.RF3& 4
351 |Unknown RPTR:RF VSWR
352 |Unknown RPTR:Tx Synth Lock
353 |Unknown RPTR:Rx Synth Lock
354 |Unknown RPTR:HSS Rx Lock
355 |Unknown RPTR:HSS Tx Lock
356 |Unknown RPTR:RF 1/4 Power
357 |Unknown RPTR:Disabled
358 |Unknown RPTR:Test Mode
359 |Informational| Alpha Group Page failed - No channels available
360 |Informational|Alpha Group Page failed - No response from unit
361 |Informational|Alpha group Page Completed Successfully
362 |Informational| Alpha Group Page failed
363 |Informational| TIM went idle unexpectedly
400 |Informational| CIM:Repeater Link Established
401 |Informational|NIM:IDB OK
402 |Unknown RPTR: Undefined Forwarded Repeater Alarm
100000 |Minor Bogus Alarm

A-9
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CALL SEQUENCES

APPENDIX B CALL SEQUENCES

B.1 GROUP CALL

B.1.1 MOBILE-TO-MOBILE ON SAME
LOCALITY

Use two mobiles with the same Home and list of
Group IDs. Select the same Group on the mobiles.

1. Pressthe PTT on Mobile-1.

* The CIM associated with the active repeater
changes from Idle Task “2" to Receive Task “4”.

* Mobile-2 receives the voice communication from
Mobile-1.

* No DIMs receive voice communication.

2. Releasethe PTT on Mobile-1.

* The active CIM returnsto the Idle Task “2".
* Mobile-2 returnsto Idle and is silent.

3. Repeat these steps using Mobile-2 as PTT Mobile.

B.1.2 MOBILE-TO-MOBILE WITH DIM
MONITORING

Use two mobiles with the same Home and list of
Group IDs. On the Dispatch Console (DC) select a
DIM and mobiles with a group that is common to
both.

1. Pressthe PTT on Mobile-1.

* The CIM associated with the active repeater
changes from Idle Task “2" to Receive Task “4”.

®* Theassociated DIM changesfrom Idle Task “2” to
Receive Task “4".

* The DIM receives the voice communication.

* Mobile-2 receives the voice communication from
Mobile-1.

2. Releasethe PTT on Mobile-1.

* The CIM returnsto ldle Task “2".

* Mobile-2 returnsto Idle and is silent.

* TheDIM returnsto ldle Task “2” and no voice com-
munication is heard at the DC.

3. Repeat these steps using Mobile-2 as PTT Mobile.

B.2 WIDE AREA GROUP CALL

B.2.1 MOBILE TO GROUP OF MOBILES
ON MULTIPLE LOCALITIES

Use amobile with aHome/Group that existsin a
Wide Area Call Configuration on the Call Processor.
The Wide Area Call Configuration can contain entries
for multiple Localities, Homes and Groups.

1. Pressthe PTT on Mobile-1.

* The CIM associated with the active repeater
changes from Idle Task “2" to Receive Task “4”.

®* The WAM card picks up the call from the Channel
Status Bus and acquires channel resources based on
the Wide Area Call Configuration.

* Theacquired CIM cards change from
Idle Task “2” to Transmit Task “3”.

* The other mobiles receive the audio for Mobile-1.

2. Releasethe PTT on Mobile-1.

* Theactive CIM in Receive Task “4” returnsto
Idle Task “2".

* Theassociated WAM returnsto Idle Task and
releases the acquired channels.

® Theacquired CIMs return from Transmit Task to
Idle Task.

3. Repeat these steps from any Mobile in the Wide
Area Call Configuration.

B.3 DISPATCH CONSOLE (DC) TO MOBILE
GROUP CALL

Use two mobiles with the same Home and list of
Group IDs. Select the DIM with this Group ID.

1. Pressthe PTT function on the DC.

* Theassociated DIM changes from the
Idle Task “2” to the Transmit Task “3".

* The Associated CIM is selected and changes from
the Idle Task “2” to Transmit Task “3".

* The mobiles receive the voice communication.
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Release the PTT on the DC.

The associated DIM returnsto Idle Task “2".
The associated CIM returnsto Idle Task “2".

If the associated DIM has Hang Time defined,
the associated CIM enters Hang Task “7” for the
defined time.

When the Hang Time has expired the associated
CIM returnsto Idle Task “2”.

The mobiles return to idle and stop receiving.

B.4 MOBILE GROUP CALL TO DISPATCH CON-

SOLE

Use two mobiles with the same Home and list of

Group IDs. On the Dispatch Console (DC) select a
DIM and mobiles with a group that is common to
both.

1

Pressthe PTT on Mobile-1.

The CIM associated with the active repeater
changes from Idle Task “2" to Receive Task “4”.
The associated DIM changes from Idle Task “2” to
Receive Task “4".

The DIM receives the voice communication.
Mobile-2 receives the voice communication.

On the DC pressthe PTT of the DIM.

The associated DIM changes to Transmit Task “3”".
The associated DIM changes to Duplex Task “6”.
M obile-2 receives voice communication from both
the DC and Mobile-1.

Release the PTT of Mobile-1.

The associated CIM changesto Transmit Task “3”.
Both mobiles now receive the DIM voice communi-
cation.

If the associated DIM has Hang Time defined,
the associated CIM enters Hang Task “7” for the
defined time.

B-2

When the Hang Time has expired the associated
CIM returnsto Idle Task “2".

* The mobilesreturn to idle and are silent.
B.5 MOBILE TO UNIQUE ID

Use two mobiles defined to different Home and
Group ID.

NOTE: Some of these tasks change rapidly.

1. Mobile-1, the originating mobile, selects the Auxil-
iary Call group code.

2. Pressthe PTT of Mobile-1 to access the system.

® Originating CIM (O-CIM), changes from Idle Task
“2" toDia Tone Task “C”.

3. Releasethe PTT of Mobile-1.
* Mobile-1 hears “Dia Tone” from O-CIM.

4. Pressthe PTT of Mobile-1.

5. When Mobile-1'stransmit light is lit, enter 4-digits
of DTMF for the Unique ID of Mobile-2 (terminat-
ing mobile).

6. Releasethe PTT of Mobile-1.

* Mobile-1 hears the “Confirmation Tone” from the
O-CIM confirming the acceptance of the digits.
* O-CIM changesto the Ringing Task “D”.
* Mobile-1 hears“Ringing Tone” from the O-CIM.
® Originating SNM (O-SNM) changes from
Idle Task “2” to SNM Outgoing Task “8”.
* Degtination SNM (D-SNM) changes from
Idle Task “2” to incoming Seize Task “3".
* D-SNM changes from Incoming Seize Task “3” to
SNM Incoming Task “4”.
® D-SNM changes to Incoming Channel Task “5”.
* (O-SNM changes to Outgoing Channel Task “9".
* Dedtination CIM (D-CIM) changes from
Idle Task “2” to Transmit Task “3”.
* Mobile-2 hears “Ringing Tone”.
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7. Pressthe PTT on Mobile-2.

* D-CIM changesto Duplex Task “6”.
* O-CIM changesto Transmit Task “3".
* Mobile-1 hears the voice of Mobile-2.

8. Releasethe PTT on Mobile-2.

* D-CIM changesto Transmit Task “3".
* Mobile-lissilent.

9. Pressthe PTT on Mobile-1.

® O-CIM changesto Duplex Task “6”.
* Mobile-2 hears the voice of Mobile-1.

10.Release the PTT on Mobile-1.

* O-CIM changesto transmit Task “3”.
* Mobile-2issilent.

11.Pressthe PTT on Mobile-1.
12.Press DTMF “#” key for longer than 1 second.

O-CIM changesto the End Call Task “E”.
Mobile-1 hearsthe “End Call Tone".
O-CIM changesto Idle Task “2".

O-SNM changesto the ldle Task “2”.
D-SNM changesto the End Call Task “C".
D-CIM changesto the End Call Task “E”.
Mobile-2 hearsthe “End Call Tone".
D-CIM changesto the Idle Task “2”.
D-SNM changesto the Idle Task “2”.

B.6 MOBILE TO UNIQUE ID FOR A MOBILE
OUTSIDE SWITCH

Use two mobiles defined to different Home and
Group ID.

NOTE: Some of these tasks change rapidly.

1. Mobile-1, the originating mobile, selects the Auxil-
iary Call group code.

2. Pressthe PTT of Mabile-1 to access the system.

* Theoriginating CIM (O-CIM), changes from Idle
Task “2” to Dial Tone Task “C”.

3. Releasethe PTT of Mobile-1.
* Mobile-1 hears“Dia Tone” from O-CIM.
4. Pressthe PTT of Mobile-1.

5. When Mobile-1'stransmit light islit, Enter 7-
DTMF digits, 3for Locality outside the Switch and
4 for the Unique ID of Mobile-2 (terminating
mobile).

6. Releasethe PTT of Mobile-1.

* Mobile-1 hears the “Confirmation Tone” from the
O-CIM confirming the acceptance of the digits.
® O-CIM changes to the Ringing Task “D”.
* Mobile-1 hears “Ringing Tone” from the O-CIM.
® Originating SNM (O-SNM) changes from
Idle Task “2” to SNM Outgoing Task “8".
® Destination SNM (D-SNM) changes from
Idle Task “2” to incoming Seize Task “3".
® D-SNM changes from Incoming Seize Task “3” to
SNM Incoming Task “4”.
* D-SNM changesto Incoming Channel Task “5”.
* O-SNM changesto Outgoing Channel Task “9”.
® Destination CIM (D-CIM) changes from
Idle Task “2” to Transmit Task “3".
* Mobile-2 hears“Ringing Tone”.

7. Pressthe PTT on Mobile-2.

* D-CIM changesto Duplex Task “6”.
* O-CIM changesto Transmit Task “3".
* Mobile-1 hears the voice of Mobile-2.

8. Releasethe PTT on Mobile-2.

* D-CIM changesto Transmit Task “3".
* Mobile-lissilent.

9. Pressthe PTT on Mobile-1.

® O-CIM changesto Duplex Task “6”.
* Mobile-2 hears the voice of Mobile-1.

10.Release the PTT on Mobile-1.

* O-CIM changesto transmit Task “3”.
* Mobile-2issilent.
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11.Pressthe PTT on Mobile-1.
12.PressDTMF “#" key for longer than 1 second.

O-CIM changesto the End Call Task “E”.
Mobile-1 hearsthe “End Call Tone".
O-CIM changesto Idle Task “2”.

O-SNM changesto the ldle Task “2".
D-SNM changes to the End Call Task “C”.
D-CIM changes to the End Call Task “E”.
Mobile-2 hearsthe “End Call Tone".
D-CIM changesto the Idle Task “2”.
D-SNM changesto the Idle Task “2”.

B.7 MOBILE TO DIRECTED GROUP CALL
(DTMF ENTRY WITHIN SWITCH)

Use two mobiles defined to different Home and
Group ID.

NOTE: Some of these tasks change rapidly.

1. Mobile-1, the originating mobile, selects the Auxil-
iary Call group code.

2. Pressthe PTT of Mabile-1 to access the system.

* Theoriginating CIM (O-CIM), changes from Idle
Task “2” to Dial Tone Task “C”.

3. Releasethe PTT of Mobile-1.

* Mobile-1 hears“Dia Tone” from O-CIM.

4. Pressthe PTT of Mobile-1.

5. When Mobile-1'stransmit light islit, enter DTMF
digits:

* Enter 5-DTMFdigits, 2 for Homechannel and 3for
the Group ID desired.

* Enter 8-DTMF digits, 3 for different Localities

within Switch, 2 for Home channels and 3 for
Group IDs desired.

6. ReleasethePTT of Mobile-1 to indicate completion
of dialing.

* O-CIM hearsthe “Confirmation Tone”.

* QOriginating SNM (O-SNM) changes to SNM Out-
going Task “8".

* Degtination SNM (D-SNM) changes to Incoming
Seize Task “3".

® D-SNM changesto Incoming Task “4”.

Destination CIM (D-CIM) changes to Transmit

Task “3".

D-SNM changes to Incoming Channel Task “5”.

O-SNM changes to Outgoing Channel Task “9”.

O-CIM changes to Ringing Task “D”.

Mobile-1 hearsthe “Call Proceed Tone”.

7. Pressthe PTT on Mobile-1.

* O-CIM changesto Receive Task “4”.

* D-CIM changesto Transmit Task “3".

* Mobile-2, destination mobile, hearsMobile-1 voice
communication.

8. Releasethe PTT on Mobile-1.

® O-CIM changesto Hang Task “7”.
* D-CIM changesto Hang Task “7”.
* Mobile-2issilent.

9. Pressthe PTT on Mobile-2.

* D-CIM changesto Receive Task “4”.
* O-CIM changesto Transmit Task “3".
* Mobile-1 hears the voice of Mobile-2.

10.Release the PTT on Mobile-2.

* D-CIM changesto Hang Task “7”.

®* O-CIM changesto Hang Task “7”.

* Mobile-lissilent.

11.Pressthe PTT on Mobile-1.

* O-CIM changesto Receive Task “4”.

D-CIM changes to Transmit Task “3”.
* Mobile-2 hears the voice of Mobile-1.
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12.Press DTMF “#” key for longer than 1 second.

O-CIM changesto the End Call Task “E”.
Mobile-1 hearsthe “End Call Tone".

O-CIM changesto Idle Task “2".

Both SNMs change to the End Call Task “C”.
D-CIM changesto the End Call Task “E”.
Mobile-2 hearsthe “End Call Tone".

D-CIM and both SNMs changeto the ldle Task “2”.

B.8 MOBILE TO DIRECTED GROUP CALL
(DTMF ENTRY OUTSIDE THE SWITCH)

Use two mobiles defined to different Home and
Group ID.

NOTE: Some of these tasks change rapidly.

1. Mobile-1, the originating mobile, selects the Auxil-
iary Call group code.

2. Pressthe PTT of Mabile-1 to access the system.

® Originating CIM (O-CIM), changesfrom Idle Task
“2" to Dia Tone Task “C”.

3. Releasethe PTT of Mobile-1.
* Mobile-1 hears“Dia Tone” from the O-CIM.

Pressthe PTT of Mobile-1.

5. When Mobile-1'stransmit light islit, enter DTMF
digits:

* Enter 5-DTMFdigits, 2 for Homechannel and 3for
the Group ID desired.

* Enter 8-DTMF digits, 3 for different Localities
within Switch, 2 for Home channel and 3 for Group
ID desired.

6. Releasethe PTT of Mobile-1 to indicate completion
of dialing.

* O-CIM hearsthe " Confirmation Tone".
® Originating SNM (O-SNM) changes to SNM Out-
going Task “8".

B-5

* Degtination SNM (D-SNM) changes to Incoming
Seize Task “3".

® D-SNM changesto Incoming Task “4”.

Destination CIM (D-CIM) changes to Transmit

Task “3".

D-SNM changes to Incoming Channel Task “5”.

O-SNM changes to Outgoing Channel Task “9”.

O-CIM changesto Ringing Task “D”.

Mobile-1 hears the “Call Proceed Tone”.

7. Pressthe PTT on Mobile-1.

* O-CIM changesto Receive Task “4”.

* D-CIM changesto Transmit Task “3".

* Mobile-2, destination mobile, hearsMobile-1 voice
communication.

8. Releasethe PTT on Mobile-1.

® O-CIM changesto Hang Task “7”.
* D-CIM changesto Hang Task “7”.
* Mobile-2issilent.

9. Pressthe PTT on Mobile-2.

* D-CIM changesto Receive Task “4”.
* O-CIM changesto Transmit Task “3".
* Mobile-1 hears the voice of Mobile-2.

10.Release the PTT on Mobile-2.

* D-CIM changesto Hang Task “7”.
* O-CIM changesto Hand Task “7”.
* Mobile-lissilent.

11.Pressthe PTT on Mobile-1.

* O-CIM changesto Receive Task “4”.
* D-CIM changesto Transmit Task “3".
* Mobile-2 hears the voice of Mobile-1.

12.Press DTMF “#” key for longer than 1 second.

O-CIM changesto End Call Task “E”.

Mobile-1 hearsthe “End Call Tone".

O-CIM changesto Idle Task “2".

Both SNMs change to End Call Task “C”.
D-CIM changesto End Call Task “E”.

Mobile-2 hears “End Call Tone”.

D-CIM and both SNMs changeto Idle Task “2”.
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B.9 MOBILE ORIGINATED TELEPHONE CALL
1. Mobile selects the Telephone Call group code.
2. Pressthe mobile's PTT to access the system.

®* Theassociated CIM changes from Idle Task “2” to
Dial Tone Task “C”.

3. Releasethe PTT of the mobile.
* Mobile hears“Dial Tone’ from the CIM.
4. Pressthe PTT of the mobile.

5. When the transmit light of the mobileislit, enter
DTMF digits.

* WhentheSMM isset for normal dialing translation,
enter the required digits to exercise the dialing
tranglation function.

* Whenthe SMM isset for PBX operation, enter the
complete set of digits, no wait for second dial tone
after the access digits.

6. Releasethe PTT of the mobile.

¢ CIM hearsthe “Confirmation Tone".

* TIM changesfrom Idle Task “2” to TIM Outgoing
Task “8".

* Whendigitdialingiscomplete, the TIM changesto
Channel Conversation Task “9”.

* CIM changesto Ringing Task “D”.

* Mobilehearslandside progresstones, ringing, busy
or called party answer.

7. Pressthe PTT onthe mobile.

® CIM changesto Duplex Task “6”.
* Cadled party hears the mobile voice.

8. Releasethe PTT on the mobile.

* CIM changesto Transmit Task “3".

* Mobile hearsthe called party.

* Cadled party does not hear the mobile.
9. Pressthe PTT on the mobile.

® CIM changesto Duplex Task “6”.
* (Cdled party hears the mobile voice.

B-6

10.Pressthe DTMF “#” key for longer than 1 second
and release the PTT.

CIM changesto End Call Task “E”.
Mobile hears the “End Call Tone”.
CIM changesto Idle Task “2".
Mobilereturnsto idle and is silent.
TIM changesto End Call Task “C”.
TIM disconnects the telephone line.
TIM changesto Idle Task “2".

B.10 LANDSIDE (TIM) ORIGINATE TO MOBILE
WITHIN SWITCH USING A DID LINE

1. Dial the desired number for amobile within the
Switch.

®* Theassociated TIM changesfrom Idle Task “2” to
Incoming Seize Task “3".

* CIM changesfrom Idle Task “2" to Transmit Task
“3".

* TIM changesto Incoming Channel Conversation
Task “5”.

* Landside party and mobile hear “Ringing Tone".

2. Pressthe PTT onthe mobile.

* “Ringing Tone” isturned off.
* CIM changesto Duplex Task “6”".
* Landside party hears the mobile voice.

3. Reeasethe PTT on the mobile.

* Landside party hears silence.
* CIM changesto Transmit Task “3".
* Mobile hearsthe landside party.

4. The mobile disconnects by pressing the PTT and
DTMF “#’ key for 1 second.

5. Thelandside party disconnects by pressing the
DTMF “#’ key for 1 second.

CIM changesto the End Call Task “E”.
Mobile hears the “End Call Tone”.
CIM changesto theldle Task “2".
Mobileissilent.
TIM changesto end Call Task “C”.
Landside party hears “End Call Tone".
TIM disconnects the telephone line when landside
disconnects.
* TIM changesto Idle Task “2".
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B.11 LANDSIDE (TIM) ORIGINATE TO MOBILE
WITHIN SWITCH USING A 2WY LINE

1. Dial the desired number for the 2WY line.

®* Theassociated TIM changesfrom Idle Task “2” to
Incoming Seize Task “3".
* Landside party hears the proceed tone.

2. Thelandside party entersthe 4-DTMF digits of the
Unique ID of the mobile.

* CIM changesfrom Idle Task “2" to Transmit Task
“3".

* TIM changesto Incoming Channel Conversation
Task “5".

* Landside party and the mobile hear “ Ringing
Tone".

3. Pressthe PTT onthe mobile.

* “Ringing Tone" isturned off.
* CIM changesto Duplex Task “6”.
* Landside party hears the mobile voice.

4. Releasethe PTT on the mobile.

* Landside party hears silence.
* CIM changesto Transmit Task “3".
® Mobile hears the landside party.

5. PressmobilesPTT and DTMF“#” key for 1 second
or landside party pressesthe DTMF “#” key for 1
second.

CIM changesto the End Call Task “E”.
Mobile hears the “End Call Tone”.
CIM changesto theldle Task “2".
Mobileissilent.

TIM changesto end Call Task “C”.
TIM disconnects the telephone line.
TIM changesto Idle Task “2".

B-7

B.12 TIM ORIGINATE TO MOBILE OUTSIDE
SWITCH USING A DID LINE

NOTE: Some of these tasks change rapidly.
1. Dial the number for a mobile within the Switch.

®* Theassociated TIM changesfrom Idle Task “2” to
Incoming Seize Task “3".

®* TIM changesto TIM incoming Task “4”.

® Originating SNM (O-SNM) changes from
Idle Task “2” to Incoming Seize Task “3”".

®* O-SNM changesto SNM Outgoing Task “8”.

* Degtination SNM (D-SNM) changes from
Idle Task “2” to Incoming Seize Task “3".

* D-SNM changesto SNM Incoming Task “4”.

* Dedtination CIM (D-CIM) changes from
Idle Task “2” to Transmit Task “3”.

* D-SNM changesto Incoming Channel Task “5”.

®* O-SNM changesto TIM Outgoing Conversation
Task “E”.

* TIM changesto SNM Incoming Conversation
Task “D”.

* Landside party and mobile hear “Ringing Tone".

2. Pressthe PTT on the mobile.

* “Ringing Tone" isturned off.
* CIM changesto Duplex Task “6”".
* Landside party hears the mobile voice.

3. Releasethe PTT on the mobile.

* Landside party hears silence.
* CIM changesto Transmit Task “3".
* Mobile hearsthe landside party.

4. Mobiledisconnectsby pressingthe PTT and DTMF
“#" key for 1 second.

5. Landside party disconnects by pressing the DTMF
“#" key for 1 second.

CIM changesto the End Call Task “E”.
Mobile hears the “End Call Tone”.

CIM changesto theldle Task “2".
Mobileissilent.

Both SNMs change to End Call Task “C”.
TIM changesto end Call Task “C”.
Landside party hears “End Call Tone”.
TIM disconnects the telephone line.

TIM changesto Idle Task “2”.

Both SNMs change to Idle Task “2”.
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CALL SEQUENCES

B.13 LANDSIDE ORIGINATE TO MOBILE

OUTSIDE SWITCH USING A 2WY LINE

NOTE: Some of these tasks change rapidly.

1

Dial the desired number for the 2WY line.

The associated TIM changes from Idle Task “2” to
Incoming Seize Task “3".

TIM changesto TIM Incoming Task “4”.
Landside party hears a*“Proceed Dialing Tone".

The landside party entersthe 4-DTMF digits of the
Unique ID of the mobile.

CIM changes from Idle Task “2” to Transmit Task
“3".

TIM changes to Incoming Channel Conversation
Task “5”.

Landside party and the mobile hear “Ringing
Tone”.

B-8

Pressthe PTT on the mobile.

“Ringing Tone” is turned off.
The CIM changes to Duplex Task “6”.
Landside party hears the mobile voice.

Release the PTT on the mobile.
Landside party hears silence.

CIM changesto Transmit Task “3".
Mobile hears the landside party.

. Themobile pressesthe PTT and DTMF “#” key for

1 second or landside party pressesthe DTMF “#”
key for 1 second.

CIM changesto the End Call Task “E”.
Mobile hears the “End Call Tone”.
CIM changesto theldle Task “2".
Mobileissilent.

TIM changesto end Call Task “C”.
TIM disconnects the telephone line.
TIM changesto Idle Task “2".
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CALL SEQUENCES

SNM UNIQUE ID REQUEST

'

IDLE SERVICE
’ PARSER DIM REQUEST -
NO DIM
iDIM REQUEST
SNM IDLE WAIT DIM NO RESPONSE -
——————
RESPONSE
CIM / SNM
iDn\A ACKNOWLEDGE CONVERSATION
WAIT FOR SNM CIM IDLE
FAILURE | ACKNOWLEDGE TO DIM IDLE -
————
CALL DESTINATION
i ACKNOWLEDGE
SNM IDLE DIM / SNM DIM IDLE SNM
———————
CONVERSATION DISCONNECT
<«SNMDLE
SNM IDLE DIM / SNM SNM ACKNOWLEDGE DISCONNECT
= | CONVERSATION

Figure B-1 SNM Unique ID Request Flowchart
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CALL SEQUENCES

DIM UNIQUE ID
CALL REQUEST
CIM IDLE CIM / DIM
‘ CONVERSATION
P |IDLE SERVICE PARSER =& INTERNAL CIM
SNM REQUEST NO CARDS

SNM REQUEST

DIM IDLE

SNM ACKNOWLEDGE

SNMIDLE | WAIT FOR ACKNOWLEDGE DIM IDLE FAILURE
TO CALL DESTINATION ORDER
DIM ACKNOWLEDGE
y
SNM IDLE DIM / SNM
CONVERSATION
DIM IDLE > SNM
DISCONNECT
SNM IDLE
SNM IDLE WAIT FOR SNM ACKNOWLEDGE DISCONNECT
SNM IDLE B

Figure B-2 DIM Unique ID Request Flowchart
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CALL SEQUENCES

CIM DTMF
AUXILIARY CALL

y
»
p IDLE SERVICE PARSER
g
SNM REQUEST‘ CIM ACKNOWLEDGE NO DIM
y FAILURE L
WAITSNM [——— — P DISCONNECT
ACKNOWLEDGE | _CIM IDLE CIM CARD
NO WAIT DIM
SNM MODULE
RESPONSE RESPONSE
WAIT DIM
CIM/SNM RESPONSE |
|
CONVERSATION
DIM
CIM IDLE ACKNOWLEDGE
\J CIM/ DIM
SNM IDLE SNM CONVERSATION
MMM
DISCONNECT [
CIM IDLE
SNM ACKNOWLEDGE
DISCONNECT
<« SNMIDLE | wAIT FOR
SNM IDLE
-
Figure B-3 CIM DTMF Auxiliary Call Flowchart
Revised August 2001
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CALL SEQUENCES

TIM INCOMING

IDLE SERVICE PARSER

A A A A INTERNAL ‘
DIM CIM TIM
IDLE IDLE
REQUEST
TIM WAIT WAIT FOR TIM / DIM
FORA'D"E SNM'ADLE CONVERSATION
' ACK ‘ SNM ACK
NO IDLE
P RESPONSE ™ SNM
DIM RESPONSE DISCONNECT |-— D'SCORNECT
DIM ACK ‘ A A NO SNM
Y ACK SNM REQUEST
NO y
RESPONSE | TIM ACKNOWLEDGE ™
TO CALL
DISCONNECT
DESTINATION ORDER
‘ ACKNOWLEDGE
™ Y
RESPONSE NO
Y WAIT FOR TIM | RESPONSE
ACKNOWLEDGE
TIM IDLE TIM / DIM DIM IDLE
CONVERSATION ‘ TIM ACK
TIM / SNM TIM IDLE
SNMIDLE | cONVERSATION

Figure B-4 Telephone Incoming TIM Incoming Flowchart
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CALL SEQUENCES

CIM TELEPHONE CALL REQUEST

Y

IDLE SERVICE PARSER

A TIM OUTGOING
REQUEST CIM
ACKNOWLEDGE
v FAILURE DISCONNECT
WAIT FOR TIM CIM CARD
ACKNOWLEDGE| g
TIM ACK
TIME-OUT WAIT FOR
——— —
LANDSIDE ANSWER
Y CIM IDLE
TIM IDLE CIM/TIM
——— —
CONVERSATION
IDLE TIM
————— |——
DISCONNECT
ACKNOWLEDGE
IDLE TIM WAIT
-————
FOR IDLE

Figure B-5 Telephone Calling CIM Telephone Call Request Flowchart
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CALL SEQUENCES

USER INTERFACE REQUEST FOR
DYNAMIC REASSIGNMENT BIT SET

'

SETUP DYNAMIC REASSIGNMENT

TIME-OUT
l\égggéﬁSE DYNAMIC REASSIGNMENT
BID CLEARED

IDLE

FAILURE EXECUTE SUCCESS
REPORT REQUEST REPORT

WAIT FOR EXECUTE

Figure B-6 Dynamic Reassignment User Interface Request Flowchart

USER INTERFACE REQUEST FOR
SELECTIVE UNIT DISABLE

'

SETUP OF SELECTIVE UNIT DISABLE

FAILURE
ACKNOWLEDGE | | EavE BIT SET)

REQUEST

WAIT FOR
SELECTIVE UNIT
DISABLE EXECUTE

COMPLETE
(INDICATES RESULTS)

y

IDLE

Figure B-7 Selective Unit Disable User Interface Request Flowchart
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INDEX

3000 Series Switch 1-1
3rd Level WAM Routing 1-5

A
Access Priority 1-3
Activity Log 4-5, 6-6
Activity Log screen 6-6
Activity Monitor 6-2, 6-6
Alarm
Categories 6-3
Severity 6-3
Alarm #268 1-4
Alarm #46 1-3
Alarms
Displaying Active 6-3
Displaying Archived 6-3
Repesater 6-3
Wide Area Calls 1-3
Answer Supervision 6-34
Auto-Registration 1-1
Auxiliary Calls 1-3

B
Backbone 2-1
Break and Make, see Dial Pulse
Bus 3-1
Control Bus 3-3
DataBus 3-1
Voice Bus 3-3
Busy Queuing 1-1

C
Cdl Log 6-6
CCM 6-25
Directed Calls 6-7
Queued Call Log 6-7
Reassignment Plan Activity
Log 6-8
Registration Log 6-8
Telco Calls 6-6
Call Processor 4-1
Call Processor Properties 6-20
Call Routing 6-13
Call UsageLog 4-5
Call Usage Logging 4-5
Card Properties 6-25
CCM 6-25
CIM 6-26
DCM 6-28
DIM 6-29
Globa 6-25
IDM 6-30
LEM 6-31
MAM 6-31
MCM 6-32
SNM 6-33
TIM 6-34

INDEX

VDM 6-41
WAM 6-42
Carrier Sense Multiple Access 3-2
CCM, see Conventional Channel
Module
Channel Interface Bus 3-2
Channél Interface Module 2-1, 2-2,
6-26
Channel Status Bus 3-2, 4-1, 4-6
Channel Status screen 6-6
Channel Usage Graph 6-10
CIB, see Channdl Interface Bus
CIM, see Channel Interface Module
Control Bus 3-3
CSB Idle/Coallision line 3-3
IDB Idle/Callision line 3-3
Control Consoles 2-1
Conventional Channel Module 2-2,
6-25
Conventional Repeater Module 2-2
Conventiona System 1-1
CP
see Call Processor 1-1
CRM, see Conventional Repeater
Module
CSB
See Channel Status Bus 3-2
CSB Usage 4-6
CSB, see Channel Status Bus
CSMA, see Carrier Sense Multiple
Access

D
DataBus 3-1

CIB 3-2

CSB 3-2

DIB 3-2

DTP 3-2

Ethernet 3-1

IDB 3-2

NetCSB 3-2

NetIDB 3-2

PABX 3-3

PSTN 3-3

SNB 3-3
Database Backup 1-4
DCM, see Dispatch Channel Module
Demo Mode 1-5
Device Address 1-2
Dial Pulse 6-35
Dialing Rules 6-10
DIB, see Dispatch Interface Bus
Digit Patterns Screen 6-12
DIM, see Dispatch Interface Module
Direct Inward Dialing 6-35
Directed Calls Log Screen 6-7
Directed Group Call B-4

Index-1

Disconnect Supervision 6-34

Dispatch Channel Module 2-2, 6-28

Dispatch Console Call B-1

Dispatch Interface Bus 3-2

Dispatch Interface Module 2-1, 2-2,
6-29

Dispatch Tone Protocol 3-2

DTMF, see Dual Tone
Multi-Frequency

DTR, see Dispatch Tone Protocol

Dual Tone Multi-Frequency 6-35

Dynamic Reassignment 1-3, 4-4

E

Emergency Messages 1-1

Emergency Traffic Activity Log 6-7

Emergency Traffic Activity Log
screen 6-7

Enter New Key 5-3

Error Messages 4-5

Ethernet 3-1

F
FileMenu 5-3

G

GPM, see Group Patch Module
GROUPCALL B-1

Group Call 4-1,B-1

Group ID 1-2

Group Patch Module 2-2
Group Traffic Summary 6-10

H
High-Speed Data Bus 1-2
Home Repeater Channel 1-2

I

IDB, see Intra-terminal Data Bus
IDM, see Intelligent Dispatch Module
Intelligent Dispatch Module 6-30
Internal Errors 4-5

Interrogate 4-3

Intra-Terminal Data Bus 3-2, 4-1

L

LapLink 1-3

Locality 1-2

Log Properties 6-20

Logging Encoder Module 6-31
LTR 1-1

M

Master Clock 3-4, 6-35

Master Frame Synchronization 6-35
Master Sync 3-4
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MCM

see Multi-Net Console Module 2-1
MLM, see Multi-Net Logic Module
Modules 2-2

CCM 2-2

CIM 2-2

CPM 2-2

DIM 2-2

IDM 2-2

LEM 2-2

MAM 2-2

MCM 2-2

NetNIM 2-2

PTM 2-2

SNM 2-2

TIM 2-2

VDM 2-2

VTM 2-2

WAM 2-2
Monitor Repeater Channel 1-2
Multi-Net Acquisition Module 6-31
Multi-Net Console Module 2-1, 6-32
Multi-Net Locality 2-1
Multi-Net Trunked System 1-1

N
NetCSB
see Network Channel Status
Bus 3-2
NetIDB
see Network Intra-Termina Data
Bus 3-2
NetNIM
see Network Interface Module 1-2
Network Channel Status Bus 3-2
Network Interface Module 1-2, 2-2
Network Intra-Terminal Data Bus 3-2
NIM, see Network Interface Module
North American Number Plan 6-16

@]

Optional Features 1-5

Options
3rd Level WAM Routing 1-5
Priority 1 Emergency 1-5
Repeater Alarms 1-5
Wide AreaCalling 1-5

p
Pattern list 6-15
PCM
see Pulse Code Modulation 1-3
PCM, see Pulse Code Modulation
Periodic Reboot 1-4
Printing Reports 6-9
Priority 1 Emergency 1-5
Priority Access 1-1
Pulse Code Modulated 3-3
Pulse Code Modulation 1-3

Q

Queued Call Log 6-8

Queued Directed Call Log screen 6-8
Queued Telco Call Log screen 6-8

R

Reassignment Plan 4-4

Reassignment Plan Activity Log
Screen 6-8

Reboot 1-4

Registration Log 4-6, 6-9

Registration of Unique IDs 4-2

Remote Access Service 1-3

Repeater Alarms 6-3

Repeater Site 1-2

Resource Allocation 1-3

RF Equipment 2-1

RNT, see Radio Network Terminal

Rule Group Screen 6-12

Rx PCM Bus 3-4

S

Site Tracking Module 2-2

SMB, see System Management Bus

SNB, see System Network Bus

SNM, see System Network Module

Specia Calls 1-2

SSB, see System Status Bus

SSM

see System and Subscriber

Manager 1-1

Standard Group Call 4-1

Status Monitor 4-6

Status Repeater 1-2

STM, see Site Tracking Module

Switch 2-1,2-2

Switch Configuration Manager 6-1

Switch Interfaces 3-1

Switch Module Programming 6-1

Switch Properties 6-20

System Administrator 1-4

System and Subscriber Manager 1-1

System and Subscriber Manager

(SSM) 5-1

System Busy Statistics 6-10

System Configuration 4-1

System Management Bus 4-1

System Network Bus 3-3

System Network Module 2-2, 6-33

System Operator 1-4

System Status Bus 4-1

System Switch, see Radio Network

Terminal
System Traffic Listing 6-10

T
Telco Call Screen 6-6

Telephone Call B-6

Telephone Interface Module 2-2, 6-34

Index-2

Telephone Line Styles 6-35

TIM, see Telephone | nterconnect
Module

TIM, see Telephone Interface Module

Total System Traffic 6-10

Trunk Group Screen 6-12

Trunked System 1-1

Tx PCM Bus 3-3

U
uiD

see UniqueID 1-2
UID to Group Contributions 6-10
UID Traffic Summary 6-10
UniquelD 1-2
Unique ID Call B-2
Usage Accounting 4-1, 4-5
Usage Accounting Log Screen 6-9
User Messages 5-9, 5-17

\Y,
VDM, see Voter Diagnostics Module
Voice Bus 3-3

Master Clock 3-4

Master Sync 3-4

Tx PCM Bus 3-3

VTM Bus 3-3
Voice Tone Module 2-2
Voter Diagnostic Module 6-41
Voter Diagnostics Module 2-2
VTM Bus 3-3
VTM, see Voice Tone Module

w
WAC

see Wide AreaCall 1-3
WAM

see Wide AreaModule 1-3
WAM Configuration Status screen 6-6
Wide AreaCall 1-3,4-1

Cdll Router 6-42

Card Address 6-42

Default Priority 5-13

Default Transmit UID 5-13

Hang Time 5-13

Maximum Inactive Time 5-13

Participant 5-13

Permanent 5-13

Port 6-42

Routing Group 5-13, 6-42

Temporary 5-13

Type 6-42

WAC Group Timeout 5-13
Wide Area Dispatch Call 1-3
Wide AreaGroup Call B-1
Wide AreaModule 1-3, 6-42
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